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WF-M5694 User's Guide

Welcome to the WF-M5694 User's Guide.
For a printable PDF copy of this guide, click here.
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Product Basics

See these sections to learn about the basic features of your product.

Note: Printing software instructions in this manual are intended for use with the standard Epson printer
software. For more information on using the Printer Command Language (PCL) or PostScript (PS3)
printer software, please see the appropriate sections.

Using the Control Panel

Product Parts Locations

Checking for Software Updates

Using Eco Mode and Other Power Saving Settings

Epson Connect Solutions for Smartphones, Tablets, and More
Using AirPrint

Using Google Cloud Print

Using Fire OS Printing

Using Windows 10 Mobile Printing

Using the Control Panel
See these sections to learn about the control panel and select control panel settings.

Control Panel Buttons and Lights

Setting a Password and Locking the Control Panel
Changing LCD Screen Language

Adjusting Control Panel Sounds

Adjusting the Screen Brightness

Turning Off the Operation Time Out Setting

Parent topic: Product Basics

16



Control Panel Buttons and Lights

o Interrupt Reset  Stop
an
]

The O power button and light
The M home button

The —* Interrupt button
The Z Reset button

The @ Stop button

The LCD screen

The 3 back button

The  Status button and lights
The numeric keypad

10 The C clear button

11 The & B&W button

12 The <& Color button

0 N o ok~ WDN =

(o]

Status Icon Information
Status Button Information

Parent topic: Using the Control Panel
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Status Icon Information

Your product may display status icons on the LCD screen for certain product status conditions. Press
to view or change the current network settings.

Description

(2]
o
=
(7]

Displays additional information or instructions, such as on loading paper or placing a
document.

ADF

A document is in the Automatic Document Feeder (ADF).

The ink cartridge is running low on ink or the maintenance box is nearly full.

Press the i Status button to open the Status Menu, select Printer Information, and check
the status of the consumables.

The ink cartridge is expended or the maintenance box is full.

Press the i Status button to open the Status Menu, select Printer Information, and check
the status of the consumables.

Unread or unprinted fax data is stored in the product. If you have set up the product to save
received faxes on a computer or external storage device, this icon may also indicate that
received faxes have not been saved on the computer or storage device.

EKE

Fax memory usage.

(D

Fax memory is full. Delete received faxes you have already read or printed. If you have set
up the product to save received faxes on a computer or external storage device, turn on
the computer or connect the storage device to the product.

1

A fax is sending or receiving.

A Wi-Fi or an Ethernet connection is being processed.

No Ethernet connection.

gl fIC

An Ethernet connection has been established.
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Description

No Wi-Fi connection.

A Wi-Fi network error has occurred or the product is searching for a connection.

A Wi-Fi connection has been established. The number of bars indicates the connection's
signal strength.

An Ad hoc connection has been established.

A Wi-Fi Direct mode connection has been established.

A Simple AP mode connection has been established.

Access to the product's functions are restricted to authorized users. Press the icon to log in
to the printer. (You need to enter a user name and password.) Contact your administrator if
you do not know the login information.

H H %"»ﬂ@mmmg

Access to the product's functions are restricted to authorized users and a user is currently
logged in. Press the icon to log out.

Note: If you see a numbered icon on top of the Fax icon on your product's LCD screen, received faxes
have been temporarily saved to the product's memory.

Parent topic: Control Panel Buttons and Lights

Status Button Information

Press the i Status button on the control panel to view the current product and job status.

Function

Description

Printer

Displays the status of consumables and any errors that have occurred
with the product. Select the error from the list to display the error
message.

Job Monitor

Displays the current job and any jobs waiting to be processed.
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Function

Description

Job History Displays the job history and any error codes for failed jobs in the
history.
Job Storage Select Inbox to display received faxes stored in the product's history.

Confidential Job

Displays jobs that require a password to print.

Parent topic: Control Panel Buttons and Lights

Setting a Password and Locking the Control Panel

You can set an administrator password to lock the following settings and prevent them from being

changed:

» System Administration Setup settings

* Eco mode settings

¢ Presets
« Contacts

Note: For more information on administration settings, see the Administrator's Guide.

Press the M home button, if necessary.

2. Select Setup.

You see a screen like this:

T

Paper Selup

Maintenine | |

Print Status Sheet

. Retwork Stalus

s

3. Scroll down and select Admin Settings.
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4. Select Admin Password.
5. Select Register.

You see a screen like this:

=
-
™
-
(=g

6. Use the displayed keyboard to enter a password, and press .

7. Enter your password again to confirm.

8. Select OK.

9. Select Lock Setting and select On.

When the control panel is locked, you must enter the password to access any of the locked settings.

Note: If you forget your password, contact Epson for assistance.

Entering Characters on the LCD Screen
Using Presets

Parent topic: Using the Control Panel
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Entering Characters on the LCD Screen

Follow these guidelines to enter characters for passwords and other settings.

« To move the cursor, selectl - |or| > |

» To change the case of letters, select lil

To delete the previous character, select ::I
* To enter numbers or symbols, select .

* To enter a space, select El
Parent topic: Setting a Password and Locking the Control Panel
Using Presets
You can save frequently used copy, fax, and scan settings as presets. This lets you easily reuse them
whenever necessary.

Note: Presets can be locked by an administrator. If you cannot access or change presets, contact your
administrator for assistance.

1. Press the M home button, if necessary.
2. Select Presets. Enter the Administrator password, if necessary.
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You see a screen like this:

+ Pressis I
 fuld Hew |
Aol Henw |

Al New |

fald Hew Hii

3. Select Add New.
4. Select the function for which you want to set up a preset.

A
I

You see the main screen for that function, such as the Copy screen:

B cay [ (=1 T
EH Layout ['Ug':lﬁm poples

#ith Border

5. Select the settings you want to save, and select Save.
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You see a screen like this:

™~
-
™
-
=

6. Use the displayed keyboard to enter a name for the preset and press .
7. Select Save.

When you copy, fax, or scan, you can use the preset by selecting Presets and selecting your preset
from the list.

Parent topic: Setting a Password and Locking the Control Panel

Related tasks
Entering Characters on the LCD Screen

Changing LCD Screen Language

You can change the language used on the LCD screen.

Note: This setting can be locked by an administrator. If you cannot access or change this setting,
contact your administrator for assistance.

1. Press the M home button, if necessary.
2. Select Setup.
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You see a screen like this:

§1 Selup

[ Ink Levels I

Paper Setup

. Retwark Stalus

I
Print Status Sheet |
l

Scroll down and select System Administration.
Select Common Settings.
Scroll down and select Language.

o o bk w

Select a language.
Parent topic: Using the Control Panel

Adjusting Control Panel Sounds

You can adjust the sound level heard when you press buttons on the control panel.

Note: This setting can be locked by an administrator. If you cannot access or change this setting,
contact your administrator for assistance.

1. Press the % home button, if necessary.
2. Select Setup.
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You see a screen like this:

§1 Selup

[ Ink Levels I

Paper Setup

I
Print Status Sheet |
. Retwark Shalus ]

Scroll down and select System Administration.
Select Common Settings.

Select Sound.

Select Button Press.

Press E to decrease or E to increase the sound.
Select OK.

® N O 0 b~ w

Note: You can also adjust the Sound Type and the sound level for various product functions.
Parent topic: Using the Control Panel

Adjusting the Screen Brightness
You can adjust the brightness of the LCD screen.
1. Press the M home button, if necessary.
2. Select Setup.
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You see a screen like this:

[ Ink Levels I
MaTenanpe | |

Faper Selup ]
Print Status Sheet |
. Retwark Shalus ]l:

Scroll down and select System Administration.
Select Common Settings.
Select LCD Brightness.

Adjust the screen brightness by selecting a brightness level or by pressing the left and right arrow
buttons.

7. Select OK to exit.
Parent topic: Using the Control Panel

o o bk w

Turning Off the Operation Time Out Setting

The Operation Time Out setting causes the LCD screen to return to the Home screen after a few minutes
of inactivity. This feature is enabled by default, but you can turn it off.

Note: This setting can be locked by an administrator. If you cannot access or change this setting,
contact your administrator for assistance.

1. Press the M home button, if necessary.
2. Select Setup.
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You see a screen like this:

§1 Selup

[ Ink Levels I

Paper Setup

. Retwark Stalus

I
Print Status Sheet |
l

Scroll down and select System Administration.
Select Common Settings.

Scroll down and select Operation Time Out.
Select Off.

Parent topic: Using the Control Panel

o o kW

Product Parts Locations

See these sections to identify the parts on your product.

Product Parts - Top
Product Parts - Inside
Product Parts - Back

Parent topic: Product Basics
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Product Parts - Top

© 00 N O O b WOWN -

ADF cover
Automatic Document Feeder (ADF)

Edge guide

ADF input tray

ADF output tray

Paper cassette 1

Optional paper cassette unit
Optional paper cassette cover
Optional paper cassette 2

29



N OO oA W DN -

Edge guides

Paper stopper
Output tray extension
Output tray

Edge guides

Rear paper feed slot
Feeder guard
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Document cover
Scanner glass
Control panel

1
2
3
4

Parent topic: Product Parts Locations

USB Type A port for external devices
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Product Parts - Inside

1 Ink cartridge slots

2 Front cover
3 Print head

Parent topic: Product Parts Locations
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Product Parts - Back

i

Line port

EXT port

USB port

LAN port

Service USB port (do not remove sticker)
Maintenance box

Rear cover

AC inlet

0o N OO o0~ WDN -

Parent topic: Product Parts Locations

Checking for Software Updates

Periodically, it's a good idea to check Epson's support website for free updates to your product software.
Visit the driver download site at (U.S. downloads or Canadian downloads).

* Windows: Your printer software automatically checks for updates. You can also manually update the
software by selecting Software Update here:

» Accessing the Windows Desktop and right-clicking the product icon in the Windows taskbar
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+ On the Maintenance tab in the printer settings window

You can also update the software by selecting EPSON Software Updater in the EPSON or EPSON
Software program group, accessible by the Start button, or on the Start or Apps screens, depending
on your version of Windows.

» 0OS X: You can manually update the software by opening the Applications > Epson Software folder
and selecting EPSON Software Updater.

Parent topic: Product Basics

Using Eco Mode and Other Power Saving Settings

Your product enters sleep mode automatically and turns off the LCD screen if it is not used for a period
of time. You can make the time period shorter and select other options to save energy and resources.

Changing the Eco Settings
Changing the Sleep Timer Settings
Changing the Power Off Timer Settings

Parent topic: Product Basics

Changing the Eco Settings
You can use the product's control panel to change the Eco settings.
Note: The Sleep Timer setting in Eco Mode overrides the Sleep Timer setting in the Common Settings
menu. If you turn on Eco Mode, 2-sided copying is selected by default. The Eco Mode setting can be

locked by an administrator. If you cannot access or change this setting, contact your administrator for
assistance.

1. Press the M home button, if necessary.
2. Select Eco Mode. Enter the administrator password, if necessary.
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You see a screen like this:

== Eco Mode

P )

Ll o

Sleep Timer

Select On.

Select Configure.

Change any settings as necessary.

. Select OK to exit.

Parent topic: Using Eco Mode and Other Power Saving Settings

o o AW

Changing the Sleep Timer Settings
You can adjust the time period before your product enters sleep mode and turns off the LCD screen.
Note: This setting can be locked by an administrator. If you cannot access or change this setting,

contact your administrator for assistance. The Sleep Timer setting in Eco Mode overrides this Sleep
Timer setting.

Press the % home button, if necessary.

Select Setup.

Scroll down and select System Administration. Enter the administrator password, if necessary.
Select Common Settings.

o kw0 b=

Select Sleep Timer.
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You see a screen like this:

Bt Sleep Timer

B

(1-FA0minaalEs)

6. Do one of the following:
* Press the — or + icons to reduce or increase the number of minutes.

* Press the number of minutes on the LCD screen, select the number of minutes from the on-screen
keypad, then press .

7. Select OK.
Parent topic: Using Eco Mode and Other Power Saving Settings

Changing the Power Off Timer Settings

You can have the product turn off automatically if it is not used for a specified period of time.

Note: This setting can be locked by an administrator. If you cannot access or change this setting,
contact your administrator for assistance.

1. Press the  home button, if necessary.
2. Select Setup.
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You see a screen like this:

;' Ink Levels I
I MaTenanpe | |

| Faper Selup ]

| Print Status Sheet |

!. Retwark Shalus ]lﬂ

3. Scroll down and select System Administration. Enter the administrator password, if necessary.
4. Select Common Settings.
5. Do one of the following depending on the setting you see displayed on the LCD screen:

» Select Power Off Timer, then select a time period between 30minutes and 12h (12 hours).

+ Select Power Off Settings, then select Power Off If Inactive to adjust the time before the
product turns off automatically or Power Off If Disconnected to turn the product off after 30
minutes of inactivity over the network.

Parent topic: Using Eco Mode and Other Power Saving Settings

Epson Connect Solutions for Smartphones, Tablets, and More

Use your smartphone, tablet, or computer to print and scan documents, photos, emails, and web pages
from your home, office, or even across the globe.

Print from anywhere with these Epson Connect solutions:
* Epson Email Print

* Epson iPrint Mobile App

* Epson Remote Print

Scan and send a file as an email or upload it to an online service directly from your Epson product with
Epson Scan to Cloud or the Epson iPrint Mobile App.

Using Epson Email Print
Using the Epson iPrint Mobile App
Using Epson Remote Print
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Using Epson Scan to Cloud
Parent topic: Product Basics

Using Epson Email Print

With Epson Email Print, you can print from any device that can send email, such as your smartphone,
tablet, or laptop. Just activate your product's unique email address. When you want to print, attach a
PDF, Microsoft Office document, or photo to an email and send it to your product. Both the email and the
attachments will print automatically.

1. Connect your product to your network. See the link below.

2. If you did not already set up Email Print when you installed your product software, see the link below
to use your product control panel to activate your unique email address. Or visit epsonconnect.com
to learn more about Email Print, create your Epson Connect account, and register your product to
the Epson Connect service.

3. Now you are ready to send and print emails to your product's Email Print address.

Note: Go to epsonconnect.com and log into your Epson connect account to personalize your product's
email, adjust print settings, and set up other Epson Connect services.

Parent topic: Epson Connect Solutions for Smartphones, Tablets, and More

Using the Epson iPrint Mobile App

Use this free Apple and Android app to print and scan with networked Epson products. Epson iPrint lets
you print PDFs, Microsoft Office documents, photos, and web pages over a wireless network. You can
scan and save a file on your device, send it as an email, or upload it to an online service such as Box,
Dropbox, Evernote, or Google Drive.

1. Connect your product to your wireless network. See the link below.

2. \Visit epson.com/connect to learn more about Epson iPrint and check the compatibility of your mobile
device.

3. Download Epson iPrint from the Apple App Store or Google Play.

4. Connect your mobile device to the same wireless network as your product.

5. Open Epson iPrint and select your Epson product.

Now you are ready to print or scan with your mobile device and your Epson product.
Parent topic: Epson Connect Solutions for Smartphones, Tablets, and More
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Using Epson Remote Print

With Epson Remote Print software, you can print from your laptop or desktop computer to an Epson
Email-enabled product anywhere in the world.

1.
2.

Connect your Epson product to your wireless network. See the link below.

If you did not already set up an Epson Connect account when you installed your product software,
visit epsonconnect.com to create your account and register your product to the Epson Connect
service.

Note: Make a note of your product's email address.

Visit epsonconnect.com to learn more about Remote Print and how to download the Remote Print
Driver software.

Download and install the Remote Print software.
Enter the email address and optional access key of your Epson product during Remote Print setup.

Now you are ready to print remotely. Select the print command in your laptop or desktop computer
application and choose the Remote Print option for your Epson product.

Parent topic: Epson Connect Solutions for Smartphones, Tablets, and More

Related topics
Wi-Fi or Wired Networking

Using Epson Scan to Cloud

The Epson Scan to Cloud service allows you to scan and send a file as an email or upload it to an online
service directly from your Epson product. Register an email address or online services such as Box,
DropBox, Evernote, or Google Drive with your Epson Connect account.

1.
2.

Connect your Epson product to your network. See the link below.

If you did not already set up an Epson Connect account when you installed your product software,
visit epsonconnect.com to create your account and register your product to the Epson Connect
service.

Note: Make a note of your product's email address and password.

Visit epsonconnect.com to sign into your account with the email address and password you
selected.

Select your product, select Scan to Cloud, and select Destination List.
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5. Click Add, then follow the instructions on the screen to create your destination list.

6. Now you are ready to use Scan to Cloud. Select the setting for scanning to Scan to Cloud on your
Epson product control panel.

Parent topic: Epson Connect Solutions for Smartphones, Tablets, and More

Related topics
Wi-Fi or Wired Networking

Using AirPrint

AirPrint enables instant wireless printing from iPhone, iPad, and iPod touch with the latest version of
iOS, and Mac with the latest version of OS X.

AirPrint

Load paper in your product.
Set up your product for wireless printing. See the link below.
Connect your Apple device to the same wireless network that your product is using.

b=

Print from your device to your product.
Note: For details, see the AirPrint page on the Apple website.

Parent topic: Product Basics

Related topics
Wi-Fi or Wired Networking

Using Google Cloud Print

With a Google Account, you can print from your Apple or Android device to your Epson product. You can
also print from Chromebooks and the Google Chrome browser without drivers or cables.

1. Connect your Epson product to your wireless network. See the link below.
2. Note your product's IP address by checking your network status. See the link below.
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3. Connect your computer or your Apple or Android device to the same wireless network as your Epson
product.

4. Enter your product's IP address into the address bar of a web browser.
5. Select the Google Cloud Print Services option.

Note: If you don't see the Google Cloud Print Services option, turn your product off and back on. If
the option still doesn't appear, select the Firmware Update option and follow the on-screen
instructions to update your product.

Click Register.

Select the checkbox to agree to the Usage Advisory and click Next.
Click OK to launch the sign-in page.

A separate browser window opens.

9. Enter your Google Account username and password and click Sign in, or, if you don't have an
account, click Sign up for a new Google Account and follow the on-screen instructions.

10. Click Finish printer registration to complete setup and print a test page.

Your product is now linked to your Google Account and can be accessed from any Chromebook,
computer, Apple or Android device with Internet access. Visit Epson Support for more information on
using Google Cloud Print, or the Google Cloud Print website for a list of supported apps.

Setting Up Google Cloud Print on a Chromebook
Parent topic: Product Basics

Related topics
Wi-Fi or Wired Networking

Setting Up Google Cloud Print on a Chromebook
With a Google Account, you can print from a Chromebook without drivers or cables.
1. Connect your Epson product to your wireless network. See the link below.
2. Turn on your Chromebook and connect it to the same wireless network as your product.

Note: See your Chromebook's documentation for details on connecting to a network.

LY


http://www.epson.com/cgi-bin/Store/support/supDetail.jsp?sku=GPRINT
http://www.google.com/cloudprint/learn/index.html
http://www.google.com/cloudprint/learn/apps.html

3. Do one of the following:

» Click Add to Cloud Print in the notification that appears in the corner of your Chromebook
screen.

Note: If you do not see a notification, check to see if a number appears in the status area at the
lower-right corner of the screen. Click this number to open the notifications menu, then click Add
to Cloud Print.

* Open a web browser and enter chrome://devices in the address bar. Skip to step 4.
* If you see a registration confirmation screen instead, click Register.

4. Click Add Device.

5. Click the Register button that appears next to your product.

6. Click Register on the confirmation screen. Your product's LCD screen displays a confirmation
message.

7. Select OK or press the OK button on your product to confirm the Google Cloud Print connection and
print a test page.

Your product is now linked to your Google Account and can be accessed from any Chromebook, iPhone,
or Android phone with Internet access. Visit Epson Support for more information on using Google Cloud
Print, or the Google Cloud Print website for a list of supported apps

Parent topic: Using Google Cloud Print

Using Fire OS Printing

You can wirelessly print from Amazon Fire tablets and phones to your nearby networked Epson product.
There is no software to download, no drivers to install, and no cables to connect. With just a few taps in
Email, Calendar, Contacts, and WPS Office, you can send whatever is on the screen to an Epson
product.

1. Connect your Epson product to your wireless network. See the link below.
2. Connect your Amazon device to the same wireless network as your product.

3. Now you are ready to print. From your Amazon application, tap the print option and select your
product to print whatever is on the screen.

Note: If you see a message telling you that a plug-in is required, tap OK and tap Download. If your
Amazon Fire product uses Fire OS 5 and above, your device automatically uses the built-in Mopria
Print Service app to print.

42


http://www.epson.com/cgi-bin/Store/support/supDetail.jsp?sku=GPRINT
http://www.google.com/cloudprint/learn/index.html
http://www.google.com/cloudprint/learn/apps.html

Visit epson.com/connect to learn more about Fire OS Printing (one of many Epson Connect Partner
Solutions) and check the compatibility of your mobile device.

Parent topic: Product Basics

Using Windows 10 Mobile Printing

You can wirelessly print from Windows 10 Mobile tablets and phones to your nearby networked Epson
product. There is no software to download, no drivers to install, and no cables to connect. Look for the
print option in your Windows 10 application to send whatever is on the screen to an Epson product.

1. Connect your Epson product to your wireless network. See the link below.
2. Connect your Windows 10 Mobile device to the same wireless network as your product.

3. Now you are ready to print. From your Windows 10 application, tap the print option and select your
product to print whatever is on the screen.

Visit epson.com/connect to learn more about Windows 10 Mobile Printing (one of many Epson Connect
Partner Solutions) and check the compatibility of your mobile device.

Parent topic: Product Basics
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Wi-Fi or Wired Networking

See these sections to use your product on a Wi-Fi or wired network.
Wi-Fi Infrastructure Mode Setup

Wi-Fi Direct Mode Setup

Wi-Fi Protected Setup (WPS)

Printing a Network Status Sheet

Changing or Updating Network Connections

Wi-Fi Infrastructure Mode Setup

You can set up your product to communicate with your computer using a wireless router or access point.
The wireless router or access point can be connected to your computer over a wireless or wired network.

1 Epson product
2  Wireless router or access point
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Computer with a wireless interface
Computer
Internet

o o1 A W

Ethernet cable (used only for wired connection to the wireless router or access point)

Selecting Wireless Network Settings From the Control Panel
Parent topic: Wi-Fi or Wired Networking

Selecting Wireless Network Settings From the Control Panel
You can select or change wireless network settings using your product control panel.

To install your product on a wireless network, follow the instructions on the Start Here sheet and install
the necessary software by downloading it from the Epson website. The installer program guides you
through network setup.

Note: Breakdown or repair of this product may cause loss of fax and network data and settings. Epson is
not responsible for backing up or recovering data and settings during or after the warranty period. We
recommend that you make your own backup or print out your fax and network data and settings.

1. Press the M home button, if necessary.

2. Press -
3. Select Wi-Fi Setup.
You see a screen like this:

=) Wi=Fi Setup

' i
| Wi-Fi Setlup Wizord

Push Button Setup (WPS) |
FiIH Code Setup (#WFS) L
| L
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Select Wi-Fi Setup Wizard.

Note: If you need to disable the wireless network to set up your product on an Ethernet network,
scroll down and select Disable Wi-Fi instead. Then follow the instructions on changing to a wired

network connection in this guide.

Select the name of your wireless network or enter the name manually.

Note: To enter the wireless network name manually, select Other Networks and select the
Network (SSID) field. Use the displayed keypad to enter your network name.

Select the Password field and enter your wireless password using the displayed keypad.

Note: The network name and password are case sensitive. Be sure to correctly enter uppercase and

™~
-
™
-
=
=
=l

lowercase letters, and numeric or special characters.

Press when you finish entering your password and select Proceed.

Press II' or El to move the cursor.

Press EI to change the case of letters.
Press E to delete the previous character.
Press to enter numbers and symbols.
Press El to enter a space.
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8. Confirm the displayed network settings and select OK to save them.
Note: If you need to change a setting, press the 3 back button.

9. If you want to print a network setup report, press the &> B&W button. (Otherwise, select Done.)
10. Press the M home button to return to the Home screen.

If the network connection is successful, the Wi-Fi icon in the upper-right corner of the LCD screen is
lit as shown.

) CEE - )

Copy Scon i Preseds

- N — I B
8 b W

Parent topic: Wi-Fi Infrastructure Mode Setup

Related references
Control Panel Buttons and Lights
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Wi-Fi Direct Mode Setup

You can set up your product to communicate directly with your computer or another device without
requiring a wireless router or access point.

LM (s

1 Epson product
2  Computer with a wireless interface
3  Other wireless device

Your product automatically selects one of these modes to communicate with your computer or device:

Access point mode
If your product is not already connected to a wireless network, it enters access point mode and the
product itself acts as the network access point for up to 4 devices. When operating in this mode, your
product displays an AP connection symbol on the LCD screen.

Peer-to-peer mode
If your product is already connected to a wireless network, it enters peer-to-peer mode and
disconnects from any other networks. This also disables any other product features requiring access
to the Internet. When operating in this mode, your product displays a Direct or D connection symbol
on the LCD screen.

Note: To disconnect a peer-to-peer mode connection, release the connection to your product from
your computer or other device. Your product will reconnect to the previously used network.

Enabling Wi-Fi Direct Mode
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Parent topic: Wi-Fi or Wired Networking
Enabling Wi-Fi Direct Mode

You can enable Wi-Fi Direct mode to allow direct communication between your product and computer or
other devices without a wireless router or access point.

1. Press the f home button, if necessary.

2. Press -
3. Select Wi-Fi Setup.
You see a screen like this:

=) Wi-Fi Setup

&
Yi-Fi Setup Wizard

Push Butfon Setup (WFS) |
FIH Code Setup (WES) _L-_.
| L

4. Scroll down and select Wi-Fi Direct Setup.

5. Select Connection Setup.
6. Select Change Password and select Yes.

Note: If you have already connected devices or computers to your product via Wi-Fi Direct, they are
disconnected when you change the password.
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7. Enter your Wi-Fi Direct password.

Note: Your password must be at least 8 and no more than 22 characters long.

* Press II' or El to move the cursor.

* Press EI to change the case of letters.

* Press E to delete the previous character.
* Press to enter numbers and symbols.
* Press El to enter a space.

8. Press when you finish entering your password.
You see a screen like this:

i) Wi=Fi Direct Setup

Cancel
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9. Scroll down to view the SSID (Wi-Fi network name) and password.

10. Use your computer or wireless device to select the Wi-Fi network name (SSID) displayed on the
LCD screen, then enter the password shown.

11. Press the M home button to return to the Home screen.

You see either an AP or Direct connection symbol on the LCD screen and should be able to print
directly to your product from your computer or device.

Note: If the AP or Direct connection symbol is not displayed on the LCD screen, Wi-Fi Direct mode
is not enabled. Repeat these steps to try again.

Parent topic: Wi-Fi Direct Mode Setup

Related references
Control Panel Buttons and Lights

Related tasks
Entering Characters on the LCD Screen

Wi-Fi Protected Setup (WPS)

If your network uses a WPS-enabled wireless router or access point, you can quickly connect your
product to the network using Wi-Fi Protected Setup (WPS).

Note: To check if your router is WPS-enabled, look for a button labeled WPS on your router or access
point. If there is no hardware button, there may be a virtual WPS button in the software for the device.
Check your network product documentation for details.

Using WPS to Connect to a Network

Parent topic: Wi-Fi or Wired Networking

Using WPS to Connect to a Network

If you have a WPS-enabled wireless router or access point, you can use Wi-Fi Protected Setup (WPS) to
connect your product to the network.

1. Press the  home button, if necessary.

2. Press -

3. Select Wi-Fi Setup.
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You see a screen like this:

=) Wi-Fi Setup

&
Wi-Fi Selup Wizard I

Push Butfon Setup (WFS) |
PIH Codde Setup (WPS) | "

4. Select Push Button Setup (WPS).
5. Follow the instructions on the LCD screen to complete WPS setup.
6. Press the M home button.

If the network connection is successful, the Wi-Fi icon in the upper-right corner of the LCD screen is
lit as shown.

A e @ B K
Copy Scan Fix Presets

Parent topic: Wi-Fi Protected Setup (WPS)

Printing a Network Status Sheet

You can print a network status sheet to help you determine the causes of any problems you may have
using your product on a network.

1. Press the  home button, if necessary.
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2. Select Setup.
You see a screen like this:

§T Selup

[ Ik Levels &
Makilennnie | |

Paper Selup ]

Print Status Sheet

. Metwark Stalus

l-l

3. Select Network Status.
4. Select Wi-Fi/Network Status.
You see a screen like this:

i) WieFLfHetwork Status

[ELHT |
Qlain [P faldress

Print

Note: If you are connected to a wireless network, the signal strength is also displayed.

5. Select Print.
6. Pressthe & B&W button to print the network status sheet.

Examine the settings shown on the network status sheet to diagnose any problems you have.
Parent topic: Wi-Fi or Wired Networking
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Changing or Updating Network Connections
See these sections to change or update how your product connects to a network.

Accessing the Web Config Utility

Changing a USB Connection to a Wi-Fi Connection
Changing a Wi-Fi Connection to a Wired Network Connection
Connecting to a New Wi-Fi Router

Disabling Wi-Fi Features

Parent topic: Wi-Fi or Wired Networking

Accessing the Web Config Utility

You can select your product's network settings and confirm its operating status using a web browser.
You do this by accessing your product's built-in Web Config utility from a computer or other device that is
connected to the same network as your product.

Note: For more information on the Web Config utility, see the Administrator's Guide.

Print a network status sheet.
Locate the IP address for your product that is listed on the network status sheet.

3. On a computer or other device connected to the same network as your product, open a web
browser.

4. Enter your product's IP address into the address bar.
You see the available Web Config utility options.
Parent topic: Changing or Updating Network Connections

Related tasks
Printing a Network Status Sheet

Changing a USB Connection to a Wi-Fi Connection

If you have already connected your product to your computer using a USB connection, you can change
to a Wi-Fi connection.

1. Disconnect the USB cable from your product.
2. Uninstall your product software.
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3.

Download and install your product software from the Epson website using the instructions on the
Start Here sheet.

Parent topic: Changing or Updating Network Connections

Changing a Wi-Fi Connection to a Wired Network Connection

If you have already connected your product to your computer wirelessly, you can change to a wired
network connection if necessary.

© 0o N OOk DN~

Disable your product's Wi-Fi features.

Connect one end of an Ethernet network cable to the product's LAN port.

Connect the other end to any available LAN port on your router or access point.
Uninstall your product software.

Download and install your product software from the Epson website.

Follow the on-screen instructions to install the software.

When you see the Select Your Connection screen, select Wired network connection.
If you see a Select Setup Option screen, select Set up printer for the first time.
Continue following the rest of the on-screen instructions.

Parent topic: Changing or Updating Network Connections

Related tasks
Disabling Wi-Fi Features

Connecting to a New Wi-Fi Router

If you change the wireless router you have been using on your network, you need to update your
product's Wi-Fi connection to the new router.

Note: If you switch to a 5 GHz wireless router, set the router to operate in dual band (2.4 GHz and
5 GHz) mode. See your router documentation for instructions.

1.

Do one of the following:
* Windows: Uninstall your product software.
+ OS X: Go to the next step.

Download and install your product software from the Epson website using the instructions on the
Start Here sheet.
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Parent topic: Changing or Updating Network Connections

Related tasks
Uninstalling Product Software - Windows

Disabling Wi-Fi Features

You may need to disable your product's Wi-Fi features if you change your network connection type or
need to solve a problem with your network connection.

Note: Before disabling Wi-Fi features, make a note of your product's SSID (network name) and
password, and any network settings selected for the Epson Connect services you may use.

1. Press the % home button, if necessary.

2. Press -
3. Select Wi-Fi Setup.
You see this screen:

=) Wi=Fi Setup

&
i-Fi Setup Wizard

Push Button Setup (8F5) |
FIH Code Setup (WRS) _L-_'
| ¥

4. Scroll down and select Disable Wi-Fi.
5. Select Yes to disable Wi-Fi.
Parent topic: Changing or Updating Network Connections
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Enabling Epson Universal Print Driver (PCL) or PostScript
Printing
Before enabling Epson Universal Print Driver (PCL) or PostScript printing on your product, make sure
you have installed the software as described on the Start Here sheet.

Installing the Epson Universal Print Driver - Windows
Installing the PostScript (PS3) Printer Software - Windows
Installing the PostScript (PS3) Printer Software - OS X
Selecting PDL (Page Description Language) Settings
Selecting Printer Language and Interface Settings
Printing a PS3 (PostScript) Status Sheet

Installing the Epson Universal Print Driver - Windows

The Epson Universal Print Driver supports multiple printer languages, such as PCL and ESC/P-R, and
can be installed on a Windows computer.

Note: Make sure your product is turned on and connected to the same network as your computer before
installing the printer software. Depending on your model, not all printer languages may be supported.

1. Download the EPSON Universal Print Driver from epson.com/support/wfm5694downloads.
2. Double-click the downloaded package.
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3. Follow the on-screen instructions until you see this screen:

EPSOM Printer Uitilities Setup

Detect the printer, and automatically configure the port.
Is $he printer connecied via a network 7

(®)Yea: Histwork connectiar]

Saarch aplions ..

et () No: USE connection

[[] Set Defaut of Frinter Corbrol Language to PCLE

OK Abort

4. Select Yes: Network connection and click OK.

Note: Select the Set Default of Printer Control Language to PCL6 checkbox if you want to set the
default printer language to PCL6. Leave this option deselected to set the printer language to ESC/P-
R. (You can change this setting later as needed.)
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After the software finishes searching for products, you see a screen like this:

! EPS0OM Printer LHilities Setup 7 ®
(%) Add EPSON Liniwansal Print Driver
() Add fiound perters
Seladd & pad ta carmect & prrier
Salact from found panters o
Found Printers:
Mode! flame P Addness MAL Addness Location
WP XG0 192 16813000 DO2GABFREDIC
V- 20000 152 1681000 ACTRIEICE0RC Unberienan
W= 2000 182 1681000 DOZEABFFISED Linkncwm
< >
£ Set as defaull prnter Diaplay Setngs
= ]

5. Do one of the following:

* If you are installing one product, make sure Add EPSON Universal Print Driver is selected and
continue with the next step.

+ If you are installing more than one product, select Add found printers and go to step 9.

Note: You can customize and filter your product search results by clicking Display Settings.
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Open the Select a port to connect a printer menu and select an existing printer port, if necessary.
Otherwise, skip this option to create a new port automatically.

Select the product you want to install from the Found Printers list.

Note: Deselect the Set as default printer checkbox if you do not want the product to be set as your
default printer.

Click OK, then skip the remaining steps.

If you are installing more than one product, select the products from the Found Printers list and click
Add to Printer Folder.

! EPSOM Printer Lialities Setup 7 by

() Add EPSOMN Urievaraal Print Driver
(%) Add fourd perters

Salect prirters from the falowing list, amd then dick the "Add to Prinber Falder” bufton . (You can
select mubple printers from the: list )

Found Printers:
Madel Mame P Address MAL Address Locaton il
WF- X000 192 16813000 ACB2E2BET
WF-2000 152 16813000 B4EBBC2551CE
WE- 00 192 1681000 EAEBBCTANFID
WIP-X0H 192 16813000 DO2GABFREDIC
WF-20000 152 168110004 AC1EMEICH05C
ET- X0 192168 130001 40244048341
REAE A0 88 4 M ABECSERM v
L4 *
Ak tio Printer Folder | Diaplay Settings
Printers to be addsd
Mam= of added prinler IF Address

[ ERSOM Universal Print Dierver WF- 30004 192,168, 1. 3000
[C] EPSOM Universal Print Detver WF-1000 152.168.1.3060C

indio Edit

Salerd & prnter from ihe s 1o 28 § & the delasuk prinber

Help Aot 0K Back
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The selected products appear in the lower section of the screen.
10. Select the checkbox next to the product you want to make your default printer, if necessary.
11. Click OK.
Parent topic: Enabling Epson Universal Print Driver (PCL) or PostScript Printing

Installing the PostScript (PS3) Printer Software - Windows

If you did not install the standard Epson printer software, you need to install the PostScript (PS3) printer
software before you can adjust the print settings and print to your network printer.

Note: Make sure your product is turned on and connected to the same network as your computer before
installing the printer software.

1. Download the Drivers and Utilities Combo Package - PS3 PostScript from
epson.com/support/wfm5694downloads.

Double-click the downloaded package.
Click OK.

Click Accept.

Click Install.

I

. Click Next and follow the on-screen instructions.
Parent topic: Enabling Epson Universal Print Driver (PCL) or PostScript Printing

Installing the PostScript (PS3) Printer Software - OS X

If you did not install the standard Epson printer software, you need to install the PostScript (PS3) printer
software before you can adjust the print settings and print to your network printer.

Note: Make sure your product is turned on and connected to the same network as your computer before
installing the printer software.

1. Download the Drivers and Utilities Combo Package - PS3 PostScript from
epson.com/support/wfm5694downloads.

2. Double-click the downloaded package.

3. Double-click EPSON.
Click Continue on the next two screens.
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Click Agree.
Click Install.
If necessary, enter the administrator password.

® N o O

. Click Start and follow the on-screen instructions.
Parent topic: Enabling Epson Universal Print Driver (PCL) or PostScript Printing

Related topics
Printing with the PostScript (PS3) Printer Software - OS X

Selecting PDL (Page Description Language) Settings

You can select settings for PCL and PostScript printing using the control panel on the product.

Note: These settings can be locked by an administrator. If you cannot access these settings, contact
your administrator for assistance.

1. Press the f home button, if necessary.
2. Select Setup.
You see a screen like this:

41 Setup

[ Ink Levels I
MaiTennnpe | |

Faper Selup ]

Frint Status Sheet |
. Retwark Shalus ]l:

3. Scroll down and select System Administration. Enter the administrator password, if necessary.
4. Select Universal Print Settings.
5. Select PDL Print Configuration.
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You see a screen like this:

B POL Priet Condiquration

Conmon Sellings |
PL Menu |
el M |

6. Select one of the options shown above, then select the settings you want to use.

7. When you are finished, press the f home button.

PDL Print Configuration Options

Parent topic: Enabling Epson Universal Print Driver (PCL) or PostScript Printing

PDL Print Configuration Options

Select the PDL Print Configuration options you want to use for PCL or PostScript printing.

PDL Print Configuration
option

Available
settings

Description

Common Settings

Paper Size Various sizes Sets the default paper size for PCL or PostScript
printing.

Paper Type Various paper Sets the default paper type for PCL or PostScript
types printing.

Orientation Portrait Sets the default orientation for PCL or PostScript
L printing.

andscape

Quality Draft Sets the quality for PCL or PostScript printing.
Standard
Best
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PDL Print Configuration

Available

Description

option settings
Ink Save Mode On/Off Saves ink by reducing print density.
Print Order Last Page on Starts printing from the first page of a file.

Top

First Page on
Top

Starts printing from the last page of a file.

Number of Copies 1 to 999 Selects the number of copies to print.

Binding Margin Left Edge Specifies the binding edge for double-sided documents.
Top Edge

Auto Paper Ejection On/Off Ejects paper automatically when printing is stopped

during a print job.

2-Sided Printing On/Off Selects duplex printing.

PCL Menu

Font Source Resident Uses a font preinstalled on the printer.
Download Uses a font you have downloaded.

Font Number 1to 111 Selects the default font number for the default font

source.

Pitch

0.44 to 99.99 cpi

Selects the default font pitch if the font is scalable and
fixed-pitch (availability depends on font source and
number settings).

Height

4.00 t0 999.75 pt

Selects the default font height if the font is scalable and
proportional (availability depends on font source and
number settings).

Symbol Set

Various

Selects the default symbol set. If the selected font is not
available for the selected symbol set, the font source
and number are replaced with IBM-US (the default
setting).
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PDL Print Configuration | Available Description
option settings
Form 510 128 lines Sets the number of lines for the selected paper size and
orientation. Changes the line spacing (VMI) stored in
the printer. Later changes in page size or orientation
cause changes in the Form value based on the stored
VMI.
CR Function CR Selects the line feed command when printing with a
CR+LF driver from a specific operating system.
LF Function LF
CR+LF
Paper Source Assign 4 Makes the paper source select command compatible
with HP LaserJet 4
4K Makes the paper source select command compatible
with HP LaserJet 4000, 5000, and 8000
58 Makes the paper source select command compatible
with HP LaserJet 5S
PS3 Menu
Error Sheet On/Off Prints a sheet showing the status when errors occur
during PostScript or PDF printing.
Binary On/Off Enable when printing files that contain binary images.

Allows you to print binary images even if the driver is set
to ASCII.

PDF Page Size

Various sizes

Selects the paper size when printing a PDF file. If Auto
is selected, the paper size is determined based on the
size of the first page.

Parent topic: Selecting PDL (Page Description Language) Settings

Selecting Printer Language and Interface Settings
You can select printer language and interface settings using the control panel on the product.
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Note: These settings can be locked by an administrator. If you cannot access these settings, contact
your administrator for assistance.

Press the M home button, if necessary.
2. Select Setup.
You see a screen like this:

T &

Paper Selup

. Metwork Stalus ¥

I
Frint Status Sheet |
|

3. Scroll down and select System Administration. Enter the administrator password, if necessary.
4. Select Printer Settings.
You see a screen like this:

Frinter Seftings

F"-:l:-:f Sournce Sellings

ll:".-H IFF Timeouil Sseliing | |

F‘r‘ﬂtm Langusie

1
futo Errce Sobver ]

|k L1
Memory Divice Interface ltl

5. Select the Printing Language and other settings you want to use.
6. When you are finished, press the f home button.
Printer Language and Interface Options
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Parent topic: Enabling Epson Universal Print Driver (PCL) or PostScript Printing

Printer Language and Interface Options

Select the settings you want to use.

Printer Settings option [ Available Description
settings
USB I/F Timeout Setting | 0.5 to 300 Specify the length of time before ending USB
seconds communication from a computer using the PCL or
PostScript driver. This setting is necessary to avoid
endless USB communication.
Printing Language Auto Select the language for the USB or network interface.
PCL
PS3
PDF
PC Connection via USB | Enable Select whether to allow USB communication with the
Disable product.

Parent topic: Selecting Printer Language and Interface Settings

Printing a PS3 (PostScript) Status Sheet

You can print a PS3 (PostScript) status sheet or font list to confirm the current PostScript printer

software version or fonts.

1. Press the M home button, if necessary.

2. Select Setup.
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You see a screen like this:

[ Ink Levels I

Maintenanoe | |
Paper Setup |

Print Status Sheet |
. Retwark Stalus ] ¥

3. Select Print Status Sheet.

4. Select the status sheet you want to print.

5. Press the & B&W button to print the status sheet.

Parent topic: Enabling Epson Universal Print Driver (PCL) or PostScript Printing

68



Loading Paper

Before you print, load paper for the type of printing you will do.
Note: Load only plain paper when printing with the PCL or PostScript (PS3) printer software.

Loading Paper in the Cassette

Loading Paper and Envelopes in the Rear Paper Feed Slot
Paper Loading Capacity

Available Epson Papers

Paper or Media Type Settings - Printing Software

Selecting the Paper Settings for Each Source - Control Panel
Selecting Default Paper Settings - Administrator

Installing and Enabling the Optional Second Paper Cassette

Loading Paper in the Cassette
You can load plain paper in these sizes in the paper cassette:
+ Letter (8.5 x 11 inches [216 x 279 mm])
* A4 (8.3 x 11.7 inches [210 x 297 mm])
* Legal (8.5 x 14 inches [216 x 356 mm])
1. Close the paper stopper and output tray, if necessary.
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Pull out the paper cassette. If you are loading paper in the optional cassette, remove the paper
cassette cover.
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4. Set the front edge guide to the paper size you are using.

=~
N\
B5
@
A4
\ |

5. Load a stack of paper, printable side down, against the edge guide as shown.

(

Note: Make sure the paper is loaded against the edge guide and not sticking out from the end of the
cassette.
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6. Slide the edge guides against the paper, but not too tightly. If you are loading paper in the optional
cassette, reattach the paper cassette cover.

Caution: To prevent paper feeding problems, make sure the paper fits beneath the top edges of the
guides.

7. Keep the cassette flat as you gently insert it.
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8. Extend the output tray and open the paper stopper.

Note: If you are using legal-size or longer paper, do not open the paper stopper. Do not remove or
insert the paper cassette during printing.

9. Select the size and type of paper you just loaded on the product LCD screen.
Always follow these paper loading guidelines:

» Load only the recommended number of sheets.

* Load paper short edge first, no matter which way your document faces.

» Load the printable side facedown.

» Load letterhead or pre-printed paper top edge first.

* Do not load paper above the arrow mark inside the edge guides.

» Check the paper package for any additional loading instructions.

Parent topic: Loading Paper

Related references

Paper Loading Capacity

Related tasks

Loading Paper and Envelopes in the Rear Paper Feed Slot

Loading Paper and Envelopes in the Rear Paper Feed Slot
You can print envelopes or documents in a variety of paper types and sizes in the rear paper feed slot.
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1. Extend the output tray and open the paper stopper.

Note: If you are using legal-size or longer paper, do not open the paper stopper.

2. Open the feeder guard and pull up the paper support.
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3. Flip the feeder guard forward, then slide the edge guides outward.

4. Ifyou are inserting a stack of paper, fan the sheets first and tap the stack on a flat surface to even
the edges.

Note: You can load one sheet of binder paper with holes on one of the long edges as shown. Do not
select automatic 2-sided printing for this type of paper.

(- )

®
L9

000000000000000000
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5. Do one of the following:
* Insert paper, glossy or printable side up and short edge first, in the center of the tray.

Caution: To prevent paper feeding problems, make sure you do not load too much paper in the
slot.

» Load envelopes short edge first, with the flap facing down and the flap edge to the left, in the
center of the slot.
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6. Slide the edge guides against the paper, but not too tightly.

S SE—

7. Select the size and type of paper you just loaded on the product LCD screen.

Always follow these paper loading guidelines:

Load only the recommended number of sheets.

Load paper short edge first, no matter which way your document faces.
Load the printable side faceup.

Load letterhead or pre-printed paper top edge first.

Do not load paper above the arrow mark inside the edge guides.

If you have trouble loading a stack of envelopes, press each envelope flat before loading it or load one
envelope at a time.

If print quality declines when printing multiple envelopes, try loading one envelope at a time.
Do not load envelopes that are curled, folded, or too thin.
Check the paper package for any additional loading instructions.

Parent topic: Loading Paper

Related references

Paper Loading Capacity
Related tasks

Loading Paper in the Cassette
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Paper Loading Capacity

Paper type Loading capacity - paper Loading capacity - rear paper
cassette feed slot
Plain paper 250 sheets 80 sheets
Copy paper Letter (8.5 x 11 inches
[216 x 279 mm]) or A4
Letterhead (8.3 x 11.7 inches
Recycled paper [210 x 297 mm])
Color paper 250 sheets 1 sheet
Preprinted paper Legal (8.5 x 14 inches
[216 x 356 mm])
Epson Bright White Paper 200 sheets 50 sheets

20 sheets for manual two-sided
printing

Epson Presentation Paper Matte

80 sheets

Thick paper (cardstock up to 68 Ib
[256 g/m2])

10 sheets

Letter (8.5 x 11 inches
[216 x 279 mm]) or A4
(8.3 x 11.7 inches
[210 x 297 mm])

5 sheets for manual two-sided
printing

1 sheet

Legal (8.5 x 14 inches
[216 x 356 mm])
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Paper type

Loading capacity - paper
cassette

feed slot

Loading capacity - rear paper

Epson Premium Presentation Paper
Matte

Epson Premium Presentation Paper
Matte Double-sided

Epson Ultra Premium Presentation
Paper Matte

Epson Brochure & Flyer Paper
Matte Double-sided

20 sheets

Envelopes

10 envelopes

Parent topic: Loading Paper

Available Epson Papers

You can purchase genuine Epson ink and paper at epson.com/ink3 (U.S. sales) or epson.ca (Canadian
sales). You can also purchase supplies from an Epson authorized reseller. To find the nearest one, call

800-GO-EPSON (800-463-7766).

Paper Matte Double-sided

[216 x 279 mm])

Paper Type Size Part number Sheet count
Epson Bright White Paper Letter (8.5 x 11 inches S041586 500
[216 x 279 mm])
Epson Brochure & Flyer Paper Letter (8.5 x 11 inches S042384 150
Matte Double-sided [216 x 279 mm])
Epson Presentation Paper Matte | Letter (8.5 x 11 inches S041062 100
[216 x 279 mm])
Legal (8.5 x 14 inches S041067 100
[216 x 356 mm])
Epson Premium Presentation 8 x 10 inches (203 x 254 mm) | S041467 50
Paper Matte Letter (8.5 x 11 inches S041257 50
[216 x 279 mmy) S042180 100
Epson Premium Presentation Letter (8.5 x 11 inches S041568 50
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Paper Type Size

Part number Sheet count

Epson Ultra Premium Presentation
Paper Matte

Letter (8.5 x 11 inches
[216 x 279 mm])

S041341 50

Parent topic: Loading Paper

Paper or Media Type Settings - Printing Software

For this paper

Select this paper Type or Media Type setting

Plain paper
Epson Bright White Paper

Plain Paper / Bright White Paper

Letterhead paper Letterhead
Recycled paper Recycled
Color paper Color
Preprinted paper Preprinted
Envelopes Envelope

Epson Presentation Paper Matte
Epson Premium Presentation Paper Matte

Epson Premium Presentation Paper Matte Double-
sided

Epson Brochure & Flyer Paper Matte Double-sided
Epson Ultra Premium Presentation Paper Matte

Premium Presentation Paper Matte

Cardstock up to 68 Ib (256 g/m?)

Card Stock

Note: The settings listed here are available only when printing from your computer; they do not apply to

your product's control panel settings.

Parent topic: Loading Paper

Selecting the Paper Settings for Each Source - Control Panel

You can change the default paper size and paper type for each source using the control panel on the

product.
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Press the M home button, if necessary.
Select Setup.
You see a screen like this:

[ Ink Levels I

Paper Selup

| Meiwark Stalus ¥

l
Frint Status Sheet |
l

Select Paper Setup.
Select the paper source you want to change.

You see a screen like this:

" Paper Skze
_|
" Paper Type
_|

Select Paper Size.

Select the paper size you loaded.
Select Paper Type.

Select the paper type you loaded.
Select OK.
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10. Select another paper source to change or press the M home button.
Paper Type Settings - Control Panel
Parent topic: Loading Paper

Paper Type Settings - Control Panel

For this paper Select this Paper Type setting

Plain paper Plain Paper
Epson Bright White Paper
Epson Presentation Paper Matte

Letterhead paper Letterhead
Recycled paper Recycled
Color paper Color
Preprinted paper Preprinted
Envelopes Envelope
Epson Premium Presentation Paper Matte Prem. Matte

Epson Premium Presentation Paper Matte Double-
sided

Epson Ultra Premium Presentation Paper Matte
Epson Brochure & Flyer Paper Matte Double-sided

Thick paper (cardstock up to 68 Ib [256 g/m2]) Card Stock

Parent topic: Selecting the Paper Settings for Each Source - Control Panel

Selecting Default Paper Settings - Administrator
As an administrator, you can adjust default paper settings that apply to all print jobs sent to the product.

Note: These settings can be locked by an administrator. If you cannot access these settings, contact
your administrator for assistance.

Selecting the Default Printer Settings
Setting the Universal Print Settings
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Parent topic: Loading Paper

Selecting the Default Printer Settings

You can change default printer settings using the control panel on the product.

Note: These settings can be locked by an administrator. If you can't access these settings, contact your
administrator for assistance.

1. Press the % home button, if necessary.
2. Select Setup.
You see a screen like this:

[ Ik Levels I

Mairtenanee | |
Paper Setup |

Print Status Sheet |
 etwark Stalus K

3. Scroll down and select System Administration. Enter the administrator password, if necessary.
You see a screen like this:

Bt System Adninistration

. Printer Settings | [
Conmon Settings | I
Wi=Fi Hetmork Setlings |

Epson Connect Services I

 Gungle Cliusd Prind Services K
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4. Select Printer Settings.
5. Select one of these Auto Error Solver options:

» Turn on this setting to display a warning and print on one side of paper only when a 2-sided
printing error occurs, or to print the data that the printer could process when a memory full error
occurs.

+ Turn off this setting to display an error message and stop printing if an error occurs.
6. When you are finished, press the A home button to return to the Home screen.
Paper Source Settings Options
Parent topic: Selecting Default Paper Settings - Administrator
Paper Source Settings Options
Select the Paper Source Settings options you want to use for your printed jobs.

Paper Source Available settings [Description
Settings option
Rear Paper Feed | Normal Select Normal to give printing priority to paper loaded in the
Priority Last rear paper feed slot.
Ad/Letter Auto On Select On to switch the selected paper size to match the
Switching Off loaded paper (Letter or A4) if the wrong size is selected.
Auto Select Copy Select On for any of these settings to automatically print on
Settings Fax paper from any source containing paper that matches your
paper settings.

Other

Error Notice Paper Size Notice | Select On for either of these settings to display an error
- message when the selected paper type or size does not
Paper Type Notice match the loaded paper.

Parent topic: Selecting the Default Printer Settings

Setting the Universal Print Settings

You can change the default universal print settings using the control panel on the product.

Note: These settings can be locked by an administrator. If you cannot access these settings, contact
your administrator for assistance.
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1. Press the f home button, if necessary.
2. Select Setup.
You see this screen:

[ Ink Levels I

Mairtenanoe | |
Paper Selup |

Frint Status Sheet |
. Retwark Stalus ] ¥

3. Scroll down and select System Administration. Enter the administrator password, if necessary.
You see this screen:

Bt System Adninistration

. Printer Seitings | i
Connon Setlings | I

i=Fls Hetrork Setlings
Epson Conmett Sefvices I
| Gongle Cluusd Prind Services ||w

4. Select Universal Print Settings.

5. Adjust the settings as necessary.

6. When you are finished, press the f home button.
Universal Print Settings Options

Parent topic: Selecting Default Paper Settings - Administrator
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Universal Print Settings Options

Select the Universal Print Settings you want to use.

Universal Print
Settings option

Available settings

Description

Top Offset — Adjusts the top or left margin.
Left Offset —
Top Offset in — Adjusts the top or left margin of the back page when
Back performing double-sided printing.
Left Offset in —
Back
Check Paper On Select On to check the paper width before printing. This
Width Off prevents printing beyond the edges of the paper when the
paper size settings are incorrect, but may reduce the
printing speed.
Dry Time Standard Select the ink drying time you want to use when performing
Long double-sided printing.
Longer
Skip Blank Page [On Select On to skip printing of blank pages automatically.
Off

Parent topic: Setting the Universal Print Settings

Installing and Enabling the Optional Second Paper Cassette
Follow these instructions to add the optional paper cassette to your product.

Note: If you are using the optional paper cassette with the PCL or PostScript (PS3) printer software, you
must enable the second cassette in the printer software.

Installing the Optional Second Paper Cassette

Parent topic: Loading Paper
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Installing the Optional Second Paper Cassette
You can install the optional paper cassette to provide more paper capacity.
1. Turn off the product and unplug the power cord and any connected cables.

Warning: To avoid electric shock, make sure you unplug the power cord.

Remove the paper cassette from its carton and place it where you want to set up the product.

3. Carefully lift the product as shown, then gently lower it onto the paper cassette. Make sure the
connectors and pins align correctly.

4. Reconnect the power cord and other connection cables, and plug in the product.
5. Turn on the product.
Parent topic: Installing and Enabling the Optional Second Paper Cassette
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Placing Originals on the Product

Follow the instructions here to place your original documents or photos on the product.

Caution: Do not place anything on top of your product or use its cover as a writing surface to avoid
damagingit.

Placing Originals on the Scanner Glass
Placing Originals in the Automatic Document Feeder

Placing Originals on the Scanner Glass

You can place originals up to this size on the scanner glass: Letter (8.5 x 11 inches [216 x 279 mm]) or
A4 (8.3 x 11.7 inches [210 x 297 mm]).

1. Open the document cover.
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2. Place your original facedown on the scanner glass with the top facing into the corner. Slide the
original to the edges of the indicated corner.

Note: You can place multiple originals on the scanner glass. Just make sure they are at least
0.8 inch (20 mm) away from each other.

3. Close the document cover gently to keep your original in place.
Parent topic: Placing Originals on the Product

Related topics
Copying
Scanning
Faxing

Placing Originals in the Automatic Document Feeder

You can place multi-page original documents in the Automatic Document Feeder (ADF).You can also
use the ADF to scan both sides of a 2-sided document. Make sure the originals meet the Automatic
Document Feeder specifications before loading them.

Caution: Make sure your originals are not creased or folded, and do not contain holes, staples, tape, or
other materials that could obstruct the feeder.
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1. Slide the ADF edge guide outward.

2. Fan your stack of originals and tap them gently on a flat surface to even the edges.

» )
/;§;;

3. Insert the originals into the ADF faceup and top-edge first.
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The ADF icon on the control panel lights up.
4. Slide the ADF edge guide against the originals, but not too tightly.
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Parent topic: Placing Originals on the Product

Related references

Automatic Document Feeder (ADF) Specifications
Related topics

Copying

Scanning

Faxing
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Copying

See the information here to copy documents or photos using your product.
Note: Copies may not be exactly the same size as your originals.

Copying Documents or Photos
Copying Options

Copying Documents or Photos

You can copy documents or photos onto various sizes and types of paper, including Epson special
papers.

1. Place your original document or photo on the scanner glass, or place multi-page documents in the
ADF.

2. Load the paper you want to print on.
3. Press the M home button, if necessary.
4. Select Copy.

You see a screen like this:

B cop =1

= [ocumend ronles
Em Lagoul 1] S capie

. U

5. To print more than one copy, press a number key on the product's control panel, or select copies
and use the displayed keypad to enter the number of copies.

6. Change any of the displayed settings as necessary.
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7. Select Settings to view and change additional copy settings, if necessary. Then press the 3 back

button

8. Select Preview to preview your copy on the LCD screen.

9. Select Preset to save your copy settings.

Note: Presets can be locked by an administrator. If you can't access or change this setting, contact
your administrator for assistance.

10. When you are ready to copy, press the & B&W button.

Note: To cancel printing, press the & Stop button or select Cancel.

Parent topic: Copying

Copying Options

Select the copying options you want to use for your copies.

Note: Not all options or settings may be available, depending on other copying settings.

Copying option

Layout

Available settings |Description
With Border Leaves a small margin around the image or document
2-up Copies multiple page documents onto one sheet. Also,
4 select Settings and change the Document Orientation and
-up .
Layout Order settings as necessary.
ID Card Copies both sides of an ID card onto one side of a sheet of

paper

Document Size

Various sizes

Select the document size of your original

Paper Source

Various sources

Select the paper source that you want to use. If you select
Auto, paper is fed automatically depending on the paper
settings you selected for the paper sources.
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Copying option

Available settings

Description

Zoom Custom Size Automatically sizes the image by the percentage you select
Actual Size Copies at 100% size
Auto Fit Page Automatically sizes the image to fit the paper size you
selected
Letter->4x6in and Automatically converts from one size to another
other conversions
2-Sided Off Select to make 2-sided copies. When you select 1>2-Sided
- or 2>1-Sided, also select Advanced and select the binding
2>2-Sided S .
edge for your originals or copies.
1>2-Sided
2>1-Sided
Document Portrait Specifies the orientation of your originals
Orientation Landscape
Quality Text Specifies the document type of your originals and adjusts
Text(Best) the quality of your copies
Text & Image
Text & Image(Best)
Photo
Density Varying levels Adjusts the lightness or darkness of copies
Remove Shadow | Off Select On to erase the shadows that appear in the center of
on a document when copying a book or that appear around a
document when copying thick paper.
Remove Punch | Off Select On to erase the binding holes on a document
Holes o
n
Collate Copy Off Select On to print multiple copies of a multi-page document
on both in order and sorted into sets
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Copying option

Available settings

Description

Dry Time Standard Select to adjust the drying time for 2-sided copies, if
L smudges or marks appear on the front of the paper when
ong . ;
you print on the second side
Longer
Advanced Various settings Select advanced settings such as Saturation and
Settings Sharpness

Parent topic: Copying
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Printing from a Computer

Before printing from your computer, make sure you have set up your product and installed its software
as described on the Start Here sheet.

Note: If you have an Internet connection, it is a good idea to check for updates to your product software
on Epson's support website. If you see a Software Update screen, select Enable automatic checking
and click OK. The update scans your system to see if you have the latest product software. Follow the
on-screen instructions.

Printing with Windows

Printing with OS X

Printing with the Epson Universal Print Driver - Windows
Printing with the PostScript (PS3) Printer Software - Windows
Printing with the PostScript (PS3) Printer Software - OS X
Cancelling Printing Using a Product Button

Printing with Windows

You can print with your product using any Windows application, as described in these sections.
Selecting Basic Print Settings - Windows

Selecting Double-sided Printing Settings - Windows

Selecting Additional Layout and Print Options - Windows

Selecting a Printing Preset - Windows

Selecting Extended Settings - Windows

Printing Your Document or Photo - Windows

Selecting Default Print Settings - Windows

Changing Automatic Update Options

Parent topic: Printing from a Computer

Selecting Basic Print Settings - Windows
Select the basic settings for the document or photo you want to print.
1. Open a photo or document for printing.
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2. Select the print command in your application.

Note: You may need to select a print icon on your screen, the Print option in the File menu, or
another command. See your application's help utility for details.

3. If necessary, select your product name as the printer you want to use.
Note: You may also need to select Properties or Preferences to view your print settings.

You see the Main tab of your printer settings window:

# Printing Preference =
Wan Mo Opbonz Mardsrancs

Frmting Presets Faper Source ot Selech
Agd Riemove Presets. .. Dooument Sipe Letter (8 /2 € L1 in)

=) Cooment - Fast
=| Documenit - Standard Qualiy

Crwntatio W Pt () Lanciacape
= Document - High Quakity
Cocument - 1-Gated Paper Type Pian Paper | Engnt Whis Faper w
A1%| Documenit - 2-Up
Document - 2-Sded with 2-4p Chaslity Standard “
2hded Frining  OF w
— @ Muli-Page e w
. | Copes L = Elcotate
— a‘.| a | REverse Crder
Ay ._rjll
et Mode off
Show Settings [l Print Preview
Job Amra Lite
Reset Defaults Ik Lseeds L el

4. Forthe Paper Source setting, select where you loaded the paper you want to print on.
5. Select the size of the paper you loaded as the Document Size setting.

Note: You can also select the User-Defined setting to create a custom paper size.
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6. Select the orientation of your document.
Note: If you are printing an envelope, select Landscape.
7. Select the type of paper you loaded as the Paper Type setting.

Note: The setting may not exactly match the name of your paper. Check the paper type settings list
for details.

8. Select the Quality setting that matches the print quality you want to use.

9. To print on both sides of the paper, select the 2-Sided Printing setting and select the options you
want.

10. To print multiple pages on one sheet of paper, or print one image on multiple sheets of paper, select
one of the settings in the Multi-Page menu and select the printing options you want.

11. To print multiple copies and arrange their print order, select the Copies options.
12. To preview your job before printing, select Print Preview.

13. To save your print job as a project that can be modified and combined with other print jobs, select
Job Arranger Lite.

14. To reduce noise during printing when you select Plain Paper/Bright White Paper, select On in the
Quiet Mode menu.

Paper Source Options - Windows

Print Quality Options - Windows

Multi-Page Printing Options - Windows

Parent topic: Printing with Windows

Related references

Paper or Media Type Settings - Printing Software
Paper Type Settings - Control Panel

Related tasks
Selecting Double-sided Printing Settings - Windows
Printing Your Document or Photo - Windows

Paper Source Options - Windows

You can select any of the available options in the Paper Source menu to print on the paper loaded in that
source.
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Auto Select
Automatically selects the paper source based on the selected paper size.

Paper Cassette 1
Selects the paper in cassette 1 as the paper source.

Paper Cassette 2
Selects the paper in cassette 2 as the paper source.

Rear Paper Feed Slot
Selects the paper in the rear feed slot as the paper source.

Parent topic: Selecting Basic Print Settings - Windows
Print Quality Options - Windows

You can select any of the available Quality options to fine-tune the quality of your print. Some settings
may be unavailable, depending on the paper type and border setting you have chosen.
Draft
For draft printing on plain paper.
Standard
For everyday text and image printing.
High
For photos and graphics with high print quality.
More Settings
Opens a window that lets you choose among levels of speed and quality.
Parent topic: Selecting Basic Print Settings - Windows
Multi-Page Printing Options - Windows
You can select any of the available options in the Multi-Page menu to set up your multi-page print job.
2-Up and 4-Up

Prints 2 or 4 pages on one sheet of paper. Click the Page Order button to select page layout and
border options.

2x1 Poster, 2x2 Poster, 3x3 Poster, 4x4 Poster

Prints one image on multiple sheets of paper to create a larger poster. Click the Settings button to
select image layout and guideline options.

Parent topic: Selecting Basic Print Settings - Windows
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Selecting Double-sided Printing Settings - Windows
You can print on both sides of the paper by selecting one of the 2-Sided Printing options on the Main
tab.

Note: Some options may be pre-selected or unavailable, depending on other settings you have chosen
or if you are accessing the product over a network.

2-5ided Printing | Off W

1. Select one of the following options for 2-Sided Printing:

* Auto (Long-edge binding) to print your double-sided print job by automatically flipping the paper
on the long edge.

+ Auto (Short-edge binding) to print your double-sided print job by automatically flipping the paper
on the short edge.

* Manual (Long-edge binding) to print your double-sided print job by printing one side and
prompting you to flip the paper over on the long edge to print the other side (recommended for
paper types that do not support automatic duplexing).

* Manual (Short-edge binding) to print your double-sided print job by printing one side and
prompting you to flip the paper over on the short edge to print the other side (recommended for
paper types that do not support automatic duplexing).

2. Click the Settings button.

101



You see this window:

2-5ided Printing Settings

{eft Top Right
@ir.F!!H'EdH'-‘-;: O Shaort-edge I::}L|::|r1g|—em:lg|e

Binding Margin

Front Page 0.00 5 [0.00... 1.18]

Back Page 0.00 -2 [0.00...1.18)

Uit Cimm ® inch

Start Page
(®) From Front

(") From Back

Create Folded Booklet
[[] Bookdet

Center Binding Side Binding
AL |FF__
B =

3. Select the double-sided printing options you want to use.
4. Click OK to return to the Main tab.
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5. Click the Print Density button.
You see this window:

Print Density Adjustment

Select Document Type

() Text (®)Text & Graphicst () Text & Photos () Uses Defined
Adjustments
Print Diensity L (%)
-5 1]
Increase Ink Drying Time L) 0 (sec)
] &0

6. Select the type of document you are printing as the Document Type setting. The software
automatically sets the Adjustments options for that document type.

7. If necessary, select the Adjustments options you want to use.

8. Click OK to return to the Main tab.

9. Print a test copy of your double-sided document to test the selected settings.
10. Follow any instructions displayed on the screen during printing.

Double-sided Printing Options - Windows
Print Density Adjustments - Windows

Parent topic: Printing with Windows

Related tasks
Selecting Basic Print Settings - Windows

Double-sided Printing Options - Windows

You can select any of the available options on the 2-Sided Printing Settings window to set up your
double-sided print job.
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Binding Edge Options
Select a setting that orients double-sided print binding in the desired direction.

Binding Margin Options
Select options that define a wider margin to allow for binding.

Start Page
Selects whether printing starts on the front or back page.

Create Folded Booklet Options
Select the Booklet checkbox and a binding option to print double-sided pages as a booklet.

Parent topic: Selecting Double-sided Printing Settings - Windows
Print Density Adjustments - Windows

You can select any of the available options on the Print Density Adjustment window to adjust the print
quality of your double-sided print job.

Print Density
Sets the level of ink coverage for double-sided printing.

Increase Ink Drying Time
Sets the amount of time required for drying ink after printing on one side of the paper before printing
the other side in double-sided printing to prevent ink smearing.

Parent topic: Selecting Double-sided Printing Settings - Windows
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Selecting Additional Layout and Print Options - Windows

You can select a variety of additional layout and printing options for your document or photo on the More
Options tab.

Han Mo Oplions  Mardsrsnos

Pravting Presets Diooument Sire Lekter (B 12 5 11m)
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= Documenit - High Quaty
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‘Watermark Featres..
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Show Sattings
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To change the size of your printed document or photo, select the Reduce/Enlarge Document
checkbox and select one of these sizing options:

» Select the Fit to Page option to size your image to fit the paper you loaded. Select the size of your
document or photo as the Document Size setting, and the size of your paper as the Output
Paper setting. If you want to center your image on the paper, select the Center option.

+ Select the Zoom to option to reduce or enlarge your document or photo by a specific percentage.
Select the percentage in the % menu.

2. To add the following features, click the Watermark Features button:

» Anti-Copy Pattern: adds a watermark that only appears when your printout is copied
+ Watermark: adds a visible watermark to your printout
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Note: Click the Add/Delete button to create your own watermark, and click the Settings button to
customize the watermark.

* Header/Footer: adds information such as the date and time to the top or bottom of your printout
Note: Click the Settings button to customize the text and location of the header or footer.

3. To add a password to your print job, select the Confidential Job checkbox, then enter a password.
Confidential jobs are stored in the product's memory without being printed. To print the job, enter the
password for the confidential job on the product's control panel.

Note: Confidential print jobs are cleared from the product's memory after printing.

4. Select any of the Additional Settings options to customize your print.

Image Options and Additional Settings - Windows
Header/Footer Settings - Windows

Parent topic: Printing with Windows

Related tasks
Printing Your Document or Photo - Windows

Image Options and Additional Settings - Windows
You can select any of the Image Options and Additional Settings to customize your print. Some options
may be pre-selected or unavailable, depending on other settings you have chosen.
Image Options

Emphasize Text
Adjusts the weight of printed text to increase readability.

Emphasize Thin Lines
Adjusts the weight of printed lines to increase visibility.

Edge Smoothing
Smooths jagged edges in low-resolution images such as screen captures or images from the Web.
Additional Settings Options

Rotate 180°
Prints the image rotated 180° from its original orientation.
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High Speed
Speeds up printing but may reduce print quality.

Mirror Image
Flips the printed image left to right.

Parent topic: Selecting Additional Layout and Print Options - Windows
Header/Footer Settings - Windows

You can select any of the Header/Footer Settings options to add headers or footers when you print. The
items are available to print at the top or bottom of your pages, in either the left, right, or center of the
page.

Note: These settings are not saved with your document.

Header/Footer Settings

Top Left Top Center Top Right

Uger MName w Mons ' Date,Time o
Bottom Left Bottom Cenber Bottom Right

None b MHone il Mone bl

Resst Defaults IE Cancel Help

You can select to print the following information:
* User Name

» Computer Name

* Date

+ Date/Time

* Collate Number (copy number)

Note: The user name, computer name, date, and time come from the Windows Control Panel on your
computer.

Parent topic: Selecting Additional Layout and Print Options - Windows
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Selecting a Printing Preset - Windows

For quick access to common groups of print settings, you can select a printing preset on the Main or
More Options tab.

Note: You can create your own preset by clicking the Add/Remove Presets button.

1. Click the Main or More Options tab.
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You see the available Printing Presets on the left:

= Printing Preferences
Main  More Options  Maintenance

Printing Presets

Add/Remove Presets...

E] Document - Fast

E] Document - Standard Quality
E Document - High Quality

=to Document - 2-Sided
Document - 2-p

cro Document - 2-Sided with 2-Up

Show Settings

Reset Defaults E Ink Levels i

2. Place your cursor over one of the Printing Presets to view its list of settings.

3. Click on a preset to change its settings, or use any of the available options on the screen to control
your printing presets.
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4. To choose a preset for printing, select it.
5. Click OK.
Parent topic: Printing with Windows

Selecting Extended Settings - Windows
You can select additional settings that apply to all the print jobs you send to your product.
1. Access the Windows Desktop and right-click the product icon in the Windows taskbar.
2. Select Printer Settings.
3. Click the Maintenance tab.
You see the maintenance options:

i Frinting Preference b
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4. Click the Extended Settings button.
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You see this window:
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5. Select any of the extended settings to customize your print.
6. Click OK to close the Extended Settings window.

7. Click OK to close the printer software window.

Parent topic: Printing with Windows

Printing Your Document or Photo - Windows
Once you have selected your print settings, you are ready to save your settings and print.
1. Click OK to save your settings.
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You see your application's Print window, such as this one:

X

= Prant

General  Ciptions

Select Printer

T8 EPSON = Microsoft XPS Docummen
= Fax

= Microseft Print ta PDF

L4 »>

Status Ready im tofie | Preferences §

Locatean:

Commeart Firid Printer...

Page Range
A Mumber of gopies: | 1 =

() Pages: 1 Collate
213

Enter either a single page numbser or a engla 1
page rangs. For example, 512

2. Click OK or Print to start printing.
Parent topic: Printing with Windows

Selecting Default Print Settings - Windows

When you change your print settings in a program, the changes apply only while you are printing in that
program session. If you want to change the print settings you use in all your Windows programs, you can

select new default print settings.
1. Access the Windows Desktop and right-click the product icon in the Windows taskbar.

2. Select Printer Settings.
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You see the printer settings window:

# Printing Preference =
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3. Select the print settings you want to use as defaults in all your Windows programs.
4. Click OK.

These settings are now the defaults selected for printing. You can still change them as needed for
printing in any program session.

Changing the Language of the Printer Software Screens
Parent topic: Printing with Windows
Changing the Language of the Printer Software Screens
You can change the language used on the Windows printer software screens.
1. Access the Windows Desktop and right-click the product icon in the Windows taskbar.
2. Select Printer Settings.
You see the printer settings window.
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3. Click the Maintenance tab.

You see the maintenance options:

W Printing Preférence =

Man Mo Options  Marderancs
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4. Select the language you want to use as the Language setting.

5. Click OK to close the printer software window.

The printer software screens appear in the language you selected the next time you access them.
Parent topic: Selecting Default Print Settings - Windows

Changing Automatic Update Options

Your printer software for Windows automatically checks for updates to the product software. You can
change how often the software checks for updates or disable this feature.

1. Access the Windows Desktop and right-click the product icon in the Windows taskbar.
2. Select Software Update Settings.
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You see this window:

Software Update Settings X

Check for Software Updates on the Internet

(@) Check every 2 wesks -

ll;l Mever

cancel

3. Do one of the following:
+ To change how often the software checks for updates, select a setting in the Check every menu.
» To disable the automatic update feature, select the Never option.

4. Click OK to exit.

Note: If you choose to disable the automatic update feature, you can check for updates manually.

Parent topic: Printing with Windows

Related tasks
Checking for Software Updates

Printing with OS X

You can print with your product using any OS X printing program, as described in these sections.

Note: If you have an Internet connection, it is a good idea to check for updates to your product software
on Epson's support website.

Selecting Basic Print Settings - OS X
Selecting Page Setup Settings - OS X
Selecting Print Layout Options - OS X
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Selecting Double-sided Printing Settings - OS X
Managing Color - OS X

Selecting Printing Preferences - OS X

Printing Your Document or Photo - OS X

Parent topic: Printing from a Computer

Selecting Basic Print Settings - OS X

Select the basic settings for the document or photo you want to print.
1. Open a photo or document for printing.
2. Select the print command in your application.

Note: You may need to select a print icon on your screen, the Print option in the File menu, or
another command. See your application's help utility for details.

3. Select your product as the Printer setting.

Printer: EPSON

L

L]

Prasaets: Default Settings

4. If necessary, click the arrow next to the Printer setting or the Show Details button to expand the
print window.
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You see the expanded printer settings window for your product:

Printar: EPSON

£

Presets: Default Settings v

Copies: 1

Pages: = All
From: 1 to: 1

B.50 by 11.00 inches

€

Paper Size: US Letter

Orientation: | 1 ¥ Toe

Preview b
+ | Auto Rotate
Scale:
® | Scale to Fit: ® | Print Entire Image
Fill Entire Paper
Copies per page: 1 <

Cance Print

Note: The print window may look different, depending on the version of OS X and the application
you are using.

Select the Copies and Pages settings as necessary.

Note: If you do not see these settings in the print window, check for them in your application before
printing.
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6. Select the page setup options: Paper Size and Orientation.

Note: If you do not see these settings in the print window, check for them in your application before
printing. They may be accessible by selecting Page Setup from the File menu.

7. Select any application-specific settings that appear on the screen, such as those shown in the image
above for the Preview application.

8. Select Print Settings from the pop-up menu.

Preview

Layout

Color Matching
Paper Handling
Cover Page

¥ Print Settings

Two-sided Printing Settings

Supply Levels

You see these settings:

L8

Print Settings

Paper Source:  Auto Select

£ | 4¥

Media Type: Plain Paper [ Bright White Paper

Print Quality: Marmal

¥ Advanced Settings:

Cancel Print
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9. Select the Paper Source you wish to print from.
10. Select the type of paper you loaded as the Media Type setting.

Note: The setting may not exactly match the name of your paper. Check the paper type settings list
for details.

11. Select the Print Quality setting you want to use.
12. Select any of the available print options.

Paper Source Options - OS X

Print Quality Options - OS X

Parent topic: Printing with OS X

Related references

Paper or Media Type Settings - Printing Software
Paper Type Settings - Control Panel

Related tasks
Selecting Page Setup Settings - OS X
Printing Your Document or Photo - OS X

Paper Source Options - OS X

You can select any of the available options in the Paper Source menu to print on the paper loaded in that
source.

Auto Select
Automatically selects the paper source based on the selected paper size.

Cassette 1
Selects the paper in cassette 1 as the paper source.

Cassette 2
Selects the paper in cassette 2 as the paper source.

Rear Paper Feed Slot
Selects the paper in the rear feed slot as the paper source.

Parent topic: Selecting Basic Print Settings - OS X
Print Quality Options - OS X

You can select any of the available Print Quality options to fine-tune the quality of your print. Some
settings may be unavailable, depending on the paper type setting you have chosen.

119



Draft
For draft printing on plain paper.

Normal
For everyday text and image printing.

Fine
For text and graphics with good quality and print speed.

Quality
For text and graphics with increased quality and print speed.

Parent topic: Selecting Basic Print Settings - OS X

Selecting Page Setup Settings - OS X

Depending on your application, you may be able to select the paper size and orientation settings from
the print window.

Paper Size: US Letter = | B8.50 by 11.00 inches

Orientation: '* LS Scale: 100 %

Note: If you do not see these settings in the print window, check for them in your application before
printing. They may be accessible by selecting Page Setup from the File menu.

1. Select the size of the paper you loaded as the Paper Size setting.
2. Select the orientation of your document or photo as shown in the print window.

Note: If you are printing an envelope, select the icon.

Note: You can reduce or enlarge the size of the printed image by selecting Paper Handling from the
pop-up menu and selecting a scaling option.

Parent topic: Printing with OS X

120



Selecting Print Layout Options - OS X

You can select a variety of layout options for your document or photo by selecting Layout from the pop-
up menu on the print window.

Layout -
Pages per Sheet: | 1 v
g n,
Border: Mane v

Reverse page ocrientation

Flip horizontally

Cance Print

» To print multiple pages on one sheet of paper, select the number of pages in the Pages per Sheet
pop-up menu. To arrange the print order of the pages, select a Layout Direction setting.

» To print borders around each page on the sheet, select a line setting from the Border pop-up menu.
» Toinvert or flip the printed image, select the Reverse page orientation or Flip horizontally settings.

Parent topic: Printing with OS X

Selecting Double-sided Printing Settings - OS X

You can print on both sides of the paper by selecting Two-sided Printing Settings from the pop-up
menu on the print window.

Two-sided Printing Settings &

[ 4]

Two-sided Printing: Off
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Note: Some options may be pre-selected or unavailable, depending on other settings you have chosen
or if you are accessing the product over a network. This screen may be different, depending on the
version of OS X you are using.

Select one of the Two-sided Printing options.

2. Select the type of document you are printing as the Document Type setting. The software
automatically sets the Adjustments options for that document type.

Two-sided Printing Settings &

L

Two-sided Printing:  Long-Edge binding

€3

Document Type: Text

¥ Adjustments:
Print Dansity
0 (3]
-50 0
Increased Ink Drying Time:
li] (sec)
4] +50

When printing a photo or document containing a lot of solid image
areas, reduce the density of the ink and increase its drying time.

Cancel Print

3. If necessary, customize the Adjustments settings as instructed on the screen.
4. Print a test copy of your double-sided document to test the selected settings.
5. Follow any instructions displayed on the screen during printing.

Double-sided Printing Options and Adjustments - OS X

Parent topic: Printing with OS X
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Double-sided Printing Options and Adjustments - OS X
You can select any of the available options in the Two-sided Printing Settings or Output Settings
pop-up menu to set up your double-sided print job.
Two-sided Printing Options

Long-Edge binding
Orients double-sided printed pages to be bound on the long edge of the paper.

Short-Edge binding
Orients double-sided printed pages to be bound on the short edge of the paper.
Adjustments

Print Density
Sets the level of ink coverage for double-sided printing.

Increased Ink Drying Time
Sets the amount of time required for drying ink after printing on one side of the paper before printing
the other side in double-sided printing.

Parent topic: Selecting Double-sided Printing Settings - OS X

Managing Color - OS X

You can adjust the Color Matching settings to fine-tune the colors in your printout, or turn off color
management in your printer software.

1. Select Color Matching from the pop-up menu in the print window.

Color Matching w
ColorSync D EPSON Color Controls
cancel | (T

2. Select one of the available options.
Color Matching Options - OS X
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Parent topic: Printing with OS X
Color Matching Options - OS X
You can select from these settings on the Color Matching menu.

ColorSync
Prints using standard color profiles for your product and paper to help match image colors. You can
customize the conversion method and filter settings on the ColorSync pop-up menu in the print
window.

EPSON Color Controls
Lets you manage color using controls in your printer software or turn off color management.

Parent topic: Managing Color - OS X

Selecting Printing Preferences - OS X
You can select printing preferences that apply to all the print jobs you send to your product.
1. Inthe Apple menu or the Dock, select System Preferences.

2. Select Print & Fax, Print & Scan, or Printers & Scanners, select your product, and select Options
& Supplies.

3. Select Driver or Options.

124



You see a screen like this:

General Options  Supply Levels  Litility

To take full adwardage of ywour printers aptions, confirm that they are accurately shown

nere. For information on your printer and fts optional hardware, cheok the printer's
documentation.

Thick paper and enveloapes:  CAf

Skip Blank Page: | O

Quint Mode: 04

High Spead Printing:  Or

Warning Notifications: Or

Estanksh bidirectional communication:  Or

AR IR IR IR AN A E)

Lowar Cosbeite: Mg

Cance oK

4. Select any of the available printing preferences.
5. Click OK.
Printing Preferences - OS X
Parent topic: Printing with OS X
Printing Preferences - OS X
You can select from these settings on the Options or Driver tab.

Thick Paper and Envelopes
Prevents ink from smearing when you print on envelopes or other thick paper.

Skip Blank Page
Ensures that your product does not print pages that contain no text or images.

Quiet Mode
Lessens noise during printing but may decrease print speed.

High Speed Printing
Speeds up printing but may reduce print quality.
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Warning Notifications
Lets you choose whether or not to receive warning notifications from the printer software for various
operating conditions.

Establish bidirectional communication
Allows the product to communicate with the computer. Do not change the default setting unless you
experience issues when using a shared printing pool.

Lower Cassette
Specifies whether the optional cassette is present.

Parent topic: Selecting Printing Preferences - OS X

Printing Your Document or Photo - OS X
Once you have selected your print settings, you are ready to print.
Click Print at the bottom of the print window.

Print Settings -

Paper Source: Auto Select

Media Type: Plain Paper [ Bright White Paper

[+ 2NE+ 30N+

Print Quality: MNorma

Advanced Settings:

Cancel Print

Checking Print Status - OS X
Parent topic: Printing with OS X
Checking Print Status - OS X
During printing, you can view the progress of your print job, control printing, and check ink status.
1. Click the printer icon when it appears in the Dock.
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You see the print status window:

[ BN & EPSOM

W L¥
Paust Seltings
1836131_127T0960758910_6552316_n.jpg

a

2. Select the following options as necessary for your version of OS X:
» To cancel printing, click the print job and click I:I or Delete.

* To pause a print job, click the print job and click I:' or Hold. To resume a print job, click the
paused print job and click |:| or Resume.
» To pause printing for all queued print jobs, click Pause or Pause Printer.
» To display other printer information, click Settings or Supply Levels.
Parent topic: Printing Your Document or Photo - OS X

Printing with the Epson Universal Print Driver - Windows

You can print with the Epson Universal Print Driver using any Windows printing program, as described in
these sections.

Synchronizing Printer Settings - Epson Universal Print Driver - Windows

Selecting Basic Print Settings - Epson Universal Print Driver - Windows

Selecting Additional Layout and Print Options - Epson Universal Print Driver - Windows

Selecting Maintenance Options - Epson Universal Print Driver - Windows

Selecting Default Print Settings - Epson Universal Print Driver - Windows

Locking Printer Settings - Epson Universal Print Driver - Windows

Adding Network Printers - Epson Universal Print Driver - Windows

Parent topic: Printing from a Computer
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Synchronizing Printer Settings - Epson Universal Print Driver - Windows

You may need to synchronize the printer driver with the product if the printer driver does not detect the
correct information or settings from the product.

Note: You must sync the printer driver before you can use any optional equipment installed on the
product, such as an optional cassette unit.

1. Do one of the following:

* Windows 10: Right-click K 2nd select Control Panel > Hardware and Sound > Devices and
Printers. Right-click EPSON Universal Print Driver and select Printer properties.

* Windows 8.x: Navigate to the Apps screen and select Control Panel > Hardware and Sound >
Devices and Printers. Right-click EPSON Universal Print Driver and select Printer properties.

* Windows 7: Click E]' and select Devices and Printers. Right-click EPSON Universal Print
Driver and select Printer properties.

+ Windows Vista: Click E]' and select Control Panel. Click Printer under Hardware and Sound,
then right-click EPSON Universal Print Driver and select Properties.

* Windows XP: Click Start and select Printers and Faxes. Right-click EPSON Universal Print
Driver and select Properties.

2. Click the Optional Settings tab.
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4.
Parent topic: Printing with the Epson Universal Print Driver - Windows

Selecting Basic Print Settings - Epson Universal Print Driver - Windows
Select the basic settings for the document or photo you want to print.
1.

You see this window:

Ganersl  Shasng  Fors

% Pranber Lithty

‘:h- Dvivier S4ttings

CuFTent Frinter Infonmason

Prindar Typd
Trikjie| Prindgr
Hncel Mame
- MR Senes
Prder MMoce]

ESCIPR
Auto Dupheer Instalied
Tres b
Conficantial Job

L 3

& EPSOM Unncersal Print Denve

=
:Eﬁ_ Metwork prnter seanch
%

A4fLetter Color (Standard Resolubon &00
Default of Printer Conirol Language

s Properiies =

Achrancad  Color Marmgement  Sscurty  Dolional Sefings  Vismmon Infomemton

Printsr Tnfermaton
&

() Acquire from Printer cet

[ onidy Optional Inflormartion

() Manusl Setings

0K Cancal [Hasip

Make sure Acquire from Printer is selected and click Get.

Note: Select the Only Optional Information checkbox if you only want to enable optional

equipment, such as an optional cassette unit.

The product's settings and other information appears in the Current Printer Information area.

Click OK.

Open a photo or document for printing.
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Select the print command in your application.

Note: You may need to select a print icon on your screen, the Print option in the File menu, or
another command. See your application's help utility for details.

If necessary, select EPSON Universal Print Driver as the printer you want to use.
Note: You may also need to select Properties or Preferences to view your print settings.

You see the Main tab of your printer settings window:

Prelmg Brearts Paper Source Mot Siect
s Mg g et ooument Sipe Lt 08 U3 x LLF
-
v e » Prrs R
fudedd sl aper Type Fiar SRpE | BROT E E e
Chslity [T

2SdedPrinting | OFF

Mult-Fage of

Note: For more information about a setting, right-click it and select Help.

For the Paper Source setting, select where you loaded the paper you want to print on.
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9.
10.

11.
12.
13.

Select the size of the paper you loaded as the Document Size setting.

Note: You can also select the User-Defined setting to create a custom paper size.
Select the orientation of your document.

Note: If you are printing an envelope, select Landscape.

Select the type of paper you loaded as the Paper Type setting.

Note: The setting may not exactly match the name of your paper. Check the paper type settings list
for details.

Select the Quality setting that matches the print quality you want to use.
To print on both sides of the paper, select one of the 2-Sided Printing settings.

To print multiple pages on one sheet of paper, or print one image on multiple sheets of paper, select
one of the settings in the Multi-Page menu and select the printing options you want.

To print multiple copies and arrange their print order, select the Copies options.
To preview your job before printing, select Print Preview.

To save your print job as a project that can be modified and combined with other print jobs, select
Job Arranger Lite.

Parent topic: Printing with the Epson Universal Print Driver - Windows
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Selecting Additional Layout and Print Options - Epson Universal Print Driver -

Windows

You can select a variety of additional layout and printing options for your document or photo on the More

Options tab.

Emage Options. ..

‘Watermark Festres

orfderial Job

Aibchlional Sethrgs

|Ratats 180

Shive SSRGS

Reget Detuits

Lo 3 T =g

Note: For more information about a setting, right-click it and select Help.

To change the size of your printed document or photo, select the Reduce/Enlarge Document

checkbox and select one of these sizing options:

+ Select the Fit to Page option to size your image to fit the paper you loaded. Select the size of the
your document or photo as the Document Size setting, and the size of your paper as the Output

Paper setting. If you want to center your image on the paper, select the Center option.

+ Select the Zoom to option to reduce or enlarge your document or photo by a specific percentage
Select the percentage in the % menu.

1.
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2. Select Image Options to access additional settings for improving printed images.
3. To add the following features, click the Watermark Features button:
+ Watermark: adds a visible watermark to your printout.

Note: Click the Add/Delete button to create your own watermark, and click the Settings button to
customize the watermark.

* Header/Footer: adds information such as the date and time to the top or bottom of your printout.
Note: Click the Settings button to customize the text and location of the header or footer.

4. To add a password to your print job, select the Confidential Job checkbox, then enter a password.
Confidential jobs are stored in the product's memory without being printed. To print the job, enter the
password for the confidential job on the product's control panel.

Note: Confidential print jobs are cleared from the product's memory after printing.

5. Select any of the Additional Settings options to customize your print.
Parent topic: Printing with the Epson Universal Print Driver - Windows
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Selecting Maintenance Options - Epson Universal Print Driver - Windows
You can select maintenance and other optional settings on the Maintenance tab.

i EPSOH Uriversal Prink Duiver Printing Prefenences =

Kan Mo Options: Hard aranss

%) | Mozde Check

\‘-k Head Cesning

'_Th“ Extended Settrgs

: B2 mritque
a4 =
@ Job Brranger Lite '_T!F_:‘ Privier and Opbion Information
Languge El'»gsh I'El'@sh:-
Werson 163
0K Cancel Fisip

Note: For more information about a setting, right-click it and select Help.

* Nozzle Check lets you print a nozzle check pattern to check for clogged nozzles.
* Head Cleaning lets you clean the print head.
» Network printer search lets you search for and connect to a product on the network.

* Job Arranger Lite lets you save your print job as a project that can be modified and combined with
other print jobs.

+ Extended Settings lets you change a variety of print settings.
» Print Queue displays all the print jobs in queue. You can also cancel or restart print jobs.
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* Printer and Option Information displays information on the printer settings and any optional
equipment installed.

* Language lets you change the language of the printer software screens.
Extended Settings - Epson Universal Print Driver - Windows

Parent topic: Printing with the Epson Universal Print Driver - Windows
Extended Settings - Epson Universal Print Driver - Windows

You can select from these settings on the Extended Settings window.

Privier ConbrolLangpsge SS0PH L

lsewye Spol Rk Dainhs
Eifaet Setirgs 3rni wa fierup
| e srpowsy paTEm
[ iy Dk P | Mhevry Linee Boe e s Pacee S Setirng
{Linnt s cala in eaitrge quechecn e sopkoabon,
| nges Remndmeig Mo
| Codate g Prives e

Rusat Dafuity x| cwec rac

Printer Control Language
Lets you select the printer control language.

Graphics Mode

Lets you select the mode by which to output PDL commands to the product.
TrueType Font

Lets you select how you want to print TrueType fonts.
Offset Settings

Lets you make fine-tune adjustments to the print position of data on your printout.
Skip Blank Page

Ensures that your product does not print pages that contain no text or images.
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Always Spool RAW Datatype
Increases print speed and may solve other printing problems.

Print as Bitmap

Increases print speed when printing is extremely slow or the print head stops during printing, and
other settings do not help.

Refine screening pattern
Prints graphics with a finer screening pattern.

Always Use the Driver's Paper Source Setting
Prints using the paper source setting in the printer driver, rather than the setting in your application.

Uses the collate settings specified in the application
Prints using the collate setting in your application.

Page Rendering Mode
Increases print speed when printing is extremely slow or the print head stops during printing.

Collate Using Printer Driver
Prints and collates multi-page documents using the printer driver. Deselect this checkbox to use the
product to collate your print jobs instead. (This setting is automatically enabled if there is not enough
memory on the product to collate your print job.)

Output 1 page documents facedown in 2-Sided mode
Outputs single-sided pages in a 2-sided print job facedown instead of faceup.

Parent topic: Selecting Maintenance Options - Epson Universal Print Driver - Windows

Selecting Default Print Settings - Epson Universal Print Driver - Windows

When you change your print settings in a program, the changes apply only while you are printing in that
program session. If you want to change the print settings you use in all your Windows programs, you can
select new default print settings.

1. Do one of the following:

* Windows 10: Right-click E and select Control Panel > Hardware and Sound > Devices and
Printers. Right-click EPSON Universal Print Driver and select Print Preferences.

+ Windows 8.x: Navigate to the Apps screen and select Control Panel > Hardware and Sound >
Devices and Printers. Right-click EPSON Universal Print Driver and select Print Preferences.

* Windows 7: Click E‘ and select Devices and Printers. Right-click EPSON Universal Print
Driver and select Printing Preferences.
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+ Windows Vista: Click E" and select Control Panel. Click Printer under Hardware and Sound,
right-click EPSON Universal Print Driver, and select Printing Preferences.

* Windows XP: Click Start and select Printers and Faxes. Right-click EPSON Universal Print
Driver and select Printing Preferences.

You see the printer settings window:
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Shie SETIRGE
Reset Dt
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Note: For more information about a setting, right-click it and select Help.

2. Select the print settings you want to use as defaults in all your Windows programs.

3. Click OK.

These settings are now the defaults selected for printing. You can still change them as needed for
printing in any program session.

Parent topic: Printing with the Epson Universal Print Driver - Windows
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Locking Printer Settings - Epson Universal Print Driver - Windows
Administrators can lock some printer settings to prevent unauthorized changes.

1. Do one of the following:

Windows 10: Right-click H and select Control Panel > Hardware and Sound > Devices and
Printers. Right-click EPSON Universal Print Driver and select Printer properties.

Windows 8.x: Navigate to the Apps screen and select Control Panel > Hardware and Sound >
Devices and Printers. Right-click EPSON Universal Print Driver and select Printer properties.

Windows 7: Click E and select Devices and Printers. Right-click EPSON Universal Print
Driver and select Printer properties.

Windows Vista: Click E]' and select Control Panel. Click Printer under Hardware and Sound,
then right-click EPSON Universal Print Driver and select Properties.

Windows XP: Click Start and select Printers and Faxes. Right-click EPSON Universal Print
Driver and select Properties.

2. Click the Optional Settings tab.
3. Click Driver Settings.
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You see this window:
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4. Select the checkbox for the settings you want to lock. To lock all print settings, select All Document
Settings.

5. Under Advanced Settings, select the setting option you want to use for each locked setting.
6. Click OK.
Epson Universal Print Driver Locked Setting Options
Parent topic: Printing with the Epson Universal Print Driver - Windows
Epson Universal Print Driver Locked Setting Options
Select the options you want to use for any locked print settings.
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Setting Options Description
Watermark Various text Lets you select the text for the watermark or prohibit
watermarks watermarks
Add/Delete Lets you add or delete a customized text or image-based
Settings watermark
Lets you select the size, position, color and other watermark
settings
Header/Footer Off Prohibits headers or footers
On Allows headers and footers
Settings Lets you select the text and position for printing headers and
footers
2-sided printing | Off Allows printing on only one side of the paper
On Allows printing on both sides of the paper
Multi-Page Off Prohibits multi-page settings
2-Up Allows printing of 2 pages on one sheet of paper
4-Up Allows printing of 4 pages on one sheet of paper

Parent topic: Locking Printer Settings - Epson Universal Print Driver - Windows

Adding Network Printers - Epson Universal Print Driver - Windows

You can use the Epson Universal Print Driver to find and add network printers.

1. Do one of the following:

* Windows 10: Right-click K 2nd select Control Panel > Hardware and Sound > Devices and
Printers. Right-click EPSON Universal Print Driver and select Printer properties.

* Windows 8.x: Navigate to the Apps screen and select Control Panel > Hardware and Sound >
Devices and Printers. Right-click EPSON Universal Print Driver and select Printer properties.

* Windows 7: Click E]' and select Devices and Printers. Right-click EPSON Universal Print
Driver and select Printer properties.

+ Windows Vista: Click E]' and select Control Panel. Click Printer under Hardware and Sound,
then right-click EPSON Universal Print Driver and select Properties.
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* Windows XP: Click Start and select Printers and Faxes. Right-click EPSON Universal Print
Driver and select Properties.

Click the Optional Settings tab.
You see this window:
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Click Network printer search.
When you see the search results, select Add found printers.
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You see a screen like this:
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5. Select the printer or printers you want to add.
6. Click Add to Printer Folder.
The selected printer or printers appear in the lower section of the screen.
7. Select the checkbox next to the product you want to make your default printer, if necessary.
8. Click OK.
Parent topic: Printing with the Epson Universal Print Driver - Windows
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Printing with the PostScript (PS3) Printer Software - Windows

You can print with the PostScript (PS3) printer software using any Windows printing program, as
described in these sections.

Note: The PostScript printer software supports products that are connected via Ethernet. If your product
is connected via USB, you will need to install the standard Epson printer software. To download the
standard Epson printer software, go to epson.com/support/wfm5694downloads.

Enabling the Optional Paper Cassette - PostScript Printer Software - Windows
Selecting Basic Print Settings - PostScript Printer Software - Windows

Selecting Additional Layout and Print Options - PostScript Printer Software - Windows
Selecting Default Print Settings - PostScript Printer Software - Windows

Parent topic: Printing from a Computer

Enabling the Optional Paper Cassette - PostScript Printer Software - Windows

If you installed the optional paper cassette unit, you need to enable it before you can use it with the PS3
printer software.

1. Do one of the following:

* Windows 10: Right-click K 2nd select Control Panel > Hardware and Sound > Devices and
Printers. Right-click your product name and select Printer properties.

* Windows 8.x: Navigate to the Apps screen and select Control Panel > Hardware and Sound >
Devices and Printers. Right-click your product name and select Printer properties.

* Windows 7: Click E]' and select Devices and Printers. Right-click your product name and select
Printer Properties.

* Windows Vista: Click E]' and select Control Panel. Click Printer under Hardware and Sound,
then right-click your product name, and select Properties.

+ Windows XP: Click Start and select Printers and Faxes. Right-click your product name and
select Properties.

2. Click the Device Settings tab.
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You see a window like this:
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o EPSOM WEF-X00! P53 Senes Device Settings
) [ﬂi. Font Substitution Table
Awailable PestScript Memery: (BRI
Output Protecel: ASCH
Send CTRL-D Before Each Job: Mo
Send CTRL-D After Each Job: Yes
Convert Gray Tesxt to PostScnpt Gray: ho
Canwvert Gray Graphics ta PastSeript Gray: Ne
Add Eure Currency Symbel to PostScript Fonts: No
Job Tirneout: 0 seconds
Wait Timeout: [ seconds
Minimum Font Soe to Download as Outhine: 100 peoel(s)
Maximum Font Size to Download as Bitmap: 500 pixelis)
= mg_ Installable Options
Lower Cassette Unit: Mone

[ ok ] coce

2

3. Select the optional cassette installed as the Lower Cassette Unit setting.
4. Click OK.

The optional paper cassette is now enabled.

Parent topic: Printing with the PostScript (PS3) Printer Software - Windows

Selecting Basic Print Settings - PostScript Printer Software - Windows
Select the basic settings for the document or photo you want to print.
1. Open a photo or document for printing.
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2. Select the print command in your application.

Note: You may need to select a print icon on your screen, the Print option in the File menu, or
another command. See your application's help utility for details.

3. If necessary, select your product name as the printer you want to use, and then click the
Preferences button.

You see the Layout tab of your printer settings window:

= Printing Proferences .
eyl  Paper/Tualby
Dnentabwon:
T
Prnt on Both Sides
= Mome
Page Oyder —
Front to Back e

Page Format —_—

) Pages per Sheet 1 . =

i) Booklet

Adganced...

Select the orientation of your document.

To print on both sides of the paper, select one of the Print on Both Sides settings.
To change the printing order of the pages, select one of the Page Order settings.
To print multiple pages on one sheet of paper, adjust the Pages per Sheet setting.
To create a folded booklet out of your photo or document, select the Booklet option.
Click the Paper/Quality tab.

© o N o g bk
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You see this window:

= Printing Praferences o
Leyout  Faper Tualty

Tray Selection

Prper Gourre £ Automatically Select .

edia: Plain. v

10. Select the Paper Source that matches where you loaded the paper you want to print on.
11. Select Plain as the Media setting.

Note: The PostScript printer software supports plain paper printing on these paper and envelope
sizes:

* A4 (8.3 x 11.7 inches [210 x 297 mm])
+ Letter (8.5 x 11 inches [216 x 279 mm])
* No. 10 (4.1 x 9.5inches [105 x 241 mm])

Parent topic: Printing with the PostScript (PS3) Printer Software - Windows
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Selecting Additional Layout and Print Options - PostScript Printer Software - Windows

You can select a variety of additional layout and printing options for your document or photo by clicking
the Advanced button.

EPS0MN P53 Senes Advanced Opbions >

= EFS0M P53 Series Advanced Document Settings
Paper/Qutput
Letter
= _|_|.'| G raphic
Print ﬂueli!:_.': m
Scaling: 100 %
TrueType Font: Substitute with Device Font
e Document Options
Advanced Printing Features: Enabled
Pages per Sheet Layout: Right then Down
Booklet Binding Edge: On Left Edge
-9 Posthonpt Options
=%, Printer Features
Ink Save Mode: O
Rotate by 180°: Off

o nh =~

o o

Select the size of the paper you loaded as the Paper Size setting.
Select the Print Quality option that matches the print quality you want to use.
Adjust the Scaling setting to reduce or enlarge your document or photo by a specific percentage.

Adjust the Pages Per Sheet Layout setting to change the order of multiple pages on a single sheet
of paper when you have adjusted the Pages Per Sheet setting on the Layout tab.

Adjust the Booklet Binding Edge setting to change the orientation of your printed booklet.
Expand the PostScript Options heading to access the advanced PostScript printer software features.
Select any of the remaining Printer Features options to customize your printouts.
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Parent topic: Printing with the PostScript (PS3) Printer Software - Windows

Selecting Default Print Settings - PostScript Printer Software - Windows

When you change your print settings in a program, the changes apply only while you are printing in that
program session. If you want to change the print settings you use in all your Windows programs, you can
select new default print settings.

1. Do one of the following:

Windows 10: Right-click K 2nd select Control Panel > Hardware and Sound > Devices and
Printers. Right-click your product name and select Printer properties.

Windows 8.x: Navigate to the Apps screen and select Control Panel > Hardware and Sound >
Devices and Printers. Right-click your product name and select Print Preferences.

Windows 7: Click E]' and select Devices and Printers. Right-click your product name and select
Printing Preferences.

Windows Vista: Click E]' and select Control Panel. Click Printer under Hardware and Sound,
right-click your product name, and select Printing Preferences.

Windows XP: Click Start and select Printers and Faxes. Right-click your product name and
select Printing Preferences.
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You see the printer settings window:

= Printing Praferences o
eyl  FaperTualty

Dnentabwon:

!

Pont on Both Sedes
= Mame

Page Oyder —
Front to Back —

Page Format

) Pages per Sheet 1 v =

) Bocklet

Adyanced...

G

2. Select the print settings you want to use as defaults in all your Windows programs.
3. Click OK.

These settings are now the defaults selected for printing. You can still change them as needed for
printing in any program session.

Parent topic: Printing with the PostScript (PS3) Printer Software - Windows

Printing with the PostScript (PS3) Printer Software - OS X

You can print with the PostScript (PS3) printer software using any OS X printing program, as described
in these sections.

Enabling the Optional Paper Cassette - PostScript Printer Software - OS X

Selecting Basic Print Settings - PostScript Printer Software - OS X

Selecting Page Setup Settings - PostScript Printer Software - OS X

Selecting Print Layout Options - PostScript Printer Software - OS X
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Sizing Printed Images - PostScript Printer Software - OS X
Managing Color - PostScript Printer Software - OS X
Printing Your Document or Photo - PostScript Printer Software - OS X

Parent topic: Printing from a Computer

Enabling the Optional Paper Cassette - PostScript Printer Software - OS X

If you installed the optional paper cassette unit, you need to enable it before you can use it with the PS3
printer software.

1. Inthe Apple menu or the Dock, select System Preferences.

2. Select Print & Fax, Print & Scan, or Printers & Scanners, select your product, and select Options
& Supplies.

3. Select Driver or Options.
You see a screen like this:

General Options  Supply Levels

To take full adwardage of wour printers aptions, confirm that they are accurately shown
nere. For information on your printer and its optional hardware, check the printer's
documentation.

Lower Cassetie Unil: | Mone

Cance oK

4. Select the optional cassette installed as the Lower Cassette Unit setting.
5. Click OK.
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The optional paper cassette is now enabled.
Parent topic: Printing with the PostScript (PS3) Printer Software - OS X

Selecting Basic Print Settings - PostScript Printer Software - OS X
Select the basic settings for the document or photo you want to print.
1. Open a photo or document for printing.
2. Select the print command in your application.

Note: You may need to select a print icon on your screen, the Print option in the File menu, or
another command. See your application's help utility for details.

3. Select your product as the Printer setting.

Printer: EPSON

L

L]

Prasets: Default Settings

4. If necessary, click the arrow next to the Printer setting or the Show Details button to expand the
print window.
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You see the expanded printer settings window for your product:

Printar: EPSON

£

Presets: Default Settings v

Copies: 1

Pages: = All
From: 1 to: 1

B.50 by 11.00 inches

€

Paper Size: US Letter

Orientation: | 1 ¥ Toe

Preview b
+ | Auto Rotate
Scale:
® | Scale to Fit: ® | Print Entire Image
Fill Entire Paper
Copies per page: 1 <

Cance Print

Note: The print window may look different, depending on the version of OS X and the application
you are using.

Select the Two-Sided, Copies, and Pages settings as necessary.

Note: If you do not see these settings in the print window, check for them in your application before
printing.
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6. Select the page setup options: Paper Size and Orientation.

Note: If you do not see these settings in the print window, check for them in your application before
printing. They may be accessible by selecting Page Setup from the File menu.

7. Select any application-specific settings that appear on the screen, such as those shown in the image
above for the Preview application.

8. Select Paper Feed from the pop-up menu.

Preview

Layout
Color Matching
Paper Handling

¥ Paper Feed

Cover Page

Printer Features

You see these settings:

<

Paper Fead

* All Pages From:  Auto Select <
First Page From: Rear Paper Feed

Remaining From: Rear Paper Feed

Cancel Print

9. Select All Pages From or First Page From and select the paper source you want to print from.
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10. Select Printer Features from the pop-up menu.

Preview

Layout

Color Matching
Paper Handling
Paper Feed
Cover Page

You see these settings:

Printer Features -
Feature Sets:  Quality -
MediaType: | Plain -
Print Quality: Fine v
Cancel Print

11. Select Plain as the MediaType setting.

Note: The PostScript printer software supports plain paper printing on these paper and envelope
sizes:

* A4 (8.3 x 11.7 inches [210 x 297 mm])
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* Letter (8.5 x 11 inches [216 x 279 mm])
* No. 10 (4.1 x 9.5 inches [105 x 241 mm])

12. Select one of the following Print Quality options:
» For fast printing with reduced quality, select Fast.
» For printing text and graphics with good quality and print speed, select Fine.
» For the best printing with reduced speed, select Maximum.

13. Select any of the available print options.

Parent topic: Printing with the PostScript (PS3) Printer Software - OS X

Selecting Page Setup Settings - PostScript Printer Software - OS X

Depending on your application, you may be able to select the paper size and orientation settings from
the print window.

Paper Size: US Letter % | B.50 by 11.00 inches

Orientation: Ii' S

Note: If you do not see these settings in the print window, check for them in your application before
printing. They may be accessible by selecting Page Setup from the File menu.

1. Select the size of the paper you loaded as the Paper Size setting. You can also select a custom
setting to create a custom paper size.

2. Select the orientation of your document or photo as shown in the print window.

Note: You can reduce or enlarge the size of the printed image by selecting Paper Handling from the
pop-up menu and selecting a scaling option.

Parent topic: Printing with the PostScript (PS3) Printer Software - OS X
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Selecting Print Layout Options - PostScript Printer Software - OS X

You can select a variety of layout options for your document or photo by selecting Layout from the pop-
up menu on the print window.

L4

Layout

£y

Pages per Sheet: 1
¢
Border: MNone =

Two-Sided: Off <

Reverse page orientation
Flip horizontally

Cancel Print

» To print multiple pages on one sheet of paper, select the number of pages in the Pages per Sheet
pop-up menu. To arrange the print order of the pages, select a Layout Direction setting.

» To print borders around each page on the sheet, select a line setting from the Border pop-up menu.

» To print on both sides of the page, select one of the Two-Sided settings.

» Toinvert or flip the printed image, select the Reverse page orientation or Flip horizontally settings.
Parent topic: Printing with the PostScript (PS3) Printer Software - OS X
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Sizing Printed Images - PostScript Printer Software - OS X

You can adjust the size of the image as you print it by selecting Paper Handling from the pop-up menu
on the Print window.

Paper Handling b

+| Collate pages

L3

Pages to Print: | All pages

Page Order: Automatic

L4

Scale to fit paper size

Cance Print

» To print only selected pages in a multi-page document, select an option from the Pages to Print pop-
up menu.

» To adjust the order in which pages are printed, select an option from the Page Order pop-up menu.

» To scale the image to fit on a specific paper size, select the Scale to fit paper size checkbox and
select a paper size from the Destination Paper Size pop-up menu.

Parent topic: Printing with the PostScript (PS3) Printer Software - OS X

Managing Color - PostScript Printer Software - OS X

You can adjust the Color Matching settings to fine-tune the colors in your printout.
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1. Select Color Matching from the pop-up menu in the print window.

Color Matching b

¢ ColorSync | | In printer

o

Profile: Automatic >

Cancel Print

2. Do one of the following:

» To print using standard color profiles for your product and paper to help match image colors,
select ColorSync. Select one of the available Profile options to change the active color profile.

» To use the product's default color matching, select In printer.
Parent topic: Printing with the PostScript (PS3) Printer Software - OS X

Printing Your Document or Photo - PostScript Printer Software - OS X
Once you have selected your print settings, you are ready to print.
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Click Print at the bottom of the print window.

Printer Features -
Feature Sets:  Quality +
MediaType: | Plain =
Print Quality: Fine -
Cance Print

Checking Print Status - PostScript Printer Software - OS X
Parent topic: Printing with the PostScript (PS3) Printer Software - OS X
Checking Print Status - PostScript Printer Software - OS X
During printing, you can view the progress of your print job, control printing, and check ink status.
1. Click the printer icon when it appears in the Dock.
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You see the print status window:

=i

W =

About Downloads
i

L]

2. Select the following options as necessary for your version of OS X:
* To cancel printing, click the print job and click I:l or Delete.

* To pause a print job, click the print job and click I:' or Hold. To resume a print job, click the
paused print job and click |:| or Resume.
» To pause printing for all queued print jobs, click Pause or Pause Printer.
» To display other printer information, click Settings or Supply Levels.
Parent topic: Printing Your Document or Photo - PostScript Printer Software - OS X

Cancelling Printing Using a Product Button

If you need to cancel printing, press the ® Stop button on your product.
Parent topic: Printing from a Computer
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Scanning

You can scan original documents or photos and save them as digital files.

Starting a Scan

Selecting Epson Scan Settings

Scanning with OS X Using Image Capture
Scanning Special Projects

Starting a Scan

After placing your original documents or photos on your product for scanning, start scanning using one of
these methods.

Starting a Scan Using the Product Control Panel

Starting a Scan with Document Capture Pro or Document Capture
Starting a Scan Using the Epson Scan Icon

Starting a Scan from a Scanning Program

Parent topic: Scanning

Related topics
Placing Originals on the Product

Starting a Scan Using the Product Control Panel
You can scan an image to a memory device or to your computer using your product's control panel.

1. Make sure you installed the product software and connected the product to your computer or
network.

Note: Restart your computer after installing the product software to enable scanning from the control
panel. Also make sure the Event Manager program is not being blocked by your firewall or security
software.

2. Place your original on the product for scanning.
Note: To scan a double-sided document, place it in the ADF and select the 2-Sided setting.

3. Press the M home button, if necessary.
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4. Select Scan.

You see a screen like this:

5. Select one of the following Scan to options:

Email lets you send scanned files through a pre-configured email server.
Network Folder/FTP saves your scan file to a specified folder on a network.

Memory Device saves your scan file on a memory or USB device and lets you select the file
format, quality, and other settings.

Cloud sends your scanned files to a destination that you have registered with Epson Connect.

Document Capture Pro allows you to scan over a network using your saved job settings in
Document Capture Pro or Document Capture.

Note: You cannot use this option to scan an image to Document Capture or Document Capture
Pro when your product is connected to your computer's USB port.

Computer (WSD) lets you manage network scanning in Windows 10, Windows 8, Windows 7, or
Windows Vista (English only). To use this feature, you must first set up WSD (Web Services for
Devices) on the computer.

6. Select Preset to save your scan settings.

Note: Presets can be locked by an administrator. If you cannot access or change this setting,
contact your administrator for assistance.

7. Do any of the following, as necessary:

Select the email address, location, destination, or computer.
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« Select Contacts to choose an email address or network folder.
» Select Format to choose the file format.
» Select Settings or Menu to display additional scanning options.

Adding and Assigning Scan Jobs

Parent topic: Starting a Scan
Related tasks

Using Presets

Using Epson Scan to Cloud

Related topics
Placing Originals on the Product

Adding and Assigning Scan Jobs

You can view, change, or add available default scan settings when you scan using the Document
Capture Pro option on the product control panel. You do this by accessing the scan jobs in the Document
Capture Pro (Windows) or Document Capture (OS X) program.

1.

2.

Start Document Capture Pro or Document Capture on a computer connected to the product.

Click the Manage Job icon from the toolbar at the top of the window.
You see a window showing the current scan job list.

If you want to add a scan job, click Add or the + icon, enter a name for the new job, select settings
as necessary, and click OK.

You can now use the new scan job when you scan with Document Capture Pro or Document
Capture.

Note: See the Help information in Document Capture Pro or Document Capture for details.

If you want to assign scan jobs to the selection list on the product control panel, do one of the
following:

* Windows: Click Event Settings.
- OS X: Click the - # ™ jcon at the bottom of the window, then click Event Settings.
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5. Select the jobs that you want to assign to any of the pull-down menus.

]
0
1

i2

Helpy

Ewent Settings - EFS0N

St s oo b b L Wi D B, b presiaesd

2 | Tahe Ma Aoten

3 | Take Mo Acten

Tk Mo Action
Takw Mo Acton

T Mo Aotien

T | Taks ho Acton

Take Mo Action
Takw Mo Acton
Tabie M Aoty
Taken Mo Bt

Takew by Acction

Jeb 283 3 can ba arly selscted from Metwork: Optiors

1 Scanio POF - Aule Debect/Subn. 2000, Save o Dooumenis

oK

Cancel

You can now use the added scan jobs when you scan from the product control panel.

6. Click OK, then click OK again.

Parent topic: Starting a Scan Using the Product Control Panel

Starting a Scan with Document Capture Pro or Document Capture

When you scan with Document Capture Pro (Windows) or Document Capture (OS X), the program
automatically saves your scanned file on your computer in the folder you specify. You can select
settings, preview, and change the scanned file settings as necessary.

1. Do one of the following to start Document Capture Pro or Document Capture:

* Windows 10: CIickE and select All apps. Select EPSON Software, then select Document

Capture Pro.

* Windows 8.x: Navigate to the Apps screen and select Document Capture Pro.

* Windows (other versions): Click © or Start, and select All Programs or Programs. Select
EPSON Software, then select Document Capture Pro.
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» 0OS X: Open the Applications folder, select the Epson Software folder, and select Document
Capture. Select your product and click OK, if necessary.

You see a window like this:

= Dioaumment Cagiure Pro -““_
fde  Jcan  [d8 Yew Bege  Qption  bedp

o kb [j'u, P - Fg temation B

Click the |§| Scan icon.
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You see a window like this:

Scan

Main Settings

Resolution

Heip

Document Size:
Image Type:

Ratation:

- | Auto Detect

Lettar

None

Lo

] Show the confimation dialog after scanning

Cancal

v | (200 - | doi

[] Tesxt Enhancement
[] Comect Document Skew
[] Skip Blank Page

Detailed Settings

<& Scan

Note: With OS X, you can download and install Epson Scan scanning software, which will provide
additional image adjustment features within Document Capture. To download Epson Scan, visit
Epson's driver download site (U.S. downloads or Canadian downloads).

If you want to use a scan job that you created instead, select it from the Job list in the Document
Capture Pro or Document Capture window, click the 2| Start Job button, and skip the rest of these

steps.

Select any displayed scan settings you want to use.

Note: See the Help information in Document Capture Pro or Document Capture for details.

If you want to select detailed scan settings, do one of the following:
* Windows: Click Detailed Settings. Select any displayed scan settings you want to use and click

OK.
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* OS X: If you installed Epson Scan, close the Scan Settings window, open the Scan menu at the

top of the screen and select Displays the EPSON Scan Setup Screen. Click the @ Scan icon.
Select any displayed scan settings you want to use and click OK.

6. Click Scan.
You see a preview of your scan in the Document Capture Pro or Document Capture window.
Check the scanned images and edit them as necessary.
Click one of the Destination icons to choose where to save your scanned file.

Dwectination - -;I- @ 2 lﬁ' I- *

Note: You may need to click the arrow next to the icons in order to see all of them. The available
icons may vary, depending on the software version you are using.

9. Select settings as necessary, then click OK, Send, or Print to save the scanned file.
Parent topic: Starting a Scan

Starting a Scan Using the Epson Scan Icon

You can start the Epson Scan program to select scan settings, scan, and save the scanned image to a
file.

* Windows 10: Click E and select All apps. Select EPSON Software, then select EPSON Scan.

* Windows 8.x: Navigate to the Apps screen and select EPSON Scan under EPSON or EPSON
Software.

* Windows (other versions): Click © or Start, and select All Programs or Programs. Select EPSON
or EPSON Software and click EPSON Scan.

* OS X: Open the Applications folder, open the Epson Software folder, and double-click the EPSON
Scan icon.

Note: With OS X, in addition to scanning with Image Capture, you can download and install Epson
Scan scanning software. Epson Scan provides additional image adjustment and photo correction
features for enhancing scanned images, and provides an interface for TWAIN-compliant OCR
scanning software. To download Epson Scan, visit Epson's driver download site (U.S. downloads or
Canadian downloads).
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Note: In OS X 10.11, if you see a message asking if you want to use TWAIN to scan with your
product, select Yes to scan using Epson Scan.

You see an Epson Scan window like this:

& EPSON 5can — '
; 1 M ode:
& EPSON Scan Ofics Mode .
Seitings
Mame: Currerit 5ething o
=1 L Delete

Mamn Settings  Image Adjustment

Document Souice; Avita Detect v
Cize: Letted25 =171 in.) -
Orientation ® ﬁ

[] Comect Document Skew

Hotate: o -
Irmage Type: Black & \White w
R ezolution: 200 v | dpi

d Ereview d Scan --@J

Help Configuration. .. Cloze

Parent topic: Starting a Scan
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Related tasks

Scanning with OS X Using Image Capture
Related topics

Placing Originals on the Product
Selecting Epson Scan Settings

Starting a Scan from a Scanning Program

You can start Epson Scan from a scanning program to select scan settings, scan, and open the scanned
image in the program.

Note: With OS X, in addition to scanning with Image Capture, you can download and install Epson Scan
scanning software. Epson Scan provides additional image adjustment and photo correction features for
enhancing scanned images, and provides an interface for TWAIN-compliant OCR scanning software. To
download Epson Scan, visit Epson's driver download site (U.S. downloads or Canadian downloads).

Note: In OS X 10.11, if you see a message asking if you want to use TWAIN to scan with your product,
select Yes to scan using Epson Scan.

1. Open your scanning program and select its scanning option. (See your scanning program help for
instructions.)

2. Select your product.

Note: In certain programs, you may need to select your product as the "source" first. If you see a
Select Source option, choose it and select your product. With Windows, do not select a WIA option
for your product; it will not work correctly.
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You see an Epson Scan window like this:

& EPSON Scan - X
t '_? Mode:
4 EPSON Scan Difice Mode v
Settings
e Cunent 5etting e
Cave Delete

Man Settings  Image Adjustment

Diocurment S ource: Auto Detect w

Gize: Lettes25 =11 in.] "

Orientstior: i ﬁ

[ ] Comect Document Skew

Rotate: ot "
Image T ype: Black & white v
Resolution: 200 | dpi

d Eresiew é Sean ""‘@J

Help Configueation. .. Cloze

Note: Epson Scan may start in a different mode when you first access it.

Parent topic: Starting a Scan
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Related topics
Placing Originals on the Product

Selecting Epson Scan Settings

After starting Epson Scan, you can select settings in various modes to customize your scan.
Scan Modes

Selecting the Scan Mode

Scanning in Office Mode

Scanning in Professional Mode

Image Preview Guidelines

Scan Resolution Guidelines

Selecting Scan File Settings

Parent topic: Scanning

Scan Modes

Epson Scan provides a choice of scan modes with different levels of control over your settings.

Office Mode

You can quickly scan text documents and adjust them on a preview screen. You can also select
various image adjustment options and preview your scanned image.

Professional Mode
You can manually customize all available settings, and preview and size your scanned image.

Parent topic: Selecting Epson Scan Settings

Selecting the Scan Mode

Select the Epson Scan mode you want to use from the Mode box in the upper right corner of the Epson
Scan window:

& EPS0MN 5can - x
b & -’ Mode:

e EPSON Scan Difice Mode

Settings
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Parent topic: Selecting Epson Scan Settings

Scanning in Office Mode

When you scan in Office Mode, Epson Scan automatically saves your scanned file in PDF format in your
operating system's Documents or My Documents folder, or opens it in your scanning program. You can
select settings, preview, and change the scanned file settings as necessary.

1. Start Epson Scan and select Office Mode as the Mode setting.
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You see this window:

e EPSON 5can - W
t '3 Mode:
& EPSON Scan Office Mods 5
Settings
Mame: Current Setting "

G ave [ elete

Man Settings  Image Adjustment

Diocurment S ource: Auto Detect w

Gize: Lettes25 =11 in.] "

Orientatior: i ﬁ

[ ] Comect Document Skew

Rotate: ot -
Image T ype: Black & white ~
Resolution: 0 v | dpi

d Eresiew ﬂ Sean _4@

Help Configueation. .. Cloze

Select the Document Source setting indicating where you placed your original.

Note: If you are using the ADF, remove any documents from the scanner glass.
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12.

13.

14.

Select the Size and Orientation settings that match your original.
To scan both sides of a 2-sided original into one image, select a Stitch Images setting.

Note: To use the Stitch Images setting, you must select ADF-Double-sided as the Document
Source setting.

To allow Epson Scan to detect and correct any skew in your original, select Correct Document
Skew.

To rotate your original in your scan, select a Rotate setting.

Select the Image Type setting that matches your original.

Select the Resolution setting you want to use for your scan.

Click the Preview button.

Epson Scan previews your original and displays the result in a separate Preview window.

. If you are using the ADF, reinsert your original into the ADF.
11.

If desired, select the area in your preview image that you want to scan (scan area).

Note: You cannot select a scan area if you chose ADF-Double-sided as the Document Source
setting.

Click the Image Adjustment tab and select any of the image adjustment settings you want to use.
Before making adjustments, click the image or scan area in the Preview window.

Click Scan.
You see the File Save Settings window.
Change any of the necessary file save settings and click OK.

Epson Scan scans your original, and saves the file in the selected folder or opens it in your scanning
program. If the file was saved directly to your computer, you see the file in the Windows Explorer or OS X
Finder, where you can view and print the image, if desired.

Available Document Source Settings - Office Mode
Selecting a Scan Area - Office Mode
Available Image Adjustments - Office Mode

Parent topic: Selecting Epson Scan Settings

Related concepts
Scan Resolution Guidelines
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Image Preview Guidelines
Related tasks
Scanning in Professional Mode
Selecting Scan File Settings
Available Document Source Settings - Office Mode
You can select these Document Source options in Epson Scan Office Mode.

Scanner Glass
Selects the scanner glass as the location where the originals are placed on your product for scanning.
ADF - Single-sided
Selects the Automatic Document Feeder as the location where the originals are placed on your
product for single-sided scanning.

ADF - Double-sided
Selects the Automatic Document Feeder as the location where the originals are placed on your
product for double-sided scanning.

Auto Detect
Automatically detects where the originals are placed on your product for scanning.

Parent topic: Scanning in Office Mode
Selecting a Scan Area - Office Mode

You can select a specific area in your preview image to include in your scanned image. You can select
the entire image area or a portion of it. You can even select multiple scan areas to create multiple
scanned images of different areas.

You can also use the scan area to select specific Image Adjustments settings for a scanned image. Just
be sure to click inside the scan area before selecting the settings.
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1. In the Preview window, click the i Auto Locate icon to create a marquee (dotted line) on the
preview image.
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2. Do the following, as necessary, to work with the selected scan area:

« If the marquee is correct, continue with the next step.
* To move the marquee, click inside the scan area and drag the marquee where you want it.
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* To resize the scan area, place your cursor over the edge or corner of the marquee, then click and
drag the edges where you want them. (Hold down the Shift key as you resize the marquee to
retain the same width/height proportions.)

» To create additional marquees (up to 50, if available), click the = ] Copy Marquee icon to copy the
existing marquee and paste it on the preview image.

Note: If you draw multiple marquees, make sure you select the All button in the Preview window
before you scan. Otherwise, only the area inside the currently selected marquee will be scanned.

* To delete a marquee, click the marquee, then click the = Delete Marquee icon.

» To rotate your original in your scan, click one of the Rotate icons.
3. Click inside each scan area and make any necessary settings in the Epson Scan window.
Parent topic: Scanning in Office Mode

Related concepts

Scan Resolution Guidelines
Image Preview Guidelines
Related tasks

Selecting Scan File Settings
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Available Image Adjustments - Office Mode

You can select these Image Adjustments options in Epson Scan Office Mode. Not all adjustment settings
may be available, depending on other settings you have chosen.

b ain Settngs Image.-idp.-@trrﬂnt
Urzharp Mask Descreeninaly]
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Bnghiness: 1]
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Note: Select the Image Option checkbox if you need to set any of the grayed-out image adjustments
beneath the checkbox. Not all adjustment settings may be available, depending on the Image Type
setting.

Unsharp Mask
Makes the edges of certain image areas clearer. Turn off this option to leave softer edges.

Descreening
Removes the ripple pattern that might appear in subtly shaded image areas, such as skin tones. This
option improves results when scanning magazines or newspapers. (The results of descreening do not
appear in the preview image, only in your scanned image.)

Text Enhancement
Sharpens the appearance of letters in text documents.

Auto Area Segmentation
Makes grayscale images clearer and text recognition more accurate by separating the text from the
graphics.
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Color Enhance
Enhances the red, green, or blue shades in the scanned image.

Skip Blank Pages
Ensures that your product does not scan pages that contain no text or images.

Edge Fill
Corrects shadowing around the edges of the image by filling the shadows with the color you select.

Brightness

Adjusts the overall lightness and darkness of the scanned image.
Contrast

Adjusts the difference between the light and dark areas of the overall scanned image.
Threshold

Adjusts the level at which black areas in text and line art are delineated, improving text recognition in
OCR (Optical Character Recognition) programs.

Parent topic: Scanning in Office Mode

Scanning in Professional Mode

When you scan in Professional Mode, Epson Scan automatically saves your scanned file in PDF format
in your operating system's Documents or My Documents folder, or opens it in your scanning program.
You can select settings, preview, and change the scanned file settings as necessary.

1. Start Epson Scan and select Professional Mode as the Mode setting.
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You see this window:
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11.

12.

13.

14.

Select the Document Type setting that matches your original, such as Reflective for documents or
photos.

Select the Document Source setting indicating where you placed your original. To scan a 2-sided
document in the ADF, select ADF - Double-sided.

Select the specific type of original you are scanning as the Auto Exposure Type setting: Document
or Photo.

Select the details of your original and how you want it scanned as the Image Type setting.
Select the Resolution setting you want to use for your scan.

Select the size of your document as the Document Size or adjust the size by altering the selection
on the Preview window.

Click the Preview button.
Note: If you are using the ADF, you can only preview one page at a time.

Epson Scan previews your original and displays the result in a separate Preview window.
If you are using the ADF, reinsert your original into the ADF.

. If desired, select the area in your preview image that you want to scan (scan area).

Note: You cannot select a scan area if you chose ADF-Double-sided as the Document Source
setting.

Select any of the image adjustment settings you want to use. Before making adjustments, click the
image or scan area in the Preview window.

If you want to reduce or enlarge your image as you scan, select the Target Size setting you want to
use.

Note: You cannot select a target size if you chose ADF-Double-sided as the Document Source
setting.

Click Scan.
You see the File Save Settings window.
Change any of the necessary file save settings and click OK.
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Epson Scan scans your original, and saves the file in the selected folder or opens it in your scanning
program. If the file was saved directly to your computer, you see the file in the Windows Explorer or OS X
Finder, where you can view and print the image, if desired.

Available Document Source Settings - Professional Mode
Available Image Types - Professional Mode

Selecting a Scan Area - Professional Mode

Available Image Adjustments - Professional Mode
Selecting a Scan Size - Professional Mode

Parent topic: Selecting Epson Scan Settings

Related concepts
Scan Resolution Guidelines
Image Preview Guidelines
Related tasks
Scanning in Office Mode
Selecting Scan File Settings
Available Document Source Settings - Professional Mode
You can select these Document Source options in Epson Scan Professional Mode.

Scanner Glass
Selects the scanner glass as the location where the originals are placed on your product for scanning.

ADF - Single-sided
Selects the Automatic Document Feeder as the location where the originals are placed on your
product for single-sided scanning.

ADF - Double-sided
Selects the Automatic Document Feeder as the location where the originals are placed on your
product for double-sided scanning.

Parent topic: Scanning in Professional Mode
Available Image Types - Professional Mode
You can select these Image Type options in Epson Scan Professional Mode.

24-bit Color
Select this setting for color photos.

Color Smoothing
Select this setting for color graphic images, such as charts or graphs.
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8-bit Grayscale
Select this setting for black-and-white photos.

Black & White
Select this setting for black text documents or line art.

Parent topic: Scanning in Professional Mode
Selecting a Scan Area - Professional Mode

You can select a specific area in your preview image to include in your scanned image. You can select
the entire image area or a portion of it. You can even select multiple scan areas to create multiple
scanned images of different areas (Normal Preview mode only).

You can also use the scan area to select specific image Adjustments settings for a scanned image. Just
be sure to click inside the scan area before selecting the settings.

Note: In Professional Mode, the default Preview mode is Normal Preview mode. To use Thumbnail
Preview mode instead, click the Thumbnail tab.
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1. Do one of the following to select your scan area in the Preview image:

* Normal preview: Click the E: Auto Locate icon to create a marquee (dotted line) on the preview
image.
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+ Thumbnail preview: Your scan area is selected automatically, but you can change it. Place your
cursor in one corner of the desired scan area, then click and drag the cursor to the opposite corner
to create a marquee (dotted line) on the preview image.
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2. Do the following, as necessary, to work with the selected scan area:
« If the marquee is correct, continue with the next step.
* To move the marquee, click inside the scan area and drag the marquee where you want it.
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* To resize the scan area, place your cursor over the edge or corner of the marquee, then click and
drag the edges where you want them. (Hold down the Shift key as you resize the marquee to
retain the same width/height proportions.)

* Normal preview: To create additional marquees (up to 50, if available), click the ] Copy
Marquee icon to copy the existing marquee and paste it on the preview image.

* To delete a marquee, click the marquee, then click the -15 Delete Marquee icon.

Note: If you draw multiple marquees, make sure you select the All button in the Preview window
before you scan. Otherwise, only the area inside the currently selected marquee will be scanned.

3. Click inside the scan area and make any necessary settings in the Epson Scan window.
Parent topic: Scanning in Professional Mode
Available Image Adjustments - Professional Mode

You can select these Adjustments options in Epson Scan Professional Mode. Not all adjustment settings
may be available, depending on other settings you have chosen.

Adjustmerits
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Note: Select the Image Option checkbox if you need to set any of the grayed-out image adjustments
beneath the checkbox.
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Click the | ™ image adjustment icon to access additional settings.
Click the + (Windows) or » (OS X) icon next to a setting to change the level of adjustment.

Unsharp Mask
Makes the edges of certain image areas clearer. Turn off this option to leave softer edges.

Descreening
Removes the ripple pattern that might appear in subtly shaded image areas, such as skin tones. This
option improves results when scanning magazines or newspapers. (The results of descreening do not
appear in the preview image, only in your scanned image.)

Color Restoration
Restores the colors in faded photos automatically.

Backlight Correction
Removes shadows from photos that have too much background light.

Dust Removal
Removes dust marks from your originals automatically.

Auto Exposure

Automatically adjusts the image exposure settings when you click the 4 Auto Exposure icon. To
automatically adjust image exposure settings continuously, click the Configuration button, click the
Color tab, and select Continuous auto exposure. You can adjust the level of auto exposure using a
slider.

Histogram Adjustment
Provides a graphical interface for adjusting highlight, shadow, and gamma levels individually. (For

advanced users only.) Click the w histogram icon to access the settings.

Tone Correction
Provides a graphical interface for adjusting tone levels individually. (For advanced users only.) Click

the & tone correction icon to access the settings.

Brightness
Adjusts the overall lightness and darkness of the scanned image.

Contrast
Adjusts the difference between the light and dark areas of the overall scanned image.

Saturation
Adjusts the density of colors in the overall image.

Color Balance
Adjusts the balance of colors in the overall image.
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Color Palette
Provides a graphical interface for adjusting mid-tone levels, such as skin tones, without affecting the

highlight and shadow areas of the image. (For advanced users only.) Click the “ Color Palette icon
to access the settings.

Threshold
Adjusts the level at which black areas in text and line art are delineated, improving text recognition in
OCR (Optical Character Recognition) programs.

Parent topic: Scanning in Professional Mode
Selecting a Scan Size - Professional Mode

You can reduce or enlarge the size of your image as you scan. You can also select a specific scan size,
such as a common photo size like 4 x 6 inches (102 x 152 mm). This places a scan area of that size on
the preview image so you can use it to help crop the image in the correct proportions.

1. Click the Preview button to preview your image.

2. Inthe Epson Scan window, select the size you want your scanned image to be from the Target Size
list.

+ TaigetSge: Al .. iv|A]

Note: If you need to rotate the orientation of the target size for your image, click the A orientation
icon.
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A marquee (dotted line) appears on your preview image proportioned for the size you selected.

b Proviews

Nomel| Thumbnai

Fiotste

£

7 B

a5 I 1.0 in

— x
Coyraluiad s, 2ol s ecass
Ingtolas your noes ESEon grirmed
W 2T v g il ot e g TR
= Janiw Cpmor 3w baer cgressd = oo xSk e
iy phr=reies s o ws w B Rz
L e L]
B e e e
=W e o e T o sl sk capa S orodie
WD R Ahe B oS Do S B ird
s Inmire
o S AL, s A i e i
ey 1 ke B v 1 £
e L8 e e
2550 x 3509 pinels 25050 ME Re G B

Do the following, as necessary, to work with the selected scan area:

* To move the marquee, click inside the scan area and drag the marquee where you want it.

» To resize the scan area, place your cursor over the edge or corner of the marquee, then click and
drag the edge where you want it.

Note: Manually adjusting the marquee will not change the target size of the scanned file. The
marquee only indicates the area of the image that will be scanned.
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To create a scanned image size that is not available in the Target Size list, click the Customize
option.
You see this window:

i Target Size >
Target Size: Target Size Mame:
| 1zer Defined |
Hegh: [ ]
Uriks: in. w
Save Delete
] Cancel

Name the custom size, enter the size, click Save, and click OK. Then adjust the marquee on the
preview image.
The marquee is automatically proportioned for your custom scan size.
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6. To use additional sizing tools, click the + (Windows) or » (OS X) icon next to the Target Size setting
and select options as desired.

[=] Taiget Sige: Sxiin ~ £I
W J H .00 |in \ ﬂ
Scale: B0 %
Trimming (0 (®) On

» Scale: Reduces or enlarges your image by the percentage you enter.
» Trimming: Turns automatic image cropping on or off.
« 8 Unlock icon: Unlocks the width/height proportions of the scanned image size so you can adjust
it without constraint.
Parent topic: Scanning in Professional Mode

Image Preview Guidelines

You can preview your scanned image so you can adjust the scan settings using the preview as a guide.
There are two types of preview available, depending on the scan mode and selected settings:

Thumbnail preview
A thumbnail preview displays your previewed images as thumbnails with the scanned image area and
exposure automatically selected.

Normal preview
A normal preview displays your previewed images in their entirety so you can select the scanned
image area and other settings manually.

Parent topic: Selecting Epson Scan Settings

Scan Resolution Guidelines

If you plan to enlarge a scanned image so you can print it at a larger size, you may need to increase the
resolution from the default resolution set by Epson Scan. Follow these guidelines to determine the
resolution setting you need:

* You will enlarge the image as you scan it.
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If you will enlarge the image using Epson Scan's Target Size setting, you do not need to increase the
Resolution setting.

* You will scan the image at its original size but enlarge it later in an image-editing program.

Increase Epson Scan's Resolution setting in your scan. Increase the resolution by the same amount
you will increase the image size to retain a high image quality. For example, if the resolution is 300 dpi
(dots per inch) and you will double the image size later, change the Resolution setting to 600 dpi.

* You will scan the image at 100% or smaller size.
Select Epson Scan's Resolution setting based on how you will use the scanned image:
» Email/view on a computer screen/post on the web: 96 to 150 dpi
* Print/convert to editable text (OCR): 300 dpi
» Fax: 200 dpi
Parent topic: Selecting Epson Scan Settings
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Selecting Scan File Settings

You can select the location, name, and format of your scan file on the File Save Settings window. You

can also select various optional settings that control how Epson Scan behaves when you scan and save
files.

& File Save Settings b
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Detailz: Paper See: Actual Image Sze
Onentation: Portrast
Margir: [Left, TopH 0.00mm, 0.00mm)
Fage Mumber: Save File With All Pages
Comgeesson Level - Standard Comprezzion
Text Sating: No

[ ] Orvevnite: any files with the came nams
Shiowa thiz dislog box before nest scan
[] Dpen image falder alter scanning

Showe Add Page dialog after =canning.

Cares Hel

The File Save Settings window may appear after you click Scan on the Epson Scan window. You may
also be able to access the window by clicking the \“# icon on the Epson Scan window.

1. Do one of the following to select the folder in which you want to save your scanned image:
* Click the button for one of the displayed folders.
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» Click the Other button, click the Browse or Choose button, and select a folder.

2. If you want to change the default name for your scanned image, click Edit and select the options you
want.

Select the file format you want to use in the Image Format Type menu.

If your file format provides optional settings, click the Options button to select them.
Choose any of the optional settings you want to use by selecting their checkboxes.
Click OK.

If you selected PDF or Multi-TIFF as the Type setting, you see this window after Epson Scan scans
your document:

o o bk w

Add Page Confirmation

. Scanning complete.
I,e,l Do you want bo continue zcanning and add more pages?
R

Select Edit Page to finizh scanning and edit the pages
before saving the file.

Select Save File to finish scanning and zave the file
withiout editing the pages.

fdd page | Edit page | Save File

7. Choose one of the following options:
« If you are scanning only one page, click Save File.

+ If you need to scan additional pages in a document, click Add page. Place additional pages on
the product for scanning, click Sean, and repeat until you have scanned all the pages. When you
are finished, click Save File.
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+ If you need to delete or reorder the scanned pages, click Edit page. Delete or reorder the pages
using the icons that appear on the bottom of the editing window. When you are finished, click OK.

Note: If you installed an OCR (Optical Character Recognition) program, you may see a screen
indicating the program is converting your page to text. Wait until the program re-scans the page and
close the program, if necessary.

Available Scanned File Types and Optional Settings
Parent topic: Selecting Epson Scan Settings
Available Scanned File Types and Optional Settings

You can select from a variety of scanned file types and optional settings on the File Save Settings
window in Epson Scan.

File Formats

Bitmap (*.bmp)
A standard image file format for most Windows programs.

JPEG (*.jpg)
An image format that lets you highly compress image data. However, the higher the compression, the
lower the image quality. (The TIFF format is recommended when you need to modify or retouch your
scanned image.)

Multi-TIFF (*.tif)
A TIFF file format when multiple pages are saved to the same file, allowing you to edit the images
using a compatible program.

PDF (*.pdf)
A document format that is readable by Windows and OS X systems using Adobe Reader, Acrobat, or
other programs. You can save multi-page documents in one PDF file.

PICT (*.pct)
A standard image file format for most OS X programs.

PRINT Image Matching Il (*.jpg or *.tif)
File formats that include Epson PRINT Image Matching Il data for enhanced quality and a wider color
range (does not affect the way the image displays on the screen).

TIFF (*.tif)
A file format created for exchanging data between many programs, such as graphic and DTP
software.
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Optional Settings

Overwrite any files with the same name
Select to overwrite previous files with the same names.

Show this dialog box before next scan

Select to have the File Save Settings window appear automatically before you scan (in certain Epson
Scan modes).

Open image folder after scanning

Select to have Windows Explorer or OS X Finder automatically open to the folder where your scanned
image is saved after scanning.

Show Add Page dialog after scanning
If you are scanning a multi-page document using the PDF or Multi-TIFF format, select to display a
prompt for scanning additional pages after the first page is scanned.

Parent topic: Selecting Scan File Settings

Scanning with OS X Using Image Capture

With OS X, you can scan with your product using an image-editing application such as Image Capture.

Note: With OS X, in addition to scanning with Image Capture, you can download and install Epson Scan
scanning software. Epson Scan provides additional image adjustment and photo correction features for
enhancing scanned images, and provides an interface for TWAIN-compliant OCR scanning software. To
download Epson Scan, visit Epson's driver download site (U.S. downloads or Canadian downloads).

Open an image editing application, such as Image Capture.

2. Select your Epson product from the DEVICES or SHARED list in the Finder, if necessary. (You may
need to hover over the DEVICES or SHARED list, click Show, and select your product.)

3. Ifyou see the Show Details button, click it.

If you are scanning an item on the scanner glass, your product begins a preview scan.
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4. Select the Scan Mode setting indicating where you placed your original (if available). Select any
other available scan settings as necessary.
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Note: If you are scanning a multi-page document in the ADF, you can have Image Capture combine
all the pages into a single document. After all pages have been scanned, you see the message No
document loaded.

. Select the folder in which you want to save your scanned file in the Scan To pop-up menu.
6. Click Scan.
Your scanned file is saved in the folder you selected.
Available Scan Settings - OS X Image Capture
Parent topic: Scanning

Related topics
Placing Originals on the Product

Available Scan Settings - OS X Image Capture
You can select these scan settings in your imaging editing application for OS X, if available.

Image Correction
Provides a graphical interface for adjusting brightness, tint, temperature, and saturation.

Unsharp Mask
Makes the edges of certain image areas clearer. Turn off this option to leave softer edges.

Descreening
Removes the ripple pattern that might appear in subtly shaded image areas, such as skin tones. This
option improves results when scanning magazines or newspapers. (The results of descreening do not
appear in the preview image, only in your scanned image.)

Backlight Correction
Removes shadows from photos that have too much background light.

Dust Removal
Removes dust marks from your originals automatically.

Color Restoration
Restores the colors in faded photos automatically.

Quiet Mode
Reduces noise during scanning and may reduce scan speed.

Parent topic: Scanning with OS X Using Image Capture
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Scanning Special Projects

Your product's scanning software offers various options to help you quickly complete special scan
projects.

Scanning to a SharePoint Server or Cloud Service
Scanning Multi-Page Originals as Separate Files

Parent topic: Scanning

Scanning to a SharePoint Server or Cloud Service

You can use Document Capture Pro to upload scanned images to a SharePoint server or a cloud
service.

1. Do one of the following to start Document Capture Pro:

* Windows 10: Click E and select All apps. Select EPSON Software, then select Document
Capture Pro.

* Windows 8.x: Navigate to the Apps screen and select Document Capture Pro.

* Windows (other versions): Click e or Start, and select All Programs or Programs. Select
EPSON Software, then select Document Capture Pro.

* OS X: Open the Applications folder, select the Epson Software folder, and select Document
Capture. Select your product and click OK, if necessary.
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You see a window like this:

® Document Cagiure Pro = ““
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Click the El Scan icon.
Select any displayed scan settings you want to use.

Note: See the Help information in Document Capture Pro or Document Capture for details.

Click Scan.
You see a preview of your scan in the Document Capture Pro or Document Capture window.
Click one of the cloud service Destination icons to choose where to save your scanned file.

. EIWeb Folder (WebDAV)

E Evernote (Windows only)

. L Google Drive

. * SugarSync

200



.
»
[ 3

4] Microsoft SharePoint server (Windows only)

Note: You may need to click the arrow next to the icons in order to see all of them. The available
icons may vary, depending on the software version you are using.

6. Select your Destination settings.

Note: The settings may vary, depending on the software version you are using. See the Help
information in Document Capture Pro or Document Capture for details.

7. Select any other scan settings as necessary, and click Send.
Your originals are scanned and uploaded to the indicated server.

Note: You can also create a scan job for uploading scanned images to a SharePoint server or a cloud
service. You can use the scan job when you scan with Document Capture Pro or Document Capture or
when you scan using the Document Capture Pro option on the product control panel.

Parent topic: Scanning Special Projects

Scanning Multi-Page Originals as Separate Files

You can use Document Capture Pro (Windows only) to scan multi-page originals as separate scanned
files. You indicate where you want the new scanned files to start by inserting a blank page or barcode
between the pages of your original.

Note: The settings may vary, depending on the software version you are using. See the Help information
in Document Capture Pro for details.

1. Load a multi-page original with blank pages or barcodes inserted where you want to start a new
scanned file.
2. Do one of the following to start Document Capture Pro:

* Windows 10: Click IEI and select All apps. Select EPSON Software, then select Document
Capture Pro.

* Windows 8.x: Navigate to the Apps screen and select Document Capture Pro.
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* Windows (other versions): Click ﬁ or Start, and select All Programs or Programs. Select
EPSON Software, then select Document Capture Pro.

You see this window:
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Click the El Scan icon.
Select any displayed scan settings you want to use.

Note: See the Help information in Document Capture Pro for details.

Click Scan.

You see a preview of your scan in the Document Capture Pro window.
Open the File menu and select Batch Save.

Click File Name Settings.

Select Apply Job Separation and click Separation Settings.

Select the method you used to separate the originals, select a folder name specification and click
OK.
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10. Select any other settings from the File Name settings window as necessary and click OK.
11. Select any other settings from the Batch Save window as necessary and click OK.

Your originals are saved into separate files as specified.
Note: You can also create a scan job for scanning multi-page originals as separate scanned files. You
can use the scan job when you scan with Document Capture Pro or when you scan using the Document
Capture Pro option on the product control panel.

Parent topic: Scanning Special Projects
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Faxing

See these sections to fax using your product.

Note: This product allows you to store names, telephone numbers, and fax data in its memory even
when the power is turned off. Make sure you restore all of the default settings if you give away or dispose
of the product. This will erase all of your network settings and fax data.

Note: When using the Epson Universal Print Driver or PostScript (PS3) printer software with the product,
you can fax using the printer buttons or the utilities included with the standard Epson printer software. To
download the standard Epson printer software, go to epson.com/support/wfm5694downloads.

Connecting a Telephone or Answering Machine
Setting Up Fax Features

Setting Up Contacts and Contact Groups
Sending Faxes

Receiving Faxes

Checking Fax Status

Printing Fax Reports

Connecting a Telephone or Answering Machine

You must connect your product to a telephone wall jack to send or receive faxes. If you want to use the
same telephone line to receive calls, you can connect a telephone or answering machine to your product
using an additional phone cable.

Note: If you do not connect a telephone to your product, make sure Receive Mode is set to Auto.
Otherwise, you cannot receive faxes.
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1. Connect a phone cable to your telephone wall jack and to the LINE port on your product.

s, LINE

/.

Q

(¥
V—

Note: If you have a DSL or ISDN connection, you must connect the appropriate DSL filter, or ISDN
terminal adapter or router to the wall jack to be able to use the line for faxing or voice calls using your
product. Contact your DSL or ISDN provider for the necessary equipment.

DSL connection

1  Telephone wall jack
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2 DSL filter
3 DSL modem

ISDN connection

1 ISDN wall jack
2  Terminal adapter or ISDN router

2. If you are connecting a telephone or answering machine to your product using a second phone
cable, remove the cap from the EXT port on your product.

/
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3. Connect a second phone cable to your telephone or answering machine and to the EXT port on your
product.

24
(e A

EXT.

Note: If you connect an answering machine and Receive Mode is set to Auto, set the number of
rings before your product answers a call to a number that is higher than your answering machine's
setting for the number of rings.

Any phone or answering machine must be connected to the EXT port for your product to detect an
incoming fax call when the phone is picked up. Epson cannot guarantee compatibility with VoIP,
cable phone systems, or fiberoptic digital services such as FIOS.

Parent topic: Faxing

Related tasks
Receiving Faxes Automatically

Setting Up Fax Features
Before faxing with your product, set up your fax header and select the fax features you want to use.

Note: If you leave your product unplugged for a long period of time, you may need to reset the date and
time settings for faxes.

Setting Up Basic Fax Features

Selecting Advanced Fax Settings

Setting Up Fax Features Using the Fax Utility - Windows
Setting Up Fax Features Using the Fax Utility - OS X
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Parent topic: Faxing

Related tasks
Setting Up Fax Features Using the Fax Utility - Windows
Setting Up Fax Features Using the Fax Utility - OS X

Setting Up Basic Fax Features
See these sections to select the basic settings you need to use the product's fax features.

Selecting Your Country or Region
Selecting the Date and Time

Using the Fax Setup Wizard

Selecting the Line Type

Setting the Number of Rings to Answer

Parent topic: Setting Up Fax Features
Selecting Your Country or Region
Before faxing, select the country or region in which you are using your product.
Note: If you change the country or region, your fax settings return to their defaults and you must select

them again. This setting can be locked by an administrator. If you can't access or change this setting,
contact your administrator for assistance.

1. Press the f home button, if necessary.
2. Select Setup.

T &

Paper Setup ]
Frint Status Sheet |
 Hetwark Stalus ]

T
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3. Scroll down and select System Administration. Enter the administrator password, if necessary.

I. System Adninistration

F'nnl::r Sl:ll:mgs

Commnon Seitings | I

Wi=Fi Hetmork Setlings

Epson Connect Servioes

| Gongle Cioiad Prind Services

I-Il

4. Select Common Settings.

5. Scroll down and select Country/Region.

6. Scroll up or down, if necessary, then select your country or region.
You see a confirmation screen.

7. Ifthe setting is correct, select Yes. (If not, select No and retry.)

Note: Changing the country or region restores the fax settings to the default settings.

Parent topic: Setting Up Basic Fax Features
Selecting the Date and Time

Before faxing, select the current date, time, and daylight saving phase in your area, and choose your
preferred date and time format.

Note: This setting can be locked by an administrator. If you can't access or change this setting, contact
your administrator for assistance.

1. Press the M home button, if necessary.
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2. Select Setup.

[ Ink Levels I

Maintenanoe | |
Paper Setup |

Print Status Sheed I

. Retwark Stalus ] ¥

3. Scroll down and select System Administration. Enter the administrator password, if necessary.
4. Select Common Settings.

B Connon Setfings

' LCD Brighiness I
S | |
Sleep Timer |

Power Off Timer |
Dt/ Time Settings ||w

5. Select Date/Time Settings.
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You see a screen like this:

Bt Date/Tine Settings

Dm:ﬂm:

Ela'pinhl Savire] Time ||

Tlue Difference

6. Select Daylight Saving Time.
7. Select the setting that applies to your area:
* Winter: it is winter or your region does not use Daylight Saving Time (DST)
* Summer: it is spring or summer and your region uses Daylight Saving Time (DST)

Note: If your region uses Daylight Saving Time (DST), you must change this setting to match the
season. When you change from Winter to Summer, your product automatically sets its clock ahead
one hour. When you change from Summer to Winter, it sets its clock back one hour.

8. Select Date/Time.

9. Select the date format you want to use.

10. Use the numeric keypad to enter the current date.
11. Select the time format you want to use.

12. Use the numeric keypad to enter the current time.

13. If necessary, select Time Difference and use the icons on the screen to set the difference between
UTC (Coordinated Universal Time) and your time zone.

Parent topic: Setting Up Basic Fax Features
Using the Fax Setup Wizard

You can setup the product's basic fax settings using the Fax Setting Wizard. This wizard is automatically
displayed when the product is turned on for the first time. You can also change these settings individually
from the Fax Settings menu.
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Note: These settings can be locked by an administrator. If you can't access or change these setting,
contact your administrator for assistance.

1. Press the M home button, if necessary.
2. Select Setup.

[ Ik Levels I

Mairtenanee | |
Paper Setup |

Print Status Sheet |

 etwark Stalus K

3. Scroll down and select System Administration. Enter the administrator password, if necessary.

Bt System Adninistration

. Printer Seitings | i
Connon Setlings | I

i=Fls Hetrork Setlings
Epson Conmett Sefvices I
| Gongle Cluusd Prind Services ||w

4. Scroll down and select Fax Settings.

5. Scroll down and select Fax Setting Wizard.
The Fax Setting Wizard screen appears.

6. Select Start.
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You see a Fax Header screen like the following:

7. Onthe Fax Header screen, use the displayed keypad to enter the sender name for your fax source,
such as your name or a business name. You can enter up to 40 characters.

8. On the Your Phone Number screen, use the displayed keypad to enter your fax number, up to 20
characters.

Note: The name and phone number in the fax header identifies the source of the faxes you send.

9. On the Distinctive Ring Setting screen, do one of the following:

+ If you have subscribed to a distinctive ring service from your telephone company, select Proceed.
Select the ring pattern to be used for incoming faxes or select On. Go to step 12.

+ If you do not have a distinctive ring service, select Skip and go to the next step.

Note: Distinctive ring services allows you to have several phone numbers on one phone line. Each
number is assigned a different ring pattern. You can use one number for voice calls and another for
fax calls. Select the ring pattern assigned to fax calls in the DRD Setting. If you select On or a ring
pattern other than All, Receive Mode is automatically set to Auto.

10. On the Receive Mode Setting screen, do one of the following:

+ If you have connected an external telephone or answering machine to the product, select Yes and
go to the next step.

+ If you did not connect an external telephone or answering machine, select No and go to step 12.
(Receive Mode is automatically set to Auto; otherwise you cannot receive faxes.)
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11. On the next Receive Mode Setting screen, select Yes to receive faxes automatically or select No to
receive faxes manually.

Note: If you connect an external answering machine and select to receive faxes automatically, make
sure the Rings to Answer setting is correct. If you select to receive faxes manually, you need to
answer every call and operate the product’s control panel or your phone to receive faxes.

12. On the Confirm Settings screen, confirm the displayed settings and select Proceed, or press 3 back
to change the settings.

13. On the Run Check Fax Connection screen, select Start and follow the on-screen instructions to
check the fax connection and print a report of the check result. If there are any errors reported, try
the solutions on the report and run the check again.

Note:
+ Ifthe Select Line Type screen appears, select the correct line type.

+ If the Select Dial Tone Detection screen appears, select Disable. However, disabling the dial tone
detection function may drop the first digit of a fax number and send the fax to the wrong number.

Parent topic: Setting Up Basic Fax Features

Related tasks
Entering Characters on the LCD Screen

Selecting the Line Type

If you connect the product to a PBX phone system or terminal adapter, you must change the product's
line type. PBX (Private Branch Exchange) is used in office environments where an external access code
such as “9” must be dialed to call an outside line. The default Line Type setting is PSTN (Public Switched
Telephone Network), which is a standard home phone line.

Note: This setting can be locked by an administrator. If you can't access or change this setting, contact
your administrator for assistance.

1. Press the M home button, if necessary.
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Select Setup.

[ Ink Levels I

Maintenanoe | |
Paper Setup |

Print Status Sheet |
. Retwark Stalus ] ¥

Scroll down and select System Administration. Enter the administrator password, if necessary.

Bl Svstem Adninkstration

P'I'IHEH Sedtings

Commnon Seitings | I

i=Fls Hetrork Setlings
Epson Conmeit Services ]
| Gongle Cluud Print Services ||w

Scroll down and select Fax Settings.
Select Basic Settings.

Select Line Type.

Select PBX.
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You see a screen like this:

Bt Access Code

=7 [0 Mot Use Lise

8. Select Use.
9. Select Access Code.
10. Use the displayed keypad to enter the external access code such as 9, and select OK.
Parent topic: Setting Up Basic Fax Features
Setting the Number of Rings to Answer

If you connect an external answering machine and select to receive faxes automatically, make sure the
Rings to Answer setting is correct. The number of rings should be higher than the number of rings your
answering machine is set to for answering a call.

Note: This setting can be locked by an administrator. If you can't access or change this setting, contact
your administrator for assistance.

1. Press the M home button, if necessary.
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2. Select Setup.

[ Ink Levels I

Maintenanoe | |
Paper Setup |

Print Status Sheed I
. Retwark Stalus ] ¥

3. Scroll down and select System Administration. Enter the administrator password, if necessary.

Bl Svstem Adninkstration

P'I'IHEH Sedtings

Commnon Seitings | I

Wi=Fif Hetrork Settings
Enson Connect Servioes ]
| Gongle Cluud Print Services ||w

4. Scroll down and select Fax Settings.
5. Select Receive Settings.
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6. Select Rings to Answer.

Bt Fings 1o Answer

7. Select the number of rings, and select OK. Make sure to select a number higher than the number of
rings your answering machine is set to for answering a call.

Note: An answering machine picks up every call faster than the product, but the product can detect fax
tones and start receiving faxes. If you answer the phone and hear a fax tone, check that the product has
started receiving the fax, then hang up the phone.

Parent topic: Setting Up Basic Fax Features

Selecting Advanced Fax Settings

You can select a variety of advanced fax settings.

Note: These settings can be locked by an administrator. If you can't access or change these setting,
contact your administrator for assistance.

1. Press the M home button, if necessary.
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2. Select Setup.

[ Ink Levels I
Paper Selup |

Print Status Sheed I

. Retwark Stalus ] ¥

3. Scroll down and select System Administration. Enter the administrator password, if necessary.

Bl Svstem Adninkstration

P'I'IHEH Sedtings

Commnon Seitings | I

Wi=Fif Hetrork Settings
Enson Connect Servioes ]
| Gongle Cluud Print Services ||w

4. Scroll down and select Fax Settings.
You see a screen like this:

Bl Fm Settings

LIE'F’UEIHU||.5'4.‘-|.|JI1'EI‘5

Sen Setbings | |
Recetee Settings |

Output Setings |

 Basic Settings ||w
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5. Select the group of settings you want to change.

User Default Settings - Fax
Send Settings - Fax
Receive Settings - Fax
Output Settings - Fax
Basic Settings - Fax
Security Settings - Fax

Parent topic: Setting Up Fax Features

Related topics

Receiving Faxes

Sending Faxes

Setting Up Basic Fax Features

User Default Settings - Fax
Set the default settings you want to use for faxing.

Setting Options Description
Resolution Standard Adjusts the scan resolution and print quality of
Fine outgoing faxes.
Super Fine
Ultra Fine
Photo
Density Auto Automatically adjusts the darkness of outgoing
faxes. Select this option when sending black-and-
white text documents.
Manual Lets you select from various density levels.
Document Size (Glass) |Half Letter Sets the size for a document placed on the scanner
glass.
A5
Letter
A4
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Setting Options Description
ADF 2-Sided Off Select On to enable 2-sided faxing from the ADF.
o The Direct Send option and color faxing are disabled
n , .
when you turn on this setting.
Direct Send Off Select On to send black-and-white faxes to a single
on recipient as soon as the connection is made, without
saving the scanned image to memory. You cannot
use this setting when sending a color fax or sending
a fax to multiple recipients.
Continuous Scan from | Off Select On to have the product to ask if you want to
ADF on scan another page after a document in the ADF has

finished scanning.

Transmission Report

Print on Error

Lets you select when to print transmission reports.

Print

Do Not Print

Parent topic: Selecting Advanced Fax Settings

Send Settings - Fax

Set the send options you want to use for outgoing faxes.

Setting Options Description
Batch Send Off Sorts outgoing faxes by recipient in the product's
on memory, and then sends them as a batch.
Save Failure Data Off Saves faxes that failed to be sent in the product’s
on memory. You can resend the faxes from the product's

Status Menu.

Parent topic: Selecting Advanced Fax Settings

Receive Settings - Fax

Set the receive options you want to use for incoming faxes.
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Setting

Receive Mode

Distinctive Ring

Rings to Answer

Remote Receive

Options Description

Manual Lets you confirm whether an incoming fax should be
printed; a telephone must be connected to the product

Auto Automatically receives and prints faxes.

All If you are using a Distinctive Ring Service on your

Sinale phone line, your telephone company can assign two

9 or more phone numbers to the same line and assign
Double different ring patterns to each. If you use this service,
Triole select the number of rings for your fax number so your

P product can receive faxes on the correct number of

Double&Triple rings. Select All for phones lines that do not use this
service.

1109 Sets the number of rings before your product receives
a fax. If Receive Mode is set to Auto and an
answering machine is connected to the product, make
sure this setting is set higher than the number of rings
your answering machine is set to answer a call.

Off Lets you start receiving faxes using your phone

on instead of operating the product (if the Receive Mode
is set to Auto). When you select On, you must also

Start Code set a Start Code. If you are using a cordless handset

with its base connected to the product, you can start
receiving the fax by entering the code using the
handset.

Parent topic: Selecting Advanced Fax Settings

Output Settings - Fax

Set the output options you want to use for incoming faxes.

Note: If you select Save to Inbox, faxes are saved in the product's memory. Delete faxes after viewing
or printing to prevent the memory from filling up. Even if you select other options for saving faxes, they
may be saved temporarily in the product's memory.
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Setting

Options

Description

Fax Output

Other Settings

Lets you create a folder for saving faxes on a memory
device and select settings for forwarding faxes.

Save to Inbox

Saves incoming faxes in the product's memory. You
can view the faxes on the LCD screen and print if
needed. Select how to process incoming faxes when
the memory is full by selecting the option to receive
and print faxes, or to reject incoming faxes.

Save to Computer

To use this option, you must use the Epson FAX
Utility. Select Yes and Print to have faxes saved to
your computer and printed automatically.

Save to Memory
Device

Saves incoming faxes to a connected memory device
or USB storage device. Select Yes and Print to have
faxes saved to the memory device and printed
automatically.

Forward Forwards incoming faxes to as many as 5 numbers in
your contact list. Select Yes and Print to have faxes
forwarded and printed automatically.

Note: Color faxes cannot be forwarded.
Auto Reduction On Select to reduce the size of large received faxes to fit
on the paper size in the selected paper source.

Off Select to print large incoming faxes at their original
size on multiple sheets, if necessary.

Auto Rotation On If you have loaded A5-size paper, select On to rotate

Off landscape-oriented incoming faxes so that they print
correctly on the paper.

Collation Stack On Select On to print incoming faxes so that the pages

Off are stacked in the correct page order. (When the

product is low on memory, this option may not be
available.)
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Time to Restart

Setting Options Description
Print Suspend Time Off Select On to set a time period to stop automatic
on printing of faxes or reports and save received faxes in
the product’s memory. (Make sure there is enough
Time to Stop free memory before using this function.)

Forwarding Report

Print on Error

Print

Do Not Print

Selects whether or when to print a report after an
incoming fax is forwarded.

Attach Image to Report

Off

Does not include an image of the fax on transmission
reports.

On(Small Image)

On(Large Image)

Prints transmission reports with an image of the first
faxed page. (Does not work when you select Direct
Send.)

Fax Log Auto Print Off Does not print the fax log.
On(Every 30) Prints the fax log after 30 faxes are sent or received.
On(Time) Prints the fax log at a time you select using the
numeric keypad displayed on the LCD screen.
Report Format Simple Selects the amount of information on fax reports.
Detail

Parent topic: Selecting Advanced Fax Settings

Basic Settings - Fax

Set the basic options you want to use for incoming and outgoing faxes.

Setting

Options

Description

Fax Speed

Fast(33,600bps)

Sets the speed at which you send and receive

Medium(14,400bps)

faxes.

Slow(9,600bps)
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Setting

Options

Description

ECM

On

Turns on Error Correction Mode (ECM) to
automatically correct errors in sent or received fax
data.

Off

Turns off Error Correction Mode (ECM); color
faxes cannot be sent or received.

Dial Tone Detection

On

Automatically dials the number you enter for faxing
when the product detects a dial tone.

Off

Turns off automatic dial tone detection, which may
be necessary if the product is connected to a PBX
(Private Branch Exchange) or a TA (Terminal
Adapter). However, turning this setting off may
cause the product to drop the first digit of a fax
number.

Line Type

PSTN

Selects a standard phone line (Public Switched
Telephone Network).

PBX

Selects Private Branch Exchange, the type of
phone line used in office environments where an
access code such as 9 must be used to call an
outside line.

Header

Fax Header

Select to enter the header information and your

Your Phone Number

phone number for inclusion on outgoing faxes.

Parent topic: Selecting Advanced Fax Settings

Security Settings - Fax

Set the security options you want to use for fax data.

Setting Options Description
Direct Dialing Off Does not restrict dialed fax numbers.
Restrictions On Allows faxing only to numbers stored in the contacts
list or history.
Enter Twice Requires you to enter fax numbers twice to prevent
errors.
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Setting Options Description

Confirm Address List Off Selects whether or not to display a recipient
on confirmation screen before a fax is sent.
Inbox Password Register Select to set a password for viewing incoming faxes.
Settings
Backup Data Auto Clear | Off Automatically erases sent or received fax data from
on your product's memory.
Clear Backup Data — Deletes all sent or received fax data remaining in your

product's memory; run this function if you are giving
away or disposing of your product.

Parent topic: Selecting Advanced Fax Settings

Setting Up Fax Features Using the Fax Utility - Windows
You can set up your fax header and select your fax settings using the FAX Utility for Windows.
1. Do one of the following:

* Windows 10: Click E and select All apps, then select EPSON Software.
» Windows 8.x: Navigate to the Apps screen.

* Windows (other versions): Click E" or Start > Programs or All Programs > EPSON Software.
2. Select FAX Utility.
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You see this window:

3. Select Fax Settings for Printer. (Select your product, if prompted.)
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You see this window:

w— Fax E-l:ttlngﬁ for Printer - EPS0OMN 4

Tool [ Check Fax Connection
Fax Sattings
Recaived Fax Output Settings

Speed Dil'Group Dial Lisk

Hep Halp

4. Select Fax Settings.
5. Follow the prompts that appear on the screen to enter your fax header information and select your
fax settings.

Note: For detailed information, select the FAX Utility Help option.

Parent topic: Setting Up Fax Features

Related topics
Setting Up Fax Features

Setting Up Fax Features Using the Fax Utility - OS X
You can set up your fax header and select your fax settings using the FAX Utility for OS X.

1. Inthe Apple menu or the Dock, select System Preferences. Select Print & Fax, Print & Scan, or

Printers & Scanners, select your product, and select Options & Supplies. Select Utility and select
Open Printer Utility.
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2. Double-click FAX Utility, if necessary.
You see this window:

a8 n FAX Lhility
Printer FAX EFSON
Taol \ II. m
—_— 23
: v —&3
Fam Transmason Sypralinres It Fas Retewt Monnor
Esead Conmbesi
Fax Settings ] [ A
T \' ;\ ||I
ot
Chech Fax Fiix SEImags Spewd Dial ) Crows
5 Connection Dial Ui

3. Select your FAX product in the Printer list.
4. Select Fax Settings.

5. Follow the prompts that appear on the screen to enter your fax header information and select your
fax settings.

Note: For detailed information, select the FAX Utility ? icon.

Parent topic: Setting Up Fax Features

Related topics
Setting Up Fax Features

Setting Up Contacts and Contact Groups

You can set up a list of contacts and their fax numbers so you can quickly select them for faxing. You
can also set up contact groups to send a fax message to multiple contacts.

Setting Up Contacts Using the Product Control Panel
Setting Up Speed/Group Dial Lists Using the Fax Utility - Windows
Setting Up Speed/Group Dial Lists Using the Fax Utility - OS X
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Parent topic: Faxing

Setting Up Contacts Using the Product Control Panel

You can set up your contacts and contact groups using the control panel on your product.

Note: Contacts can be locked by an administrator. If you cannot access or change contacts, contact
your administrator for assistance.

Creating a Contact

Editing or Deleting a Contact

Creating a Contact Group

Editing or Deleting a Contact Group

Parent topic: Setting Up Contacts and Contact Groups

Related tasks

Setting Up Speed/Group Dial Lists Using the Fax Utility - Windows

Setting Up Speed/Group Dial Lists Using the Fax Utility - OS X
Creating a Contact

You can create a list of contacts to save frequently used fax numbers.

Note: You can also create contacts from the Home screen, which lets you select several types of
contacts. You can create up to 200 contacts and contact groups combined.

1. Press the M home button, if necessary.
2. Select Fax.
You see a screen like this:

fem (4= IR ADF (03 3
=

[Resolution Densily Comacts
= Histaory

+  Jocumernd =i, ALF 2=51ded
) ) < E—0

Menu | (D Preview
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3. Select Contacts. Enter the administrator password, if necessary.
You see a screen like this:

oo ns ABC N
[ 004 | il GEDEGES |
[ i | 4 Book ok |

—_—
Menu Procesd

4. Select Menu.

You see a screen like this:

™ Menu A |
il Entry |
G |
1

Note: You can print your list of contacts and groups if necessary.

5. Select Add Entry.

6. Select the number you want to use for the contact you are adding.
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You see a screen like this:

™ Add Entry A |

Hame '
Hod Entered l I
Index Word

Hiol Enfered ﬁ

7. Select the Name field, use the displayed keyboard to enter the contact name (up to 30 characters),
and press .

8. Select the Index Word field, use the displayed keyboard to enter a word to use when searching for
an entry (up to 30 characters), and press ﬁ (This field is optional.)

9. Select the Fax Number field, and use the numeric keypad on the LCD screen or the buttons on the
product to enter the fax number. You can enter up to 64 characters.

Note: If necessary, enter an outside line access code (such as 9) at the beginning of the fax number.
If the access code has been set up in the Line Type setting, enter the # pound sign instead of the
code.

10. Set the Fax Speed, if necessary.

11. Select Save.

Parent topic: Setting Up Contacts Using the Product Control Panel
Editing or Deleting a Contact

You can edit or delete any of the contacts on your list.

1. Press the M home button, if necessary.

2. Select Fax.
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You see a screen like this:

fm Fax S = | T 0
=
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3. Select Contacts. Enter the administrator password, if necessary.
4. Select the contact you want to edit or delete.
You see a screen like this:

™ Detals

Mane
ARG
Indix Word
Hiot Entered
F it Humler

Delete

5. Do one of the following:
» To delete the contact, select Delete and select Yes on the confirmation screen.

» To edit the contact, select Edit, select the item you want to change, enter the correct information,
and select- When you are finished editing, select Save.
Parent topic: Setting Up Contacts Using the Product Control Panel

Creating a Contact Group
You can create a group of contacts so that you can easily send faxes to multiple recipients.
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Note: You can create up to 200 contacts and contact groups combined.

1. Press the M home button, if necessary.
2. Select Fax.

You see a screen like this:

fom | Faxt [ o | EVE =

i B

Resolution [:] Demsily ComMacls

History

g]. ADF 2=Sided
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i Preview

3. Select Contacts. Enter the administrator password, if necessary.
4. Select Menu.

You see a screen like this:

™ Menu FIN

i Entry |
Adlil Group |
Prink Ciomlacts |

Note: You can print your list of contacts and groups if necessary.

5. Select Add Group.

6. Select the number you want to use for the group you are adding.
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You see a screen like this:

™ Add Group

Hamge
Hod Entered I

Index Word

Hiol Enfered

|

7. Select the Name field, use the displayed keyboard to enter the group name (up to 30 characters),

and press .
8. Select the Index Word field, use the displayed keyboard to enter a word to use when searching for a
group (up to 30 characters), and press . (This field is optional.)

9. Select Proceed.
You see your contacts list.
10. Select the number next to each contact you want to include in your group.
A check mark appears next to each selected contact.
11. Select Save.
Parent topic: Setting Up Contacts Using the Product Control Panel
Editing or Deleting a Contact Group

You can edit an existing contact group to add or delete entries. You can also delete the entire contact
group.

1. Press the f home button, if necessary.
2. Select Fax.
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You see a screen like this:

fm Fx S = | T 0
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3. Select Contacts. Enter the administrator password, if necessary.
You see a screen like this, showing both individual contacts and contact groups:
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4. Select the group you want to edit.
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You see a screen like this:

™ Detals

non AR

Delete

Note: If you want to delete the entire group, select Delete.

5. To edit the group, select Edit.
6. Select Proceed.
You see a list of the contacts in your group.
7. To add or delete a contact, select the number next to it.
8. Select Save.
Parent topic: Setting Up Contacts Using the Product Control Panel

Setting Up Speed/Group Dial Lists Using the Fax Utility - Windows

You can set up your speed dial and group dial lists using the FAX Utility for Windows. The utility also lets
you import fax numbers from the Windows Address Book and back up fax numbers stored in your
product's memory.

Note: You can create up to 60 speed dial and group dial entries combined.

1. Do one of the following:

- Windows 10: Click I and select All apps > EPSON Software.
* Windows 8.x: Navigate to the Apps screen.

* Windows (other versions): Click E’ or Start > Programs or All Programs > EPSON Software.
2. Select FAX Utility.
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You see this window:

3. Select Fax Settings for Printer. (Select your product, if prompted.)
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You see this window:

& Fax Settings for Printer - EPS0ON - e

4. Select Speed Dial/Group Dial List.
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You see this window:
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Note: To edit an entry, select it and click the # icon. To delete an entry, select it and click the *

» To create a speed dial entry, select Speed Dial, enter a name and fax number, and click OK.
» To create a group dial entry, select Group, enter a name, select your desired fax numbers, and

Repeat the previous steps as necessary to add all your speed dial or group dial entries.

5. Select an empty entry and click the # icon.
icon.
6. Do one of the following:
click OK.
7.
8.

+
When you are finished, click the &= icon to save the entries to your product's memory.

Parent topic: Setting Up Contacts and Contact Groups

Related topics
Setting Up Contacts Using the Product Control Panel
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Setting Up Speed/Group Dial Lists Using the Fax Utility - OS X

You can set up your speed dial and group dial lists using the FAX Utility. The utility also lets you import
fax numbers from the MacAddress Book and back up fax numbers to your product's memory.

Note: You can create up to 60 speed dial and group dial entries combined.

1. Inthe Apple menu or the Dock, select System Preferences. Select Print & Fax, Print & Scan, or
Printers & Scanners, select your product, and select Options & Supplies. Select Utility and select

Open Printer Utility.
2. Double-click FAX Utility, if necessary.
You see this window:
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3. Select your FAX product in the Printer list.
4. Select Speed Dial/Group Dial List.
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You see this window:
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5. To add an entry, double-click an empty entry.
Note: To edit an entry, select it and change the information. To delete an entry, select it and press
the Delete key on your keyboard.
6. Do one of the following:
» To create a speed dial entry, select Speed Dial, enter a name and fax number, and click OK.
» To create a group dial entry, select Group Dial, enter a name, select your desired fax numbers,
and click OK.
7. Repeat the previous steps as necessary to add all your speed dial or group dial entries.
IR .
8. To import entries from your MacAddress book, click the L icon.
9. When you are finished, click the - icon to save the entries to your product's memory.

Parent topic: Setting Up Contacts and Contact Groups

Related topics
Setting Up Contacts Using the Product Control Panel
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Sending Faxes
See these sections to send faxes using your product.
Sending Faxes from the Product Control Panel
Sending Faxes Using the Fax Utility - Windows
Sending Faxes Using the Fax Utility - OS X
Parent topic: Faxing

Sending Faxes from the Product Control Panel
See these sections to send faxes using the product's control panel.

Sending a Fax Using the Keypad, Contact List, or History
Fax Sending Options

Sending a Fax at a Specified Time

Sending a Fax on Demand

Sending a Stored Fax

Dialing Fax Numbers from a Connected Telephone

Parent topic: Sending Faxes
Related references
Fax Sending Options

Related tasks
Selecting the Line Type
Using Presets

Related topics

Setting Up Contacts and Contact Groups
Setting Up Contacts and Contact Groups
Placing Originals on the Product

Sending a Fax Using the Keypad, Contact List, or History

You can send a fax from your product control panel by entering the fax number, or selecting the number
from either the contact list or fax history.

Note: You can send a black-and-white fax to up to 200 recipients at a time, or send a color fax to one
recipient at a time. If your recipient's fax machine does not print in color, your fax is automatically sent in
black-and-white.
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Note: The product can queue up to 50 black-and-white fax jobs. You can check or cancel fax jobs in the
queue using the Status Menu.

1. Place your original on the product for faxing.

2. Press the M home button, if necessary.

3. Select Fax.
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Note: To fax a double-sided document, place your document in the ADF and turn on the ADF 2-
Sided setting. (You cannot fax double-sided documents in color.)

4. Do one of the following to select fax recipients:
« Manually enter a fax number: Press the Enter a Fax Number field and enter a fax number.

Press when done. To add another fax number, repeat the same steps. You can also use the
numeric keypad on the control panel to enter a fax number.

Note: If direct dialing has been restricted, you can only select the number from the contact list or
fax history. If necessary, enter an outside line access code (such as 9) at the beginning of the fax
number. If the access code has been set up in the Line Type setting, enter the # pound sign
instead of the code.

+ Select from the contact list: Select Contacts to display the contact list screen. Select the
checkbox next to one or more contact (select the checkbox again to deselect it). You can also
select the Search field to search for recipients by name, index name, or entry number. Select
Proceed when you are finished.
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+ Select from the sent fax history: Select History to display the sent fax history. Select a recipient
from the list, select Menu, and select Send to this number.

Note: To delete entered recipients, select the Enter a Fax Number field, select the recipient you
want to delete, and select Delete from the List.

5. If you need to change any fax settings, select Menu, select Fax Send Settings, and select your
settings.

6. If you want to preview your fax in black-and-white on the LCD, select Preview. (If the preview looks
incorrect, select Retry, reposition the document or change the fax settings, and repeat this step.)

Note: If you do not touch the preview screen for 20 seconds, your product sends the fax
automatically. You cannot preview images when the Direct Send setting is turned on.

If you want to save your fax settings for later use, select Presets and add a new entry.
Press one of the < Start buttons.

Note: To cancel faxing, press the & Stop button. You can also cancel the job or check the job status
from the Status Menu.

Your product scans your original and prompts you to place additional pages, if necessary.
After scanning your originals, your product dials the number and sends the fax.

Note: Your product does not save sent color faxes to its memory. If the Save Failure Data option is
enabled, faxes that failed to be sent are stored to the product's memory and you can resend them from
the Status Menu screen.

Parent topic: Sending Faxes from the Product Control Panel
Fax Sending Options
While sending a fax, you can select Menu and select these options from the Fax Send Settings menu.

Note: You can also select these options in the User Default Settings menu.
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Setting Options Description
Resolution Standard Adjusts the scan resolution and print quality of
Fine outgoing faxes.
Super Fine
Ultra Fine
Photo
Density Auto Automatically adjusts the darkness of outgoing faxes.
Select this option when sending black-and-white text
documents.
Manual Lets you select from various density levels.
Document Size (Glass) |Half Letter Sets the size for a document placed on the scanner
A5 glass.
Letter
A4
ADF 2-Sided Off Select On to enable 2-sided faxing from the ADF. The
on Direct Send option and color faxing are disabled when
you turn on this setting.
Direct Send Off Select On to send black-and-white faxes to a single
on recipient as soon as the connection is made, without
saving the scanned image to memory. You cannot
use this setting when sending a color fax or sending a
fax to multiple recipients.
Priority Send Off Select On to send the current fax before other faxes
o waiting to be sent.
n
Continuous Scan from | Off Select On to have the product to ask if you want to
ADF on scan another page after a document in the ADF has

finished scanning.

Transmission Report

Print on Error

Print

Do Not Print

Lets you select when to print transmission reports.
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Parent topic: Sending Faxes from the Product Control Panel
Sending a Fax at a Specified Time
You can send a fax at a time of your choice.

Note: Make sure the product's date and time settings are correct. You can only send faxes in black-and-
white when you use this option.

1. Place your original on the product for faxing.

2. Pressthe M home button, if necessary.

3. Select Fax.
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Note: To fax a double-sided document, place your document in the ADF and turn on the ADF 2-
Sided setting.

4. Enter a fax number or select a number from the Contacts list or History.
5. Select Menu.

6. Select Send Fax Later.

7. Select On.

8

Select Time, use the displayed keypad on the LCD screen to enter your desired time, and select
OK.

9. Press one of the & Start buttons.

Note: To cancel faxing, press the & Stop button.
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After scanning your originals, your product dials the number and sends the fax at the specified time.
Note: If the product is turned off at the specified time, the fax is sent when it is powered on.

Parent topic: Sending Faxes from the Product Control Panel

Related references
Fax Sending Options

Related topics

Setting Up Contacts and Contact Groups

Placing Originals on the Product
Sending a Fax on Demand

You can store one scanned document (up to 100 black-and-white pages) and have it sent automatically
when another fax machine requests it. Other fax users can receive the document by calling your fax
number and using the polling receive function on their fax machines.

1. Place your original on the product for faxing.
2. Pressthe M home button, if necessary.
3. Select Fax.
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4. Select Menu.
5. Select Polling Send and select On.

6. If you need to change any fax settings, select Menu, select Fax Send Settings, and select your
settings.

7. Press the © B&W button.
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Your document is scanned and stored until you overwrite or delete it.

You can store only one document at a time. Subsequent documents overwrite the existing document.
You can also delete a stored document from the Status Menu.

Parent topic: Sending Faxes from the Product Control Panel

Related references
Fax Sending Options

Related topics
Placing Originals on the Product

Sending a Stored Fax

You can store one scanned document (up to 100 black-and-white pages) and send it whenever
necessary.

1. Place your original on the product for faxing.
2. Press the M home button, if necessary.
3. Select Fax.
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4. Select Menu.
5. Select Store Fax Data and select On.

6. If you need to change any fax settings, select Menu, select Fax Send Settings, and select your
settings.

7. Press the & B&W button.
Your document is scanned, stored, and briefly previewed.
8. When you are ready to send the document, press the { Status button.

249



You see a screen like this:
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9. Select Job Monitor.

10. Select Communication Job.

11. Select the stored fax job you want to send.
12. Select Send/View and select Send.

You can store only one document at a time. Subsequent documents overwrite the existing document.
You can also delete a stored document from the Status Menu.

Parent topic: Sending Faxes from the Product Control Panel

Related references
Fax Sending Options

Related topics
Placing Originals on the Product

Dialing Fax Numbers from a Connected Telephone

If you have connected a telephone to the EXT port on your product, you can send a fax by dialing the fax
number from the connected telephone. If the recipient's phone number and fax number are the same,
you can speak to the recipient before sending the fax.

1. Place your original on the product for faxing.
2. Press the M home button, if necessary.
3. Dial the fax number from the connected telephone. Speak to the recipient if necessary.

Note: If you are using a pre-paid calling card, enter the number and password required to use the
card before entering the destination fax number.
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4. Select Start Fax on the LCD screen.
5. Select Send.

Note: Your product now communicates with the recipient's fax machine. Do not hang up the
telephone.

6. When you hear a fax tone, press one of the & Start buttons to start sending the fax.

Note: If your recipient's fax machine does not print in color, your fax is automatically sent in black-
and-white.

7. Hang up the telephone.
Parent topic: Sending Faxes from the Product Control Panel

Related references
Fax Sending Options

Related topics
Placing Originals on the Product

Sending Faxes Using the Fax Utility - Windows

You can send a fax from a printing program in Windows. You can fax up to 100 pages at a time,
including a cover sheet.

1. Open the file you want to fax and select the print command.
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You see a window like this:

= Print i
Generd
Select Printer
FIEPSON ™ Microsoft Print to PDF
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Status Ready [Ofrritofie | Peferences
Locateon:
Commeani Fing Pringer...
Page Range
O Murber of copies: | 1
11 212 33
Cancel oy

Select your product with the FAX option as the printer.

To change the Paper Size, Orientation, Color, Image Quality, or Character Density settings, click the
Preferences or Properties button.

Note: If you see a Setup, Printer, or Options button, click it. Then click Preferences or Properties
on the next screen. For more information about selecting fax print settings, click Help.

Select the Page Range as necessary. (Leave the Number of copies setto 1.)
Click Print or OK.
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If you're faxing for the first time, you see a window like this one:

Erter Sender Information s

Nickname:
Hame:
Phone Number: Fax Murrier:

Address:

Cormpary)/ Corp.:

Diiemsian Titka:

0K Cancel |

6. Enter your sender information so that recipients can identify the origin of the fax. Then click OK to
save the sender information.
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You see a window like this:
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Enter the recipient's name and fax number or select a recipient from the phonebook, then click Next.
Note: For detailed instructions on using the Epson FAX Utility, click Help.

8. Select a cover sheet and enter a subject and message, then click Next.
9. Click Send to transmit your fax.

Parent topic: Sending Faxes

Sending Faxes Using the Fax Utility - OS X
You can send a fax from a OS X printing program using the FAX Utility. You can fax up to 100 pages at a
time, including a cover sheet.

1. Open the file you want to fax.
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Select the print command in your application.

Note: You may need to select a print icon on your screen, the Print option in the File menu, or
another command. See your application's help utility for details.

Printer: FAX

L3

Prasets: Default Settings

¥

Copies: 1

Pages: ‘=) All
From: 1 o 1

Paper Size: US Letter = | 8.50 by 11.00 inches

Orientation: | ] LS

Select your product FAX option as the Printer setting.

If necessary, click the arrow next to the Printer setting or the Show Details button to expand the
print window.

Select the number of pages you are faxing as the Pages setting.
Note: Leave the Copies setting set to 1.

Select Recipient Settings from the pop-up menu.
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You see this window:

¥

Recipient Settings

Recipient List:

Mame Compamy/Corp Fax Numboer
Add:
Mame:
Company/Corp.:
Fax Number:

A hyphen {-) is avallable only at the
beginning of the phone number because it
acts as a pause in dialing.

External Access Prefix:

Cance

Do one of the following to choose your recipient:
+ Select a name or group from the Recipient List.

* Enter a name, company, and fax number and click the + button.

» Click the E icon and select a recipient from your address book.

Select Fax Settings from the pop-up menu.
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You see this window:

Fax Settings

L4

Coler: (# Black & White
Color

image Quality: Photo -

Cance

9. Select the Color and Image Quality settings you want to use for your fax.
10. Click Fax.

Parent topic: Sending Faxes

Receiving Faxes

See these sections to receive faxes with your product.

Fax Reception

Receiving Faxes Automatically
Receiving Faxes Manually
Forwarding Received Faxes
Receiving a Fax by Polling
Viewing a Fax on the LCD Screen

Parent topic: Faxing

Fax Reception

Your product will automatically receive and print faxes when you set the Receive Mode to Auto.
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If you connected a telephone to your product so you can use the same phone line for faxes and voice
calls, you can also set your product to receive faxes manually. This allows you to check for a fax tone
using the telephone and press a button on your product to receive the fax.

Make sure to load paper in your product and select your fax settings before receiving a fax.

Note: If you run out of paper during fax printing, load more paper and press the button indicated on your
product's LCD screen to continue.

Parent topic: Receiving Faxes

Receiving Faxes Automatically

To receive faxes automatically, make sure Receive Mode is set to Auto (the default setting for the
product).

To change the Receive Mode if necessary, select Setup > System Administration > Fax Settings >
Receive Settings > Receive Mode.

If an answering machine is connected, make sure the product's Rings to Answer setting is set higher
than the number of rings your answering machine is set to answer a call. For example, if the answering
machine is set to pick up on the fourth ring, set the product to pick up on the fifth ring or later.

Parent topic: Receiving Faxes

Related concepts
Fax Reception

Related tasks
Receiving Faxes Manually

Receiving Faxes Manually

You can set up your product to receive faxes manually by setting the Receive Mode to Manual. This lets
you check for a fax tone on the connected telephone before receiving a fax.

1. To change the Receive Mode, select Setup > System Administration > Fax Settings > Receive
Settings > Receive Mode and select Manual.

When the connected telephone rings, answer the call.
If you hear a fax tone, select Start Fax on the LCD display.
Select Receive.

o &~ N

Press one of the & Start buttons to start receiving the fax.
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6. Hang up the telephone.
Parent topic: Receiving Faxes

Related concepts
Fax Reception

Related tasks
Receiving Faxes Automatically
Forwarding Received Faxes

You can forward received faxes to another fax machine, or convert the faxes into PDF documents and
forward them to a shared folder on the network or to an email address. Forwarded faxes are deleted
from the product's memory. Before using this feature, make sure the date and time are set correctly, the
forwarding destination is set up in the contact list, and the email server settings are configured.

Note: Color documents cannot be forwarded to another fax machine.

Note: This setting can be locked by an administrator. If you can't access or change this setting, contact
your administrator for assistance.

1. Press the M home button, if necessary.
2. Select Setup.
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3.

© o N o O bk

10.
11.
12.

13.
14.
15.
16.

Scroll down and select System Administration. Enter the administrator password, if necessary.
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Scroll down and select Fax Settings.
Select Output Settings.

Select Fax Output.

Select Settings.

Select Forward.

Select Yes.

Note: If you want to print the fax automatically before forwarding it, select Yes and Print.

Select Other Settings.
Select Where to Forward.
Select the forwarding destination from the contact list.

Note: Select View to sort your contacts by the printer's features. You can select up to 5 forwarding
destinations.

When you are finished selecting your forwarding destinations, select Proceed.
Confirm the displayed forwarding destinations are correct and select Close.
Select Options When Forwarding Failed.

Select the option you want to occur when received faxes fail to be forwarded; print the faxes or save
them in the printer's inbox.
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17. If you are forwarding to an email address, you can specify the subject by selecting Email Subject to

Forward.

Note: If you are forwarding faxes to a shared folder on the network or an email address, you can test
if fax forwarding was set up correctly by sending a scanned image to the destination using the scan
to email or scan to network folder/ftp option. If you are forwarding faxes to a shared folder on the
network, you can set up the FAX Utility to notify you whenever a new fax is received.

Parent topic: Receiving Faxes

Receiving a Fax by Polling

You can use polling to receive a fax from another fax machine (such as a fax information service).

Note: This procedure does not work if the fax information service includes audio guidance.

1.
2.

4.
5.
6.

Press the M home button, if necessary.
Select Fax.

You see a screen like this:
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Select Menu.

Select Polling Receive and select On.

Enter the fax number you expect to receive the fax from.
Press one of the & Start buttons to start receiving the fax.

Parent topic: Receiving Faxes
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Viewing a Fax on the LCD Screen
You can save received faxes in your product's memory and view them on the LCD screen.

Note: To use this feature, you must first enable Save to Inbox from the Output Settings menu. The Inbox
can be locked by an administrator. If you cannot access the Inbox, contact your administrator for
assistance.

1. Press the f home button, if necessary.

2. Check the (B | jcon on the LCD screen. It turns on if there are any unread or unprinted faxes in the
product's memory.

3. Select Fax.
Select Open Inbox. Enter the administrator password, if necessary.
5. Select the fax you want to view.
You see the fax displayed on the screen.
Select Menu.
Select one of the printing or deleting options, and follow the on-screen instructions.

Note: Delete faxes after you print or view them to prevent the product's memory from filling up. When the
memory is full, you can forward or print incoming faxes.

Parent topic: Receiving Faxes

Checking Fax Status

You can use the { Status button to check the status of current fax jobs, or faxes that have been received
or sent.

1. Press the i Status button.
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You see a screen like this:
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2. Do one of the following:

» To check the status of currrent fax jobs, select Job Monitor, select Communication Job, and
select the fax job you want to check.

» To check the history of faxes that have been sent or received, select Job History, select Receive
Job or Send Job, and select the job you want to check.

» To check received faxes that have been saved or temporarily saved in the product's memory,
select Job Storage and select Inbox.

Note: If you see a numbered icon on top of the Fax icon on your product's LCD screen, received
faxes have been temporarily saved to the product's memory.

Parent topic: Faxing

Printing Fax Reports

You can select from several fax reports to print whenever necessary. You can also have the fax log
printed automatically by turning on Fax Log Auto Print.

1. Press the M home button, if necessary.
2. Select Fax.
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You see a screen like this:
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3. Select Menu, select Fax Report, and select the report you want to print.
Fax Report Options
Parent topic: Faxing

Related references
Fax Report Options

Fax Report Options
Select the fax report or list you want to print.

Fax Settings List
Print a list of the current fax communication settings.

Fax Log
View or print a report on recent fax transmissions.

Last Transmission
Print a report on the previous fax that was sent or received through polling.

Stored Fax Documents
Print a list of the fax jobs currently stored in the product's memory.

Protocol Trace
Print a detailed report for the previous sent or received fax.

Parent topic: Printing Fax Reports
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Using an External Device with Your Product

Follow the instructions in these sections to use your product with an external device, such as a camera,
smartphone, or other device.

Connecting and Using a USB Flash Drive or External Device
Disconnecting a USB Device

Viewing and Printing From the LCD Screen

Transferring Files on a USB Device

Connecting and Using a USB Flash Drive or External Device

You can view and print files from a USB thumb drive or other external storage device, such as an
external hard drive. Before you connect your thumb drive or device, make sure the product is turned on
but not printing.

Note: Epson cannot guarantee the compatibility of your device. Make sure the files on the device are
compatible with the product.

1. Remove any memory cards from the product.

2. Insert your USB thumb drive or the USB cable that came with your device into the USB port on the
front of your product.

3. When you see a message that the device is recognized, select OK.

When you finish printing, make sure the access light on the drive is not flashing, then remove or
disconnect it from the product.

Caution: Do not remove the USB drive or turn off the product when the access light is flashing, or you
may lose photos on the drive.

USB Device Photo File Specifications
Parent topic: Using an External Device with Your Product

USB Device Photo File Specifications

You can use USB devices with your product containing files that meet these specifications.
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File format JPEG with the Exif version 2.3 standard

TIFF 6.0-compliant uncompressed images: RGB full-color or binary
(not CCITT-encoded)

PDF version 1.7-compliant

Image size 80 x 80 pixels to 10200 x 10200 pixels
File size Up to 2GB
Number of files JPEG: Up to 9990

TIFF: Up to 999
PDF: Up to 999

Parent topic: Connecting and Using a USB Flash Drive or External Device

Disconnecting a USB Device
After you finish working with a USB device, follow these steps to remove it.
1. If your product is connected to your computer using a USB cable, do one of the following:

* Windows: Open the My Computer, Computer, This PC, or Windows Explorer utility. Then
right-click the name of your USB device (listed as a removable disk) and select Eject.

» OS X: Drag the removable disk icon for your USB device from the desktop into the trash.

Caution: Do not remove a USB device before completing the procedure above or you may lose data
from the flash drive.

2. Pull the USB device out of the USB port on the front of the product.
Parent topic: Using an External Device with Your Product

Viewing and Printing From the LCD Screen
See these sections to view and print photos or other files displayed on your product's LCD screen.
Printing JPEG Photos
Printing TIFF Files
Printing PDF Files
Photo Adjustment Options - Device Mode
Print Setting Options - Device Mode
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Parent topic: Using an External Device with Your Product

Printing JPEG Photos

You can select JPEG photos for printing as you view them on the LCD screen.

1.

Press the M home button, if necessary.

2. Select Memory Device.
3. Select JPEG.

You see a screen like this:

-~ e
el [mages

™= U9

Setiings

Note: If you have more than 999 JPEG images on your device, the images are divided into groups,
and you must first select the group you want to display.

Do one of the following to select your photos:

» To select individual photos, select the thumbnail image of the photo you want to print, then use the
numeric keypad on the control panel or press + or — on the LCD screen to select the number of
copies (up to 99). Press the left or right arrow buttons to scroll through and select additional
photos, or press the 3 back button to return to the thumbnail image view and select another photo.

» To select all photos, select Options > Select Images > Select All Images.
» To select all photos, select Menu > Select All Images.

To adjust a photo (adjustments modify only your printed copy, not the original file), select its
thumbnail image, and select Adjustments. Make the necessary adjustments and press the 3 back
button.

To change the print settings, select Settings, and select the necessary settings. When you are
finished, press the 3 back button.
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7. When you are ready to print, press the & B&W button.

Note: To cancel printing, press the @ Stop button or select Cancel.

Parent topic: Viewing and Printing From the LCD Screen

Related references
Print Setting Options - Device Mode
Photo Adjustment Options - Device Mode

Printing TIFF Files

You can select and print files in the TIFF format from a USB flash drive or other device.

1.
2.
3.

Press the % home button, if necessary.
Select Memory Device.

Select TIFF.

You see a list of the available files.
Select the file you want to print.

You see information about the file.
Select Proceed.

Do the following as necessary:

» To print more than one copy, use the numeric keypad on the control panel or press + or — on the
LCD screen to select the number of copies (up to 99).

» To change the print settings, select Settings, and select the necessary settings. When you are
finished, press the 3 back button.

Select Proceed.
When you are ready to print, press the & B&W button.

Note: To cancel printing, press the @ Stop button or select Cancel.

Parent topic: Viewing and Printing From the LCD Screen

Printing PDF Files

You can select and print files in the PDF format from a USB flash drive or other device.
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Press the M home button, if necessary.

Select Memory Device.

3. Select PDF.
You see a list of the available files.

4. Select the file you want to print.

After the file is processed, you see the number of pages and other information.

5. Select Proceed.

6. Do the following as necessary:

» To print more than one copy, use the numeric keypad on the control panel or press + or — on the
LCD screen to select the number of copies (up to 99).

* To change the print settings, select Settings, and select the necessary settings. When you are

finished, press the 3 back button.

7. Select Proceed.

8. When you are ready to print, press the <> B&W button.

Note: To cancel printing, press the & Stop button or select Cancel.

Parent topic: Viewing and Printing From the LCD Screen

Photo Adjustment Options - Device Mode

Select the Image Adjustments you want to use when viewing and printing photos displayed on the LCD

screen.

Photo
adjustment
settings

Available options

Description

Fix Photo

On Automatically adjusts the brightness, contrast, and saturation
of the photo based on the Advanced > Scene Detection
setting that is selected

Off Turns off automatic adjustments; see Note below

P.I.M. Uses your camera's PRINT Image Matching or Exif Print

adjustments
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Photo Available options Description

adjustment

settings

Fix Red-Eye [ Off - This Image Automatically fixes the red-eye effect in photos
On - This Image
Off - All Image
On - All Image

Note: Fix Photo uses a sophisticated face recognition technology to optimize photos that include faces.
For this to work, both eyes and the nose must be visible in the subject's face. If your photo includes a
face with an intentional color cast, such as a statue, you may want to turn off Fix Photo to retain the
special color effects.

Parent topic: Viewing and Printing From the LCD Screen

Print Setting Options - Device Mode

Select the Print Settings you want to use when printing from a USB flash drive or other memory device.

Note: Not all options or settings may be available, depending on the file format.

Print settings Available options Description
Paper Source Various paper size Indicates the source that contains the paper size and type
and type settings you want to print on
Quality Standard Provides good quality for most prints
Best Provides the highest quality for special prints
Date Various date formats [ Prints the date the photo was taken on the photo in the
format you select
Fit Frame On Automatically crops the photo to fit into the selected photo
layout
Off Turns off automatic cropping
Bidirectional On Prints at normal speed
Off Slows down printing to improve print quality

270



Print settings Available options Description

Print Order Last Page on Top Select the order for printing multi-page TIFF files.

First Page on Top

Parent topic: Viewing and Printing From the LCD Screen

Transferring Files on a USB Device
You can transfer files to and from a USB device inserted into the USB port on the front of your product.

Setting Up File Sharing for File Transfers From Your Computer
Transferring Files from a USB Device to Your Computer

Parent topic: Using an External Device with Your Product

Related tasks
Disconnecting a USB Device
Connecting and Using a USB Flash Drive or External Device

Setting Up File Sharing for File Transfers From Your Computer

Before you transfer files from a computer to a USB flash drive inserted into the USB port on the front of
your product, you may need to set up your product's file sharing settings.

Caution: Remove the flash drive before you change this setting or you may lose data from the flash
drive.

Note: These settings can be locked by an administrator. If you cannot access these settings, contact
your administrator for assistance.

Press the % home button, if necessary.

Select Setup.

Scroll down and select System Administration. Enter the administrator password, if necessary.
Select Printer Settings.

ok~ wbdh -~

Select Memory Device Interface.
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You see a screen like this:

B} Memory Device Interface

venory Devee TS
————————————————————
Fio Starg e |

6. Make sure Memory Device is set to Enable.

7. Select File Sharing.

8. Select the way your computer is connected to the product: either USB or Wi-Fi/Network.
Parent topic: Transferring Files on a USB Device

Transferring Files from a USB Device to Your Computer

You can transfer files to and from a USB device inserted into the USB port on the front of your product
and a computer connected to your product.

Note: Do not transfer files to and from a USB device while you are printing from the device.

Make sure your product is connected to a computer.
Insert a USB device into the USB port on the front of your product.
3. Do one of the following to access your USB device files from your computer:

* Windows: Open the My Computer, Computer, This PC, or Windows Explorer utility, then
select the removable disk icon.

+ OS X with a USB connection: Look for the removable disk icon on your desktop, then select it.

+ 0OS X with a network connection: Select the hard drive icon on your desktop or select Computer
from the Go menu, select your product in the SHARED section of the sidebar (you may need to
widen the sidebar to see the name), and select the USBSTORAGE icon.

4. Select the folder that contains your files.
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5. Drag the files you want to transfer to the desired folder on your computer or on your USB device.

Note: Your product's LCD screen does not update to display new information about your USB device
after you copy files to it or delete files from it. Remove and insert the USB device to update the
information.

Parent topic: Transferring Files on a USB Device
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Replacing the Ink Cartridge and Maintenance Box

The maintenance box stores ink that gets flushed from the system during print head cleaning. When the
ink cartridge is expended or the maintenance box is at the end of its service life, you need to replace it.

You may also need to replace a cartridge that is more than six months old if your printouts do not look
their best, even after cleaning and aligning the print head.

Note: Please dispose of your used Epson branded ink cartridges and maintenance boxes responsibly
and in accordance with local requirements. If you would like to return your used ink cartridges and
maintenance boxes to Epson for proper disposal, please go to epson.com/recycle for more information.

Check Status of the Ink Cartridge and Maintenance Box
Purchase Epson Ink Cartridges and Maintenance Box
Removing and Installing the Ink Cartridge

Replacing the Maintenance Box

Check Status of the Ink Cartridge and Maintenance Box

Your product and its software will let you know when the ink cartridge is low or expended, or when the
maintenance box needs to be replaced.

Note: When using the Epson Universal Print Driver or PostScript (PS3) printer software with the product,
you can check ink cartridge and maintenance box status by using the printer buttons or the utilities
included with the standard Epson printer software. To download the standard Epson printer software, go
to epson.com/support/wfm5694downloads.

Checking Cartridge Status on the LCD Screen
Checking Cartridge and Maintenance Box Status with Windows
Checking Cartridge and Maintenance Box Status with OS X

Parent topic: Replacing the Ink Cartridge and Maintenance Box

Checking Cartridge Status on the LCD Screen

When your cartridge is low on ink, you see the icon on the LCD screen and the orange { Status light

flashes. When the cartridge is expended, you see the B¢ icon and the orange { Status light stays on.
You can use the { Status button check the status of the cartridge and maintenance box.

1. Press the i Status button.
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2. Select Printer Information.

You see a screen like this:

Feaity.

The ink and maintenance box levels are displayed at the bottom of the screen.

Note: The displayed ink and maintenance box levels are approximate.

3. For more information, select the images at the bottom of the screen.
Parent topic: Check Status of the Ink Cartridge and Maintenance Box

Checking Cartridge and Maintenance Box Status with Windows

A low ink reminder appears if you try to print when ink is low, and you can check your cartridge or
maintenance box status at any time using a utility on your Windows computer.

1. To check your status, access the Windows Desktop, double-click the product icon in the Windows
taskbar, and click Details.
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You see this window:

" EPS0M Status Monitor 3 —
EPSON “*
14 -7 dy to it
ready to pr e
E J
Drine Support
Ink Lewe
Black
e
Information
Maintenance Box Service Life
W
T&71
Print Queue - S

Replace or reinstall the maintenance box or ink cartridge as indicated on the screen.

Note: If the cartridge installed in the product is broken, incompatible with the product model, or
improperly installed, Epson Status Monitor will not display an accurate cartridge status.

To disable the low ink reminder, right-click the product icon in the Windows taskbar and select
Monitoring Preferences.
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You see this window:

Monitoning Preferences : EPSON >
Select Notification
Event Screen Motification 3
& Errar on
O Communication Error Off
& Printer Selection Errar on
O ink Low Off W
] simple status notification Default
Select Shortout Icon

] Register the shortout icon to the taskbar

Diouble-dicking the Shortout Ioon
opens the Printer Status Window.

] Allow monitoring of shared printers

[/] Display Epson Offers

[]Share my usage information with Epson

5] | oo =

4. Deselect the See Low Ink Reminder alerts checkbox at the bottom of the screen.

5. To disable promotional offers, deselect the Display Epson Offers checkbox.
6. Click OK.

Parent topic: Check Status of the Ink Cartridge and Maintenance Box
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Checking Cartridge and Maintenance Box Status with OS X
You can check the status of your ink cartridge and maintenance box using a utility on your Mac.

1. Inthe Apple menu or the Dock, select System Preferences. Select Print & Fax, Print & Scan, or
Printers & Scanners, select your product, and select Options & Supplies. Select Utility and select
Open Printer Utility.

2. Select EPSON Status Monitor.
You see this window:

Epson Printer Utility 4

EPSON evsox

% EPSON Status Monitor

me Lowve

BICE
THEXL

Maintenance Bax Service Life

Update | gl

3. Do the following as necessary:
* You can update the ink cartridge and maintenance box status by clicking Update.
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* Replace or reinstall the maintenance box or ink cartridge as indicated on the screen.

Note: If the cartridge installed in the product is broken, incompatible with the product model, or
improperly installed, Epson Status Monitor will not display an accurate cartridge status.

Parent topic: Check Status of the Ink Cartridge and Maintenance Box

Purchase Epson Ink Cartridges and Maintenance Box

You can purchase genuine Epson ink, maintenance boxes, and paper at epson.com/ink3 (U.S. sales) or
epson.ca (Canadian sales). You can also purchase supplies from an Epson authorized reseller. To find
the nearest one, call 800-GO-EPSON (800-463-7766).

Note: This product uses only genuine Epson-brand cartridges. Other brands of ink cartridges and ink
supplies are not compatible and, even if described as compatible, may not function properly.

The cartridge included with the printer is designed for printer setup and not for resale. After some ink is
used for charging, the rest is available for printing. Yields vary considerably based on images printed,
print settings, paper type, frequency of use, and temperature. For print quality, a variable amount of ink
remains in the cartridge after the "replace cartridge" indicator comes on.

Ink Cartridge and Maintenance Box Part Numbers
Parent topic: Replacing the Ink Cartridge and Maintenance Box

Ink Cartridge and Maintenance Box Part Numbers

Use these part numbers when you order or purchase a new ink cartridge or maintenance box.
Maintenance box part number: T6710
Ink cartridge: Black 792XL High-capacity

Note: For best printing results, use up a cartridge within 6 months of opening the package.
Parent topic: Purchase Epson Ink Cartridges and Maintenance Box

Removing and Installing the Ink Cartridge

Make sure you have your replacement cartridge handy before you begin. You must install the new
cartridge immediately after removing the old one.
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Caution: Leave your old cartridge in the printer until you are ready to replace it to prevent the print head
nozzles from drying out. Do not open ink cartridge package until you are ready to install the ink. The
cartridge is vacuum packed to maintain reliability.

Turn on your product.

2. Ifthe ink cartridge is low or expended, a message appears on your product and on your computer
screen.

3. Open the front cover.
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4. Push the ink cartridge in, then pull it out of the slot.

= N
\

Note: Dispose of used cartridges carefully. Do not take the used cartridge apart or try to refill it.
Warning: If ink gets on your skin, wash it thoroughly with soap and water. If ink gets into your eyes,

flush them immediately with water. If ink gets into your mouth, spit it out and see a doctor right away.
Keep ink cartridges out of the reach of children.
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5. Remove the cartridge from the package.

\

S
D 1"!'

Caution: Do not touch the green chip on the cartridge. Install the new cartridge immediately after
removing the old one; if you do not, the print head may dry out and be unable to print.

6. Gently shake the ink cartridge horizontally for about five seconds as shown.

(;/‘)

[

Caution: Do not remove any labels or seals, or ink will leak.
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7. Insert the new cartridge into the holder and push it in until it clicks into place.

8. Select Check on the LCD screen to make sure the cartridge is installed correctly.

Caution: If you see a message that the ink cartridge is installed incorrectly, press in the ink cartridge
until it clicks into place.

9. When you are finished, close the front cover.

The product starts charging the ink and returns to its previous state when finished.
Note: Do not turn off the printer during ink replacement.

Caution: If you remove an ink cartridge for later use, protect the ink supply area from dirt and dust and
store it in the same environment as the printer. The valve in the ink supply port is designed to contain
any excess ink, but do not touch the ink supply port or surrounding area. Always store ink cartridges with
the label facing up; do not store cartridges upside-down.
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Parent topic: Replacing the Ink Cartridge and Maintenance Box

Related concepts
Purchase Epson Ink Cartridges and Maintenance Box

Replacing the Maintenance Box
Make sure you have a new maintenance box before you begin.

Caution: Do not reuse a maintenance box that has been removed and left uninstalled for more than a
week. Keep the maintenance box away from direct sunlight.

1.  Make sure the product is not printing.
2. Remove the new maintenance box from its package.

Caution: Do not touch the green chip on the maintenance box.

3. Press the buttons on the sides of the rear cover and remove it.
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4.

6.

Grasp the maintenance box as shown and pull it out of its holder.

Note: Do not tilt the used maintenance box or take it apart.

Warning: If ink gets on your skin, wash it thoroughly with soap and water. If ink gets into your eyes,
flush them immediately with water. If ink gets into your mouth, spit it out and see a doctor right away.
Keep the maintenance box out of the reach of children and do not drink the ink.

Place the used maintenance box in the plastic bag that came with the new maintenance box. Seal
the bag and dispose of it carefully.

Insert the new maintenance box into the holder and push it all the way in.
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7. Press the buttons on the sides of the rear cover and reattach it.

Parent topic: Replacing the Ink Cartridge and Maintenance Box

Related concepts
Purchase Epson Ink Cartridges and Maintenance Box
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Adjusting Print Quality

If your print quality declines, you may need to run a utility to clean or align the print head.

Note: When using the Epson Universal Print Driver or PostScript (PS3) printer software with the product,
you can clean and align the print head and run a nozzle check by using the printer buttons or the utilities

included with the standard Epson printer software. To download the standard Epson printer software, go
to epson.com/support/wfm5694downloads.

If running these utilities does not solve the problem, you may need to replace the ink cartridge.

Print Head Maintenance
Print Head Alignment
Cleaning the Paper Guide

Print Head Maintenance

If your printouts become too light, or you see dark or light bands across them, you may need to clean the
print head nozzles. Cleaning uses ink, so clean the nozzles only if print quality declines.

You can check for clogged nozzles before you clean them so you don’t clean them unnecessarily.

Note: You cannot clean the print head if the ink cartridge is expended, and may not be able to clean it
when the cartridge is low. You must replace the cartridge first.

Print Head Nozzle Check
Print Head Cleaning

Parent topic: Adjusting Print Quality

Related topics
Replacing the Ink Cartridge and Maintenance Box

Print Head Nozzle Check
You can print a nozzle check pattern to check for clogged nozzles.

Checking the Nozzles Using the Product Control Panel
Checking the Nozzles Using a Computer Utility

Parent topic: Print Head Maintenance
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Checking the Nozzles Using the Product Control Panel
You can check the print head nozzles using the control panel on your product.
1. Make sure there are no errors on the LCD screen and plain paper is loaded in the product.
2. Press the M home button, if necessary.
3. Select Setup.
4. Select Maintenance.

You see a screen like this:

=1 Makntenance

;' Print Head Nozzle Check |

———
Print Head Cleaning |
| [
Print Head Allgnmend |
|

|
I Thick Paper I

- |
Paper Guide Cleaning |

5. Select Print Head Nozzle Check.
You see a screen like this:

'ﬁ Frint Head Hozzle Lheck

Lowad Letierffid sizp
Plein Paper

to print
nozzie cheok patiem
Press & .

6. Pressthe & Color button.
The nozzle pattern prints.
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Check the printed pattern to see if there are gaps in the lines.
Print head is clean

Print head needs cleaning

Do one of the following:
+ If there are no gaps, select Done.
* If there are gaps or the pattern is faint, select Clean the Print Head and continue.
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9. Follow the instructions on the screen to clean the print head, check the nozzles, and repeat the
process as necessary.

If you don’t see any improvement after cleaning the print head up to 4 times, turn the product off and wait
at least 6 hours. Then try cleaning the print head again. If quality still does not improve, contact Epson.

Parent topic: Print Head Nozzle Check

Related concepts
Print Head Cleaning

Related tasks
Removing and Installing the Ink Cartridge

Related topics
Loading Paper

Checking the Nozzles Using a Computer Utility
You can check the print head nozzles using a utility on your Windows or Mac computer.
1. Make sure there are no errors on the LCD screen.
2. Load a few sheets of plain paper in the product.
3. Do one of the following:
* Windows: Access the Windows Desktop and right-click the product icon in the Windows taskbar.

* OS X: In the Apple menu or the Dock, select System Preferences. Select Print & Fax, Print &
Scan, or Printers & Scanners, select your product, and select Options & Supplies. Select
Utility and select Open Printer Utility.

4. Select Nozzle Check.
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You see a window like this:

Eal MNozzle Check

To parform & nozde chack, make sure that the printer is on and
connected to the computer, Also make sure that A4 or Letter size plain
paper is loaded in the rear paper feed or the paper cassette. Click
[Print] to print & noezle chedk pattern or dick [Cancel] to quit,

5. Click Print.
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6. Check the printed pattern to see if there are gaps in the lines.
Print head is clean

Print head needs cleaning

7. |Ifthere are no gaps, click Finish.
If there are gaps or the pattern is faint, clean the print head.
Parent topic: Print Head Nozzle Check
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Related concepts
Print Head Cleaning

Related tasks
Removing and Installing the Ink Cartridge

Related topics
Loading Paper

Print Head Cleaning

If print quality has declined and the nozzle check pattern indicates clogged nozzles, you can clean the
print head.

Note: You cannot clean the print head if the ink cartridge is expended, and may not be able to clean it
when the cartridge is low. You must replace the cartridge first.

Cleaning the Print Head Using the Product Control Panel
Cleaning the Print Head Using a Computer Utility

Parent topic: Print Head Maintenance

Related tasks
Removing and Installing the Ink Cartridge

Cleaning the Print Head Using the Product Control Panel
You can clean the print head using the control panel on your product.
1. Make sure there are no errors on the LCD screen and plain paper is loaded in the product.
2. Pressthe M home button, if necessary.
3. Select Setup.
4. Select Maintenance.
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You see a screen like this:

=1 Makntenance

[ Print Head Nozzle Check |

| Print Head Cleaning |
! Print Head Allgnmen |

I Thick Paper I

.. Paper Guide Cleaning

5. Select Print Head Cleaning.
You see a screen like this:

#=1 Print Head Cleaning

Cear 1 priod Bend to correct miasing dals,
Press B .

6. Pressthe & B&W button to clean the print head.

When the cleaning cycle is finished, you see a message on the screen.
Caution: Never turn off the product during a cleaning cycle or you may damage it.

7. Select Print Nozzle Check Pattern.
8. Pressthe & B&W button to confirm that the print head is clean.
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9. Check the printed pattern to see if there are gaps in the lines.
Print head is clean

Print head needs cleaning

+ If there are no gaps, select Done.

+ If there are gaps or the pattern is faint, select Clean the Print Head to run the cleaning cycle
again.

If you don’t see any improvement after cleaning the print head up to 4 times, turn the product off and wait
at least 6 hours. Then try cleaning the print head again. If quality still does not improve, contact Epson.
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Parent topic: Print Head Cleaning

Related tasks

Cleaning the Print Head Using a Computer Utility
Removing and Installing the Ink Cartridge

Checking the Nozzles Using the Product Control Panel

Cleaning the Print Head Using a Computer Utility
You can clean the print head using a utility on your Windows or Mac computer.
1. Make sure there are no errors on the LCD screen.
2. Load a few sheets of plain paper in the product.
3. Do one of the following:
* Windows: Access the Windows Desktop and right-click the product icon in the Windows taskbar.

+ OS X: In the Apple menu or the Dock, select System Preferences. Select Print & Fax, Print &
Scan, or Printers & Scanners, select your product, and select Options & Supplies. Select
Utility and select Open Printer Utility.

4. Select Head Cleaning.
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You see a window like this:

# Head Cleaning b4

\&- Click [Start] to dean the print hesd nozdes. Because deaning
consumes some ink, only cean the print head when faint ansas or
gaps appear in your primtout, Use the MNozzle Chedk” utiity first to
confirm that the print head needs to be deaned. If the ink & low or
expended, replace the cartridge first,

-

5. Click Start to begin the cleaning cycle.

The O power light flashes throughout the cleaning cycle and stays on when the cleaning cycle is
finished.

Note: Do not open the front cover during the cleaning cycle.

6. When the cleaning cycle is finished, you can check to see if the nozzles are clean; click Print Nozzle
Check Pattern and click Print.
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7. Check the printed pattern to see if there are gaps in the lines.
Print head is clean

Print head needs cleaning

+ If there are no gaps, click Finish.
« If there are gaps or the pattern is faint, click Clean to clean the print head again.

If you don’t see any improvement after cleaning the print head up to 4 times, turn off the product and wait
at least 6 hours. Then try cleaning the print head again. If quality still does not improve, the ink cartridge
may be old or damaged and needs to be replaced.
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Parent topic: Print Head Cleaning

Related tasks

Checking the Nozzles Using the Product Control Panel
Removing and Installing the Ink Cartridge

Cleaning the Print Head Using a Computer Utility

Print Head Alignment

If your printouts become grainy or blurry, you notice misalignment of vertical lines, or you see dark or
light horizontal bands, you may need to align the print head.

Note: Banding may also occur if your print head nozzles need cleaning.

Aligning the Print Head Using the Product Control Panel
Aligning the Print Head Using a Computer Utility
Making Precise Alignment Adjustments

Parent topic: Adjusting Print Quality
Aligning the Print Head Using the Product Control Panel

You can align the print head using the control panel on your product.
1. Make sure there are no errors on the LCD screen and plain paper is loaded.
2. Press the M home button, if necessary.
3. Select Setup.
4. Select Maintenance.
You see a screen like this:

o Martenance

' Print Head Nozzle Check |

Prink Head Cleaning |

Print Head Allgnmend |

Thick Paper I

. Paper Guide Cleaning
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5. Select Print Head Alignment.
You see a screen like this:

=1 Print Head Allgnment

ucdtcesirwen |
erte et |

Fuded Line Alignment

Vertical Alignmerit

Horizontal Allgnment |

6. Do one of the following:
« If text and lines are misaligned, select Ruled Line Alignment, and press the < B&W button.
« If your printouts look blurry or vertical lines are misaligned, select Vertical Alignment.
* If you see horizontal bands at regular intervals, select Horizontal Alignment.

7. Follow the on-screen instructions to print an alignment sheet.

Note: Do not cancel printing while you are printing head alignment patterns.

8. Check the printed patterns on the alignment sheet and do one of the following:

+ If you printed a ruled line alignment sheet, select the number representing the pattern with the
least misaligned vertical line.
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 If you printed a vertical alignment sheet, select the number representing the most solid printed
pattern for each set on the LCD screen, then select Done.

I@II
1 3 4

« If you printed a horizontal alignment sheet, select the number representing the pattern with the
least amount of separation or overlap on the LCD screen, then select Done.

#1

1

n

Parent topic: Print Head Alignment

Aligning the Print Head Using a Computer Utility
You can align the print head using a utility on your Windows computer or Mac.
1. Make sure there are no errors on the LCD screen.
2. Load afew sheets of plain paper in Cassette 1.
3. Do one of the following:
* Windows: Access the Windows Desktop and right-click the product icon in the Windows taskbar.

+ OS X: In the Apple menu or the Dock, select System Preferences. Select Print & Fax or Print &
Scan, select your product, and select Options & Supplies. Select Utility and select Open
Printer Utility.

4. Select Print Head Alignment.
5. Click Next, then click Print to print a vertical alignment sheet.

Note: Do not cancel printing while you are printing a head alignment pattern.
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You see a window like this:

el Print Head Alignment X

Look at the algnment sheet.

hpA Find the sguare without any visble bands in sefs = 1. S=lect the number
that corresponds to that square from the list below for all sets. Then dide
[Mext =],
If every square contains a band, select the square with the thinnest
band or bands. Then dick [Realignment].

Realignment Cancel Mext =

6. Check the printed pattern and follow the instructions on the screen to choose the number
representing the best printed pattern for each set.

+ After choosing each pattern number, click Next.

+ If no patterns are aligned in one or more of the sets, choose the closest one in each set and click
Realignment. Then print another alignment sheet and check it.

Note: Click Skip (where available) if you want to skip a particular alignment sheet.

7. When you are done, click Finish.
Parent topic: Print Head Alignment
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Making Precise Alignment Adjustments

If you still notice dark or light bands in your printouts after running the print head alignment, you can
make precise alignment adjustments.

1. Make sure there are no errors on the LCD screen.
Load a few sheets of plain paper in the product.
Press the M home button, if necessary.

Select Setup.

A S A

Select Maintenance.
You see a screen like this:

=1 Malntenance

[ Print Head Nozzle Check |

| Print Head Cleaning |
! Print Head Allgnmen |

I Thick Paper I

.. Paper Guide Cleaning

6. Select Improve Horizontal Streaks.
7. Select Proceed.
Do one of the following:
* Increase the setting to reduce dark bands in your printouts.
* Decrease the setting to reduce light bands in your printouts.
9. Select OK.
Parent topic: Print Head Alignment

Cleaning the Paper Guide
If you see ink on the back of a printout, you can clean the paper guide rollers to remove any excess ink.
1. Make sure there are no errors on the LCD.
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2. Load a sheet of plain paper in the product.
3. Press the f home button, if necessary.
4. Select Setup.
5. Select Maintenance.
You see a screen like this:
Y |
' Print Head Hozsle Check |
Print Head Cleaning |
Print Head Alignmend |
Thick Faper I
. Paper Guide Cleaning
6. Scroll down and select Paper Guide Cleaning.
7. Select the paper source to clean.
8. Follow the instructions on the screen and press the & B&W button.
9. Check the back of the ejected paper to see if it is clean.
10. Repeat as necessary until the paper comes out clean.

Note: If the paper comes out stained even after several cleaning attempts, try cleaning the other
paper sources.

Parent topic: Adjusting Print Quality
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Cleaning and Transporting Your Product

See these sections if you need to clean or transport your product.

Cleaning Your Product
Transporting Your Product

Cleaning Your Product

To keep your product working at its best, you should clean it several times a year.

Note: Close the rear paper feed slot and the output tray when you are not using the product to protect it
from dust.

Caution: Do not use a hard brush, alcohol, or paint thinner to clean the product or you may damage it.
Do not use oil or other lubricants inside the product or let water get inside it.

Turn off the product.
Unplug the power cable.
Disconnect any connected cables.

o nh =~

Remove all the paper from the product.
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5. Clean the scanner glass and the glass area on the left with a soft, lint-free cloth (microfiber is
recommended) moistened with a little glass cleaner.

Caution: Do not spray glass cleaner directly on the glass and do not press the glass surface with
any force.

Note: If lines appear on the printout or in scanned images, carefully clean the glass area on the left.

6. Open the ADF cover and use a soft, dry, lint-free cloth (microfiber is recommended) to clean the
rollers and the interior of the ADF.

7. Clean the outer case and control panel with a soft, dry cloth. Do not use liquid or chemical cleansers.
Parent topic: Cleaning and Transporting Your Product
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Transporting Your Product

If you need to store your product or transport it a long distance, prepare it for transportation as described
here.

Caution: During transportation and storage, follow these guidelines:
* Avoid tilting the product, placing it vertically, or turning it upside down; otherwise ink may leak.

» Leave the ink cartridges installed. Removing the cartridges can dry out the print head and may prevent
the product from printing.

Note: Before storing your product for a long period, replace low, expended, or expired ink to help
prevent the print head from drying out. Store your product in a cool, dry place.

Turn off the product.
Remove all the paper from the product.
Unplug the power cable.

Disconnect any connected cables.
Close the rear paper feeder and the output tray.

o g bk w0~

Place the product in its original packing materials, if possible, or use equivalent materials with
cushioning around the product. Make sure the box adequately protects the product control panel.

Keep the product level during transportation. If print quality has declined when you print again, clean and
align the print head.

Parent topic: Cleaning and Transporting Your Product

Related concepts
Print Head Cleaning
Print Head Alignment
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Solving Problems

Check these sections for solutions to problems you may have using your product.

Product Status Messages

Status Menu Error Codes

Running a Product Check

Resetting Control Panel Defaults

Solving Setup Problems

Solving Network Problems

Solving Copying Problems

Solving Paper Problems

Solving PCL/PostScript Problems

Solving Problems Printing from a Computer
Solving Page Layout and Content Problems
Solving Print Quality Problems

Solving Scanning Problems

Solving Scanned Image Quality Problems
Solving Faxing Problems

Uninstall Your Product Software

Where to Get Help

Product Status Messages

You can often diagnose problems with your product by checking the messages on its LCD screen. You
can also check for errors by pressing the i Status button to display the Status Menu.

Note: If the screen is dark, press the screen to wake the product from sleep mode.

LCD screen message Condition/solution

Printer error. Turn the power off and | Turn the product off and then back on again. If the error
on again. continues, check for a paper jam. If there is no paper jam,
contact Epson for support.

You need to replace the following ink | Replace the ink cartridge.
cartridge.
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LCD screen message

Condition/solution

No dial tone detected.

Make sure the phone cable is connected correctly and the
phone line works. If you connected the product to a PBX (Private
Branch Exchange) phone line or Terminal Adapter, change the
Line Type setting to PBX. If you still cannot send a fax, turn off
the Dial Tone Detection setting. (Turning off the Dial Tone
Detection setting may cause the product to drop the first digit of
a fax number.)

Failed to receive faxes because the
fax data capacity is full. Press
{ Status

Received faxes may not be processed. Check the following:
» Cannot print because of a printer error.

Press the i Status button, then select Printer Information.
+ Cannot save the fax in the computer or memory device.

Check whether the faxes have been saved by pressing the

i Status button, then select Job Monitor > Communication
Job. Make sure you computer is turn on or the memory device
is connected to the product.

Combination of IP address and
subnet mask is invalid.

There is a problem with the network connection to your product.

Recovery mode

An error has occurred during firmware updating. Connect your
product using a USB cable and try downloading the Firmware
Update from the Epson support site. If you still need help,
contact Epson for support.

Note: The ink pads in the printer collect, distribute, and contain the ink that is not used on printed pages.
During the life of your product it may reach a condition where either satisfactory print quality cannot be
maintained or the ink pads have reached the end of their usable life. The Epson Status Monitor, your
LCD screen, or lights on the control panel will advise you when these parts need replacing. If this
happens during the standard warranty of the product, the exchange of the product or replacement of the
pads is covered under the standard warranty. If the product is out of warranty, the pads can be replaced
by any Epson authorized service provider. The waste ink pads are not a user-replaceable part.

Parent topic: Solving Problems
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Status Menu Error Codes

If a job does not complete successfully, you can check the error code. Press the i Status button, then
select Job History and locate the incomplete job. Select the job to display the error code and additional

information.

Code

Condition/solution

001

The product was turned off by a power failure.

101

Memory is full. Reduce the size of the print job.

102

Collated printing has failed due to a lack of available memory. Reduce the size of the print
job or print one copy at a time.

103

Print quality was decreased due to a lack of available memory. If the quality of the printout
is unacceptable, try simplifying the page by reducing the number of graphics or the
number and size of the fonts.

104

Reverse printing has failed due to a lack of available memory. Reduce the data size of the
print job.

106

Cannot print from the computer due to the access control settings. Contact your printer
administrator.

107

User authentication failed and the job has been canceled. Contact your printer
administrator.

108

Confidential job data was deleted when the product was turned off.

109

The received fax was already deleted.

110

The job was printed 1-sided because the loaded paper does not support 2-sided printing.

111

Short of available memory. Reduce the size of the print job.

201

The product's memory is full.

You can send pages individually, or print received faxes and delete them to free up
memory space.

202

The line was disconnected by the recipient's fax machine. Wait a moment, then try again.
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Code

Condition/solution

203 The product cannot detect a dial tone.
Make sure the phone cable is connected correctly and the phone line works. If you
connected the product to a PBX (Private Branch Exchange) phone line or Terminal
Adapter, change the Line Type setting to PBX. If you still cannot send a fax, turn off the
Dial Tone Detection setting. (Turning off the Dial Tone Detection setting may cause the
product to drop the first digit of a fax number.)

204 The recipient's fax machine is busy. Wait a moment, then try again.

205 The recipient's fax machine does not answer. Wait a moment, then try again.

206 The phone cable is incorrectly connected to the product's LINE and EXT ports. Connect
the phone cable correctly.

207 The phone cable is not connected. Connect the phone cable.

208 The fax could not be sent to some of the specified recipients.
Print a fax log to check which recipients failed to receive the fax. If the Save Failure Data
setting is turned on, you can resend a fax from Job Monitor in the Status Menu.

301 There is not enough storage space available on the external memory device. Clear space

401 on the device or use a different device.

302 The external memory device is write-protected. Disable write protection.

402

303 No folder is available for saving the scanned file. Create a folder or use a different
memory device.

304 The external memory device has been removed. Reinsert the device.

404

305 An error occurred while saving data to an external memory device. Reinsert the memory
device or use a different device.

405

306 The product's memory is full. Wait until current jobs are finished processing.

311 A DNS error has occurred. Check the DNS settings for the server, computer, or access

391 point. DNS settings for the server can be checked from the DNS Server option in the
Setup menu.

411

421
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Code

Condition/solution

312 An authentication error has occurred. Check the Server Settings from the Setup menu.

412

313 A communication error has occurred. Check the Server Settings or network connection by

413 running a connection check. If you selected Off as the authentication method, make sure
to select None for the email server authentication method.

314 The data size exceeds the maximum size for the attached files. Increase the Attached
File Max Size setting in the scan settings or lower the file size of the scanned image.

315 The memory is full. Retry after other ongoing jobs have finished.

327

322 An authentication error occurred. Check the Location settings.

323 A communication error has occurred. Check the Location settings or the network
connection.

324 A file with the same name already exists in the specified folder. Delete the duplicate file or
change the file name prefix in File Settings.

325 There is not enough storage space available in the specified folder. Increase the storage

401 space in the specified folder, delete unnecessary files, or reduce the file size of the
scanned image.

328 The destination was wrong or the destination does not exist. Check the Location
settings.

331 A communication error occurred while acquiring the destination list. Make sure the
product is connected to the network correctly.

332 There is not enough space available for saving the scanned files in the specified folder.

333 The destination could not be found because the destination information was uploaded to
the server before sending the scanned data. Select the destination again.

334 An error occurred while sending the scanned data.

341 A communication error has occurred. Make sure the product is connected to the computer
or network correctly. Make sure you have installed Document Capture Pro or Document
Capture. Make sure the Event Manager program is not being blocked by your firewall or
security software.

402 The memory device is write-protected. Disable write protection on the memory device.

312




Code

Condition/solution

422

An authentication error has occurred. Make sure the settings are correct for the folder
selected in the Where to Forward setting in the Setup menu.

423

A communication error has occurred. It is also possible that a file with the same name is
open or the file is a read-only file.

Check the network connection, make sure the settings are correct for the folder selected
in the Where to Forward setting in the Setup menu, close the duplicate file, or disable
read-only protection.

425

There is not enough storage space available in the forwarding destination folder. Increase
the storage space in the destination folder.

428

The destination was wrong or the destination does not exist. Make sure the settings are
correct for the folder selected in the Where to Forward setting in the Setup menu.

Parent topic:

Solving Problems

Running a Product Check

Running a product check helps you determine if your product is operating properly.

1. Disconnect any interface cables connected to your product.

Press the

o &~ N

Load plain paper in the product.

A home button, if necessary.

Select Setup.
Select Maintenance.

You see a screen like this:

i=§ Maltenance

| Print Head Hogzk Check |

l |
Frint Head Cleaning |
[ |

| Print Head Allgnmend |

II

I Thick Paper

k |
Paper Guide Cleaning |
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6. Select Print Head Nozzle Check.
You see a screen like this:

=4 Print Head Hozzke Check

Load Letierdfd size
Plein Paper

to print

nozzie check patiem
Press HF .

7. Pressthe O B&W button.
The nozzle pattern prints.
8. Do one of the following, depending on the results of the product check:

 If the page prints and the nozzle check pattern is complete, the product is operating properly. Any
operation problem you may have could be caused by your computer, cable, software, or selected
settings. Check the other solutions in this book or try uninstalling and reinstalling your printer
software.

« If the page prints but the nozzle check pattern has gaps, clean or align the print head.

+ If the page does not print, the product may have a problem. Check the other solutions in this
manual. If they do not work, contact Epson.

Parent topic: Solving Problems

Related concepts

Print Head Cleaning

Print Head Alignment

Uninstall Your Product Software

Related references
Where to Get Help
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Resetting Control Panel Defaults

If you have a problem with settings on the product control panel, you can reset them to their factory
defaults. You can choose which settings to reset or reset them all.

Note: This setting can be locked by an administrator. If you cannot access or change this setting,
contact your administrator for assistance.

1. Press the M home button, if necessary.
2. Select Setup.
3. Scroll down and select System Administration. Enter the administrator password, if necessary.
4. Scroll down and select Restore Default Settings.
You see a screen like this:

B Restors Default Settings

'ﬁ'i-ru'H:l‘rr-:rk Hellings

ﬁ]ﬂ!.l Sedtings ||
S::an Selthn;

Fm: Seftings Il

|?
| Clear A Dt o Settings |

5. Select one of these options:
* Wi-Fi/Network Settings: Resets all network settings.
+ Copy Settings: Resets all settings for copying.
» Scan Settings: Resets all settings for scanning.
+ Fax Settings: Resets all settings for faxing.

» Clear All Data and Settings: Resets all control panel settings to their defaults and deletes the
contacts list.

You see a confirmation screen.
6. Select Yes to reset the selected settings. (Select No if you want to cancel the operation.)
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Parent topic: Solving Problems

Solving Setup Problems

Check these sections if you have problems while setting up your product.

Noise After Ink Installation
Software Installation Problems

Parent topic: Solving Problems

Noise After Ink Installation
If you hear noises from your product after installing ink, check the following:

» The first time you install the ink cartridges, the product must charge its print head. Wait until charging
finishes before you turn off the product, or it may charge improperly and use excess ink the next time
you turn it on.

« If the product's print head stops moving or making noise, and the charging process has not finished
after approximately 5 minutes, turn off your product. Turn it back on and check to see if charging is still
in progress. If it is still in progress, contact Epson for help.

Parent topic: Solving Setup Problems

Software Installation Problems
If you have problems while installing your product software, try these solutions:

» Make sure your product is turned on and any necessary cables are securely connected at both ends. If
you still have problems installing software, disconnect the cable and carefully follow the instructions on
the Start Here sheet. Also make sure your system meets the requirements for your operating system.

» Close any other programs, including screen savers and virus protection software, and install your
product software again.

* In Windows, make sure your product is selected as the default printer and the correct port is shown in
the printer properties.

 If you see any error message or your software does not install correctly in Windows, you may not have
software installation privileges. Contact your System Administrator.

Parent topic: Solving Setup Problems

Related concepts
Uninstall Your Product Software
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Related references
Windows System Requirements
OS X System Requirements

Solving Network Problems
Check these solutions if you have problems setting up or using your product on a network.

Note: Breakdown or repair of this product may cause loss of fax and network data and settings. Epson is
not responsible for backing up or recovering data and settings during or after the warranty period. We
recommend that you make your own backup or print out your fax and network data and settings.

Product Cannot Connect to a Wireless Router or Access Point
Network Software Cannot Find Product on a Network

Product Does Not Appear in OS X Printer Window

Cannot Print Over a Network

Cannot Scan Over a Network

Parent topic: Solving Problems

Product Cannot Connect to a Wireless Router or Access Point
If your product has trouble finding or connecting to a wireless router or access point, try these solutions:

* If you are connecting the product via Wi-Fi Protected Setup (WPS) and the Wi-Fi icon on your
product's LCD screen is not lit or does not appear, make sure you select one of the WPS options from
the product control panel within 2 minutes of pressing the WPS button on your router.

» Make sure to place your product within contact range of your 2.4 GHz router or access point. Avoid
placing your product near a microwave oven, 2.4 GHz cordless phone, or large metal object, such as a
filing cabinet.

Note: If you are using a 5 GHz wireless router, set the router to operate in dual band (2.4 GHz and

5 GHz) mode. If your router uses a single network name (SSID) for both the 2.4 GHz and 5 GHz band,
give each band its own network name (SSID) instead, such as Home Network 2.4 GHz and Home
Network 5 GHz. See your router documentation or contact your internet service provider for
instructions.

» Verify that your router or access point is operating correctly by connecting to it from your computer or
another device.
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* You may need to disable the firewall and any anti-virus software on your wireless router or access
point.

* Check to see if access restrictions, such as MAC address filtering, are set on the router or access
point. If access restrictions are set, add your product's MAC address to your router's address list. To
obtain your product's MAC address, print a network status sheet. Then follow the instructions in your
router or access point documentation to add the address to the list.

* If your router or access point does not broadcast its network name (SSID), follow the instructions that
came with your product to enter your wireless network name manually.

« If your router or access point has security enabled, determine the kind of security it is using and any
required password or passphrase for connection. Then make sure to enter the exact WEP key or WPA
passphrase correctly.

» Check if your computer is restricting the available wireless channels. If so, verify that your wireless
access point is using one of the usable channels and change to a usable channel, if necessary.

* If you are using a Wi-Fi Direct connection that suddenly disconnects, the Wi-Fi direct password on
your device may have been changed. If necessary, delete the existing DIRECT-xxxxxxxx connection
settings from your device and enter a new password. See your device documentation for instructions.

+ If you connected your product to a Windows computer using Wi-Fi Direct and it automatically selected
Access Point Mode, you may have trouble accessing a low-priority Internet connection. Check the
network connection or adapter settings in the Windows Control Panel and set the Internet metric
setting to 100 for your version of the Internet Protocol.

Parent topic: Solving Network Problems

Related concepts
Wi-Fi Direct Mode Setup

Related tasks
Selecting Wireless Network Settings From the Control Panel
Printing a Network Status Sheet

Related topics
Wi-Fi or Wired Networking

Network Software Cannot Find Product on a Network
If EpsonNet Setup cannot find your product on a network, try these solutions:

» Make sure your product is turned on and connected to your network. Verify connection using your
product control panel.
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» Check if your network name (SSID) contains non-ASCII characters. Your product cannot display non-
ASCII characters.

» Make sure your product is not connected to a guest network.

 If necessary, reinstall your product software and try running EpsonNet Setup again:
1. Reset your product's network settings to their factory defaults.
2. Windows only: uninstall your product software.
3. Initialize your router following the instructions in your router documentation.

Note: If you are reading these instructions online, you will lose your Internet connection when you
initialize your router, so note the next step before initializing it.

4. Download your product software from the Epson website using the instructions on the Start Here
sheet.

* If you have replaced your router, reinstall your product software to connect to the new router.

Note: If you are using a 5 GHz wireless router, set the router to operate in dual band (2.4 GHz and

5 GHz) mode. If your router uses a single network name (SSID) for both the 2.4 GHz and 5 GHz band,
give each band its own network name (SSID) instead, such as Home Network 2.4 GHz and Home
Network 5 GHz. See your router documentation or contact your internet service provider for
instructions.

Parent topic: Solving Network Problems

Related concepts
Uninstall Your Product Software

Related topics
Wi-Fi or Wired Networking

Product Does Not Appear in OS X Printer Window
If your product does not appear in the OS X printer window, try these solutions:
» Turn your product off, wait 30 seconds, then turn it back on again.

* If you are connecting the product via Wi-Fi Protected Setup (WPS) and the Wi-Fi icon on your
product's LCD screen is not lit, make sure you select one of the WPS options from the product control
panel within 2 minutes of pressing the WPS button on your router.
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« If you are connecting the product wirelessly via EpsonNet Setup and the Wi-Fi icon does not appear lit
on your LCD screen, make sure your product software was installed correctly. If necessary, reinstall
your software.

Note: If you are using a 5 GHz wireless router, set the router to operate in dual band (2.4 GHz and

5 GHz) mode. If your router uses a single network name (SSID) for both the 2.4 GHz and 5 GHz band,
give each band its own network name (SSID) instead, such as Home Network 2.4 GHz and Home
Network 5 GHz. See your router documentation or contact your internet service provider for instructions.

Parent topic: Solving Network Problems

Related concepts
Uninstall Your Product Software

Cannot Print Over a Network
If you cannot print over a network, try these solutions:
* Make sure that your product is turned on.
» Make sure you install your product's network software as described in your product documentation.

» Print a network status sheet and verify that the network settings are correct. If the network status is
Disconnected, check any cable connections and turn your product off and then on again.

« If you are using TCP/IP, make sure the product's IP address is set correctly for your network. If your
network does not assign IP addresses using DHCP, set the IP address manually.

* Make sure your computer and product are both using the same wireless network.

* If network printing is slow, print a network status sheet and check the signal strength. If it is poor, place
your product closer to your router or access point. Avoid placing your product near a microwave oven,
2.4 GHz cordless phone, or large metal object, such as a filing cabinet.

Note: If you are using a 5 GHz wireless router, set the router to operate in dual band (2.4 GHz and
5 GHz) mode. See your router documentation for instructions.

+ Check to see if your wireless router or access point has an enabled Privacy Separator function that is
preventing printing from a device over the network. See your router or access point documentation for
instructions on disabling the Privacy Separator function.

« If you are connecting the product via Wi-Fi Protected Setup (WPS) and the Wi-Fi icon on your
product's LCD is not lit, make sure you select one of the WPS options from the product control panel
within 2 minutes of pressing the WPS button on your router.
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* Check your wired LAN router or access point to see if the LED for the port to which your product is
connected is on or flashing. If the link LED is off, try the following:

» Make sure the Ethernet cable is securely connected to your product and to your router, access
point, switch, or hub.

» Try connecting your product to a different port or a different router, access point, switch, or hub.
» Try connecting with a different Ethernet cable.
» Try printing to your product from another computer on the network.

Note: If you are using a 5 GHz wireless router, set the router to operate in dual band (2.4 GHz and
5 GHz) mode. See your router documentation for instructions.

* If you are connecting the product via EpsonNet Setup and the Wi-Fi icon does not appear lit on the
LCD, make sure your product software was installed correctly. If necessary, reinstall your software.

Parent topic: Solving Network Problems
Related concepts

Uninstall Your Product Software

Related tasks

Printing a Network Status Sheet

Related topics
Wi-Fi or Wired Networking

Cannot Scan Over a Network
If you cannot start Epson Scan for scanning over a network, try these solutions:

« If you cannot scan from your product control panel, make sure you restarted your computer after
installing the product software. Make sure the Event Manager program is not being blocked by your
firewall or security software.

Note: If you are using a 5 GHz wireless router, set the router to operate in dual band (2.4 GHz and

5 GHz) mode. If your router uses a single network name (SSID) for both the 2.4 GHz and 5 GHz band,
give each band its own network name (SSID) instead, such as Home Network 2.4 GHz and Home
Network 5 GHz. See your router documentation or contact your internet service provider for
instructions.

+ If you are scanning a large original at a high resolution, a network communication error may occur. Try
scanning again at a lower resolution.
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 If network communication was interrupted while starting Epson Scan, exit Epson Scan, wait a few
seconds, and restart it. If Epson Scan cannot restart, turn off your product, turn it back on, and try
restarting Epson Scan again.

» Check the connection setting and test the connection using Epson Scan Settings:
Windows 10: Click E select All apps, and select EPSON Scan Settings. Make sure the
Connection setting is set to Network, then click the Test button.
Windows 8.x: Navigate to the Apps screen and select EPSON Scan Settings. Make sure the
Connection setting is set to Network, then click the Test button.

Windows (other versions): Click E]' or Start > All Programs or Programs > EPSON > EPSON
Scan > EPSON Scan Settings. Make sure the Connection setting is set to Network, then click the
Test button.

OS X: Open the Applications folder, click Epson Software, and click EPSON Scan Settings. Make
sure the Connection setting is set to Network, then click the Test button.

* If the user restriction feature (Access Control) is enabled, a user ID and password are required to
scan. If you do not know the user ID or password, contact your administrator for assistance.

» Make sure the option selected as the Timeout Setting in the Epson Scan Settings program is long
enough to complete scanning over a network.

* You may need to disable the firewall and any anti-virus software on your wireless router or access
point.

Note: With OS X, in addition to scanning with Image Capture, you can download and install Epson Scan
scanning software. Epson Scan provides additional image adjustment and photo correction features for
enhancing scanned images, and provides an interface for TWAIN-compliant OCR scanning software. To
download Epson Scan, visit Epson's driver download site (U.S. downloads or Canadian downloads).

Parent topic: Solving Network Problems

Related tasks
Starting a Scan Using the Epson Scan Icon
Starting a Scan from a Scanning Program

Solving Copying Problems
Check these solutions if you have problems copying with your product.

Product Makes Noise, But Nothing Copies
Product Makes Noise When It Sits for a While
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Parent topic: Solving Problems

Product Makes Noise, But Nothing Copies
If your product makes a noise, but nothing copies, try these solutions:

* Run a nozzle check to see if any of the print head nozzles are clogged. Then clean the print head, if
necessary.

« Ifthe nozzle check page does not print, but the product's power is on, make sure your product
software is installed correctly.

* Make sure your product is level (not tilted).
Parent topic: Solving Copying Problems

Related concepts
Print Head Nozzle Check
Print Head Cleaning

Product Makes Noise When It Sits for a While

Your product is performing routine maintenance. This is normal.
Parent topic: Solving Copying Problems

Solving Paper Problems
Check these sections if you have problems using paper with your product.

Paper Feeding Problems

Paper Jam Problems Inside the Product

Paper Jam Problems in the Cassette

Paper Jam Problems in the Duplexer (Rear Cover)
Document Jams in the Automatic Document Feeder
Paper Ejection Problems

Parent topic: Solving Problems
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Paper Feeding Problems
If you have problems feeding paper, try these solutions:

« If paper does not feed for printing, remove it from the rear feed slot or cassette. Reload it, then adjust
the edge guides. Make sure the paper stack is not above the tab on the edge guides inside the
cassette or rear feed slot.

» Be sure to insert the paper cassette all the way into your product.
» If multiple pages feed at once, remove the paper, fan the edges to separate the sheets, and reload it.
* Do not load more than the recommended number of sheets.
» Make sure your paper meets the specifications for your product.
 If paper jams when you print on both sides of the paper, try loading fewer sheets.
* Make sure the paper size and paper type settings are correct for the paper source.
» For best results, follow these guidelines:
» Use new, smooth, high-quality paper that is not curled, creased, old, too thin, or too thick.
* Load paper in the cassette printable side down.
» Follow any special loading instructions that came with the paper.
Parent topic: Solving Paper Problems

Related references

Paper Jam Problems Inside the Product

Paper Jam Problems in the Cassette

Paper Jam Problems in the Duplexer (Rear Cover)
Paper Loading Capacity

Related topics

Loading Paper

Paper Jam Problems Inside the Product
If paper has jammed inside the product, follow the steps here to clear the jam.
1. Cancel the print job from your computer, if necessary.
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2. Open the front cover.
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5. If any jammed paper remains near the output tray, carefully remove it.

6. Follow the prompts on the LCD screen to clear any error messages. If you still see a paper jam
message, check the other paper jam solutions.

Parent topic: Solving Paper Problems

Related references

Paper Jam Problems in the Cassette

Paper Jam Problems in the Duplexer (Rear Cover)
Document Jams in the Automatic Document Feeder

Paper Jam Problems in the Cassette
If paper has jammed in the cassette, follow the steps here to clear the jam.
1. Cancel the print job, if necessary.
2. Close the output tray.
3. Pull out the paper cassette.
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4. Carefully remove any paper jammed inside the product.

5. Carefully follow all paper loading instructions and reload the paper.
6. Keep the cassette flat as you gently insert it.

7. Follow the prompts on the LCD screen to clear any error messages. If you still see a paper jam
message, check the other paper jam solutions.

Parent topic: Solving Paper Problems

Related references
Paper Jam Problems Inside the Product
Paper Jam Problems in the Duplexer (Rear Cover)
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Document Jams in the Automatic Document Feeder

Paper Jam Problems in the Duplexer (Rear Cover)
If paper has jammed in the duplexer, follow the steps here to clear the jam.
1. Cancel the print job from your computer, if necessary.
2. Press the buttons on the sides of the rear cover and remove it.

3. Carefully remove any jammed paper.

328



4. Remove any jammed paper from the duplexer.

6. Follow the prompts on the LCD screen to clear any error messages. If you still see a paper jam
message, check the other paper jam solutions.

Parent topic: Solving Paper Problems

Related references

Document Jams in the Automatic Document Feeder
Paper Jam Problems Inside the Product

Paper Jam Problems in the Cassette
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Document Jams in the Automatic Document Feeder

If you have problems with document jams in the automatic document feeder (ADF), follow the steps here
to clear the jam.

1. Cancel the print job, if necessary.

2. Remove your originals from the ADF.
3. Open the ADF cover.

Caution: Make sure you open the ADF cover before removing any jammed paper. Otherwise the
product may be damaged.
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5. Close the ADF cover, then raise the document cover.

7. Lower the document cover.

8. Raise the ADF input tray.

9. Carefully remove any jammed pages.
10. Lower the ADF input tray.

11. Reload your originals.
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Caution: Make sure you do not load the ADF beyond its capacity for your paper size. Also make sure
the originals you load are not bent, folded, or curled and do not have tape, staples, or other materials
that could obstruct the feeder.

12. Follow the prompts on the LCD screen to clear any error messages. If you still see a paper jam
message, check the other paper jam solutions.

Parent topic: Solving Paper Problems

Related references

Paper Jam Problems in the Cassette

Paper Jam Problems Inside the Product

Paper Jam Problems in the Duplexer (Rear Cover)

Related topics
Loading Paper

Paper Ejection Problems
If you have problems with paper ejecting properly, try these solutions:

« If paper does not eject fully, you may have set the wrong paper size. Cancel printing to eject the paper.
Select the correct paper size when you reprint.

« If paper is wrinkled when it ejects, it may be damp or too thin. Load new paper and be sure to select
the correct paper type setting when you reprint.

Parent topic: Solving Paper Problems

Related references

Document Jams in the Automatic Document Feeder
Paper Jam Problems in the Cassette

Paper Jam Problems Inside the Product

Paper Jam Problems in the Duplexer (Rear Cover)
Paper or Media Type Settings - Printing Software
Paper Type Settings - Control Panel

Related topics
Loading Paper

Solving PCL/PostScript Problems

Check these sections if you have problems with the PCL or PostScript printer software.
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Nothing Prints Using the PCL/Postscript Printer Software
Settings Are Missing from the PCL or PostScript Printer Software
Printing a PS3 (PostScript) Status Sheet

Parent topic: Solving Problems

Nothing Prints Using the PCL/Postscript Printer Software
If your document doesn't print, try these solutions:
* Make sure your product is turned on and properly connected.
* Make sure the printing language setting on the control panel is correct.

» Check your product's control panel for error messages. The PCL and PostScript printing software will
not display any error messages on your computer screen if a printing error occurs.

* Make sure your product is selected as the printer in your printing program.
Parent topic: Solving PCL/PostScript Problems

Settings Are Missing from the PCL or PostScript Printer Software
If certain settings are missing or incorrect in the PCL or PostScript printer software, try these solutions:
» Make sure your product is selected in the PCL printer software.

« If you are using the product as a laser printer replacement and have not installed Epson printer
software, certain options and functions may not be available. Install the standard Epson, PCL, or
PostScript printer software to access additional settings and features.

Parent topic: Solving PCL/PostScript Problems

Related topics
Enabling Epson Universal Print Driver (PCL) or PostScript Printing

Printing a PS3 (PostScript) Status Sheet

You can print a PS3 (PostScript) status sheet to confirm the current font information and PostScript
printer software version.

Parent topic: Solving PCL/PostScript Problems

Solving Problems Printing from a Computer
Check these sections if you have problems while printing from your computer.
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Note: When printing using AirPrint, the available print settings are different from those covered in this
manual. See the Apple website for details.

Note: For problems while printing with the Epson Universal Print Driver or PostScript (PS3) printer
software, see the sections covering that software in this manual.

Nothing Prints
Product Icon Does Not Appear in Windows Taskbar
Printing is Slow

Parent topic: Solving Problems

Nothing Prints
If you have sent a print job and nothing prints, try these solutions:
* Make sure your product is turned on.
» Make sure any interface cables are connected securely at both ends.

+ If you connected your product to a USB hub, make sure it is a first-tier hub. If it still does not print,
connect your product directly to your computer instead of the hub.

* Run a product check to see if a test page prints. If the test page prints, check to see if your product
software is installed correctly.

* In Windows, make sure your product is selected as the default printer.

* In Windows, delete all jobs from the Windows Spooler. Click Print Queue on the Maintenance tab in
the printer settings window, and cancel and stalled print jobs.

Parent topic: Solving Problems Printing from a Computer

Related tasks
Running a Product Check

Product Icon Does Not Appear in Windows Taskbar

If you do not see your product icon in the Windows taskbar, first try restarting your computer. If that does
not work, try this solution:

1. Do one of the following:

* Windows 10: Right-clickﬂ and select Control Panel > Hardware and Sound > Devices and
Printers.
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+ Windows 8.x: Navigate to the Apps screen and select Control Panel > Hardware and Sound >
Devices and Printers.

* Windows 7: Click E]' and select Devices and Printers.

* Windows Vista: Click E]' select Control Panel, and click Printer under Hardware and Sound.

* Windows XP: Click Start and select Printers and Faxes. (Or open the Control Panel, select
Printers and Other Hardware, if necessary, and Printers and Faxes.)

Right-click your product name, select Printing Preferences, and select your product name again if
necessary.

Click the Maintenance tab.

Click the Extended Settings button.

Select Enable EPSON Status Monitor 3, then click OK.

Click the Monitoring Preferences button.

Click the checkbox for the option that adds the shortcut icon to the taskbar.
Click OK to close the open program windows.

Parent topic: Solving Problems Printing from a Computer

Printing is Slow
If printing becomes slow, try these solutions:

Make sure your system meets the requirements for your operating system. If you are printing a high-
resolution image, you may need more than the minimum requirements. If necessary, increase your
system's memory.

If you are using Windows 7, close the Devices and Printers window before you print.

If you are using OS X, make sure you download and install the Epson printer driver.
Clear space on your hard drive or run a defragmentation utility to free up existing space.
Close any programs you are not using when you print.

If your product is connected to a USB hub, connect it directly to your computer instead.

If printing becomes slower after printing continuously for a long time, the product may have
automatically slowed down to protect the print mechanism from overheating or becoming damaged.
Let the product rest with the power on for 30 minutes, then try printing again.
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For the fastest printing, select the following settings in your product software:

* Make sure the paper type setting matches the type of paper you loaded.

» Turn on any high speed settings in your product software.

+ Select a lower print quality setting.

» Make sure the ink drying time has not been increased for double-sided printing.

» Windows: Click the Maintenance or Utility tab, select Extended Settings or Speed and Progress,
and select the following settings:

« Always Spool RAW Datatype
* Page Rendering Mode
* Print as Bitmap
Parent topic: Solving Problems Printing from a Computer
Related references
Windows System Requirements
OS X System Requirements
Paper or Media Type Settings - Printing Software
Paper Type Settings - Control Panel
Related tasks
Selecting Basic Print Settings - Windows

Selecting Extended Settings - Windows
Selecting Basic Print Settings - OS X

Solving Page Layout and Content Problems
Check these sections if you have problems with the layout or content of your printed pages.

Note: When printing using AirPrint, the available print settings are different from those covered in this
manual. See the Apple website for details.

Inverted Image

Too Many Copies Print
Blank Pages Print

Incorrect Margins on Printout
Incorrect Characters Print
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Incorrect Image Size or Position
Slanted Printout

Parent topic: Solving Problems

Inverted Image
If your printed image is inverted unexpectedly, try these solutions:
» Turn off any mirror or inversion settings in your printing application.

» Turn off the Mirror Image, Flip horizontally, or Reverse page orientation settings in your printer
software. (This option has different names, depending on your operating system version.)

Note: Leave these options turned on when you print on Epson Iron-on Cool Peel Transfer paper, if
available for your product.

Parent topic: Solving Page Layout and Content Problems

Related tasks
Selecting Basic Print Settings - OS X
Selecting Additional Layout and Print Options - Windows

Too Many Copies Print

Make sure that the Copies setting in your printing program or printer software is not set for multiple
copies.

Parent topic: Solving Page Layout and Content Problems

Related tasks
Selecting Basic Print Settings - OS X
Selecting Basic Print Settings - Windows

Blank Pages Print
If blank pages print unexpectedly, try these solutions:
* Make sure you selected the correct paper size settings in your printing program and printer software.

 If a blank page exists in a document you are printing and you want to skip printing it, select the Skip
Blank Page setting in your printer software.

* Run a print head nozzle check to see if any of the nozzles are clogged. Then clean the print head, if
necessary.
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* Make sure your product is selected as the printer in your printing program.
Parent topic: Solving Page Layout and Content Problems

Related concepts
Print Head Nozzle Check
Print Head Cleaning

Related tasks

Selecting Basic Print Settings - OS X
Selecting Extended Settings - Windows
Selecting Basic Print Settings - Windows

Incorrect Margins on Printout
If your printed page has incorrect margins, try these solutions:
» Make sure you selected the correct paper size settings in your printing program and printer software.
* Make sure you selected the correct margins for your paper size in your printing program.
* Make sure your paper is positioned correctly for feeding into the printer.
You can use the preview option in your printer software to check your margins before you print.
Parent topic: Solving Page Layout and Content Problems

Related tasks
Selecting Basic Print Settings - Windows
Selecting Basic Print Settings - OS X

Related topics
Loading Paper

Incorrect Characters Print
If incorrect characters appear in your prints, try these solutions before reprinting:
» Make sure any cables are securely connected at both ends.

* In Windows, delete all jobs from the Windows Spooler. Click Print Queue on the Maintenance tab in
the printer settings window, and cancel any stalled print jobs.

* If your product is connected to a USB hub, connect it directly to your computer instead.

« |If your computer entered sleep mode the last time you printed, the next print job after your computer
exits sleep mode may contain garbled characters. Print your document again.
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+ If incorrect characters still appear in your prints, try connecting your product using a different cable.
Parent topic: Solving Page Layout and Content Problems

Incorrect Image Size or Position
If your printed image is the wrong size or in the wrong position, try these solutions:

» Make sure you selected the correct paper size and layout settings in your printing program and printer
software.

» Make sure your paper is positioned correctly for feeding into the printer.
You can use the preview option in your printer software to check your margins before you print.
Parent topic: Solving Page Layout and Content Problems

Related tasks

Selecting Basic Print Settings - Windows

Selecting Basic Print Settings - OS X

Selecting Additional Layout and Print Options - Windows
Selecting Page Setup Settings - OS X

Slanted Printout
If your printouts are slanted, try these solutions:
» Slide the edge guides against the edges of the paper.
« Select a higher print quality setting in your printer software.
» Turn off any high speed settings in your product software.
* Align the print head.
* Make sure the product is not printing while tilted or at an angle.
Parent topic: Solving Page Layout and Content Problems

Related tasks
Selecting Basic Print Settings - OS X
Selecting Basic Print Settings - Windows

Related topics
Loading Paper
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Solving Print Quality Problems

Check these sections if your printouts have problems with print quality, but your image looks fine on your
computer screen.

Note: When printing using AirPrint, the available print settings are different from those covered in this
manual. See the Apple website for details.

White or Dark Lines in Printout
Blurry or Smeared Printout

Faint Printout or Printout Has Gaps
Grainy Printout

Parent topic: Solving Problems

White or Dark Lines in Printout
If you notice white or dark lines in your prints (also called banding), try these solutions before you reprint:

* Run a nozzle check to see if any of the print head nozzles are clogged. Then clean the print head, if
necessary.

» Make sure the paper type setting matches the type of paper you loaded.

» Make sure you loaded the printable side of the paper correctly for your product.
» Turn off any high speed settings in your product software.

» Align the print head.

* You may need to replace the ink cartridge.

Parent topic: Solving Print Quality Problems

Related concepts

Print Head Nozzle Check

Print Head Cleaning

Print Head Alignment

Related references

Paper or Media Type Settings - Printing Software

Paper Type Settings - Control Panel

Related tasks

Selecting Additional Layout and Print Options - Windows
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Related topics
Loading Paper
Replacing the Ink Cartridge and Maintenance Box

Blurry or Smeared Printout
If your printouts are blurry or smeared, try these solutions:
* Make sure your paper is not damp, curled, old, or loaded incorrectly in your product.
» Use a support sheet with special paper, or load special paper one sheet at a time.
» Make sure your paper meets the specifications for your product.
» Use Epson papers to ensure proper saturation and absorption of genuine Epson inks.
* Make sure the paper type setting in your product software matches the type of paper you loaded.
» Make sure you loaded the printable side of the paper correctly for your product.

* If you are printing on thick paper or envelopes, turn on the Thick Paper setting from the control panel
or select Thick Paper and Envelopes in the Extended Settings of the printer software. (Turning this
setting on will decrease print speed.)

* Remove each sheet from the output tray as it is printed.
* Avoid handling printouts on glossy paper right after printing to allow the ink to set.
» Turn off any high speed settings in your product software.

+ If you print on both sides of a sheet of paper, smudges may appear on the reverse side of heavily
saturated or dark images. If one side of a sheet will contain a lighter image or text, print that side first.
Adjust the Print Density and/or Increase Ink Drying Time settings.

« If printed copies are smeared, lower the copy density setting on the product control panel.

* Run a nozzle check to see if any of the print head nozzles are clogged. Then clean the print head, if
necessary.

 Align the print head.
* Clean the paper path.

Note: Your product will not operate properly while tilted at an angle. Place it on a flat, stable surface that
extends beyond the base of the product in all directions.

Parent topic: Solving Print Quality Problems
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Related concepts
Print Head Cleaning
Print Head Alignment

Related references
Available Epson Papers
Paper Specifications

Related tasks

Selecting Basic Print Settings - Windows

Selecting Double-sided Printing Settings - Windows
Selecting Additional Layout and Print Options - Windows
Selecting Basic Print Settings - OS X

Selecting Double-sided Printing Settings - OS X
Selecting Printing Preferences - OS X

Cleaning the Paper Guide

Related topics
Loading Paper

Faint Printout or Printout Has Gaps
If your printouts are faint or have gaps, try these solutions:

* Run a nozzle check to see if any of the print head nozzles are clogged. Then clean the print head, if
necessary.

* The ink cartridge may be old or low on ink, and you may need to replace it.

* Make sure the paper type setting matches the type of paper you loaded.

» Make sure your paper is not damp, curled, old, or loaded incorrectly in your product.
* Align the print head.

* Clean the paper path.

Parent topic: Solving Print Quality Problems

Related concepts

Print Head Nozzle Check
Print Head Cleaning
Print Head Alignment
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Related references

Paper or Media Type Settings - Printing Software
Paper Type Settings - Control Panel

Related tasks

Cleaning the Paper Guide

Selecting Basic Print Settings - OS X

Selecting Basic Print Settings - Windows

Related topics
Loading Paper
Replacing the Ink Cartridge and Maintenance Box

Grainy Printout
If your printouts are grainy, try these solutions:

Make sure you loaded the printable side of the paper correctly for your product.
Select a higher print quality setting and turn off any high speed settings in your product software.

Run a nozzle check to see if any of the print head nozzles are clogged. Then clean the print head, if
necessary.

Align the print head.

You may need to increase the image resolution or print a smaller size; see your software
documentation.

Note: Images from the Internet may be low resolution and not result in a high quality printout.

If you enlarged the image in an image-editing program, you need to increase the resolution setting to
retain a high image quality. Increase the resolution by the same amount you increased the image size.
For example, if the resolution is 300 dpi (dots per inch) and you will double the image size later,
change the resolution setting to 600 dpi.

Note: Higher resolution settings result in larger file sizes, which take longer to process and print.
Consider the limitations of your computer system when selecting a resolution, and select the lowest
possible resolution that produces acceptable quality to keep file sizes manageable.

Parent topic: Solving Print Quality Problems
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Related concepts

Print Head Nozzle Check

Print Head Cleaning

Print Head Alignment

Related tasks

Selecting Basic Print Settings - Windows
Selecting Basic Print Settings - OS X
Selecting Additional Layout and Print Options - Windows
Selecting Printing Preferences - OS X
Related topics

Loading Paper

Solving Scanning Problems
Check these solutions if you have problems scanning with your product.

Scanning Software Does Not Operate Correctly
Cannot Start Epson Scan
Scanning to a Network Folder or FTP is Slow

Parent topic: Solving Problems

Scanning Software Does Not Operate Correctly
If your scanning software does not operate correctly, try these solutions:

» Make sure your computer has adequate memory and meets the system requirements for your
operating system.

» Make sure your computer is not running in a power-saving mode, such as sleep or standby. If so,
wake your system and restart your scanning software.

« If you upgraded your operating system but did not reinstall your scanning software, try reinstalling it.

Note: With OS X, in addition to scanning with Image Capture, you can download and install Epson
Scan scanning software. Epson Scan provides additional image adjustment and photo correction
features for enhancing scanned images, and provides an interface for TWAIN-compliant OCR
scanning software. To download Epson Scan, visit Epson's driver download site (U.S. downloads or
Canadian downloads).
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Parent topic: Solving Scanning Problems

Related concepts
Uninstall Your Product Software

Related references
Windows System Requirements
OS X System Requirements

Related tasks
Scanning with OS X Using Image Capture

Cannot Start Epson Scan
If you cannot start Epson Scan, try these solutions:
» Make sure your product is turned on and any interface cables are securely connected at both ends.
* Make sure Epson Scan is selected in your scanning program.

» Make sure your computer is not running in a power-saving mode, such as sleep or standby. If so,
wake your system and restart Epson Scan.

» Check the connection setting and test the connection using Epson Scan Settings:

Windows 10: Click E and select All apps. Select EPSON, then select EPSON Scan Settings. Make
sure the correct Connection setting is selected, then click the Test button.

Windows 8.x: Navigate to the Apps screen and select EPSON Scan Settings. Make sure the correct
Connection setting is selected, then click the Test button.

Windows (other versions): Click E]' or Start > All Programs or Programs > EPSON > EPSON
Scan > EPSON Scan Settings. Make sure the correct Connection setting is selected, then click the
Test button.

OS X: Open the Applications folder, click Epson Software, and click EPSON Scan Settings. Make
sure the correct Connection setting is selected, then click the Test button.

* Make sure you do not have multiple versions of Epson Scan installed. If you do, uninstall both versions
and install one version.

+ If you upgraded your operating system but did not reinstall Epson Scan, try reinstalling it.

* If the user restriction feature (Access Control) is enabled, a user ID and password are required to
scan. If you do not know the user ID or password, contact your administrator for assistance.
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Note: With OS X, in addition to scanning with Image Capture, you can download and install Epson Scan
scanning software. Epson Scan provides additional image adjustment and photo correction features for
enhancing scanned images, and provides an interface for TWAIN-compliant OCR scanning software. To
download Epson Scan, visit Epson's driver download site (U.S. downloads or Canadian downloads).

Parent topic: Solving Scanning Problems

Related tasks

Starting a Scan Using the Epson Scan Icon

Starting a Scan with Document Capture Pro or Document Capture
Scanning with OS X Using Image Capture

Scanning to a Network Folder or FTP is Slow

If scanning is slow when you select the Network Folder/FTP option, make sure you enter the computer
or server's IP address (not a host name) as the scanning location. If you use a host name as the network
folder or FTP scanning destination, it may slow down the scanning process.

Parent topic: Solving Scanning Problems

Solving Scanned Image Quality Problems
Check these sections if a scanned image on your computer screen has a quality problem.

Image Consists of a Few Dots Only

Line of Dots Appears in All Scanned Images
Straight Lines in an Image Appear Crooked

Image is Distorted or Blurry

Image Colors are Patchy at the Edges

Image is Too Dark

Back of Original Image Appears in Scanned Image
Ripple Patterns Appear in an Image

Scanned Image Colors Do Not Match Original Colors
Scan Area is Not Adjustable in Thumbnail Preview
Scanned Image Edges are Cropped

Parent topic: Solving Problems
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Image Consists of a Few Dots Only
If your scanned image consists only of a few dots, try these solutions:
* Make sure you placed your original for scanning facing the correct way.

+ If you are scanning using the Epson Scan Black & White setting, adjust the Threshold setting and
scan again.

Parent topic: Solving Scanned Image Quality Problems

Related references
Available Image Adjustments - Professional Mode
Available Image Adjustments - Office Mode

Related topics
Placing Originals on the Product

Line of Dots Appears in All Scanned Images

If a line of dots appears in all your scanned images, clean the scanner glass with a soft, dry, lint-free
cloth or use a small amount of glass cleaner on the cloth, if necessary. Paper towels are not
recommended.

Caution: Do not spray glass cleaner directly on the scanner glass.

Parent topic: Solving Scanned Image Quality Problems

Related tasks
Cleaning Your Product

Straight Lines in an Image Appear Crooked

If straight lines in an original appear crooked in a scanned image, make sure to place your original
straight when you scan it.

Parent topic: Solving Scanned Image Quality Problems

Related topics
Placing Originals on the Product
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Image is Distorted or Blurry
If a scanned image appears distorted or blurry, try these solutions:

» Make sure your original is not wrinkled or warped. This may prevent the original from laying flat on the
scanner glass.

* Do not move your original or your product during scanning.

* Your product will not operate properly while tilted at an angle. Place your product on a flat, stable
surface that extends beyond its base in all directions.

+ Adjust these Epson Scan settings (if available) and try scanning again:
+ Select the Unsharp Mask setting.
* Adjust the Auto Exposure setting.
* Increase the Resolution setting.

Parent topic: Solving Scanned Image Quality Problems

Related topics
Selecting Epson Scan Settings

Image Colors are Patchy at the Edges

If you are scanning a thick or warped original, cover its edges with paper to block external light as you
scan it.

Parent topic: Solving Scanned Image Quality Problems

Image is Too Dark

If your scanned image is too dark, try these solutions:

+ Adjust these Epson Scan settings (if available) and try scanning again:
* Auto Exposure
* Brightness
* Histogram Adjustment

» Check the brightness and contrast settings of your computer monitor.

Parent topic: Solving Scanned Image Quality Problems

Related topics
Selecting Epson Scan Settings
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Back of Original Image Appears in Scanned Image

If an image from the back of a thin original appears in your scanned image, place a piece of black paper
on the back of the original and scan it again.

Parent topic: Solving Scanned Image Quality Problems

Ripple Patterns Appear in an Image

You may see a ripple pattern (called a moiré) in scanned images of printed documents. This is caused
by interference from differing pitches in the scanner's screen and your original's halftone screen. To
reduce this effect, adjust these Epson Scan settings (if available) and try scanning again:

+ Select the Descreening setting.
» Select a lower Resolution setting.
Parent topic: Solving Scanned Image Quality Problems

Related topics
Selecting Epson Scan Settings

Scanned Image Colors Do Not Match Original Colors

Printed colors can never exactly match the colors on your computer monitor because printers and
monitors use different color systems: monitors use RGB (red, green, and blue) and printers typically use
CMYK (cyan, magenta, yellow, and black).

Check the color matching and color management capabilities of your computer, display adapter, and the
software you are using to see if they are affecting the palette of colors you see on your screen.

To adjust the colors in your scanned image, adjust these Epson Scan settings (if available) and try
scanning again:

+ Change the Image Type setting and experiment with different combinations of the next settings.
+ Adjust the Tone Correction setting.

* Adjust the Auto Exposure setting.

Parent topic: Solving Scanned Image Quality Problems

Related topics
Selecting Epson Scan Settings
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Scan Area is Not Adjustable in Thumbnail Preview
If you cannot adjust the scan area while viewing a Thumbnail preview in Epson Scan, try these solutions:
» Create a scan area by drawing a marquee on your preview image and adjusting it as necessary.
+ Switch to Normal preview mode, if available, and preview your image again.
Parent topic: Solving Scanned Image Quality Problems

Related concepts
Image Preview Guidelines

Related tasks
Selecting a Scan Area - Professional Mode
Selecting a Scan Area - Office Mode

Scanned Image Edges are Cropped

If the edges of a scanned image are cropped, make sure your original is placed correctly for scanning. If
necessary, move your original away from the edges of the scanner glass slightly.

Parent topic: Solving Scanned Image Quality Problems

Related topics
Placing Originals on the Product

Solving Faxing Problems
Check these solutions if you have problems faxing with your product.

Cannot Send or Receive Faxes
Cannot Receive Faxes with a Telephone Connected to Your Product

Parent topic: Solving Problems

Cannot Send or Receive Faxes
If you cannot send or receive faxes, try these solutions:
« If you are faxing from a computer, use the Epson FAX Utility to send your fax.
* Make sure the recipient's fax machine is turned on and working.
* Make sure paper is loaded correctly in your product.

» Make sure you have set up your header information and have not blocked your caller ID. Otherwise,
your faxes might be rejected by the recipient's fax machine.
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« If user restriction has been enabled, you may need to enter a user name and password. Contact your
administrator for assistance.

« If you did not connect a telephone to your product, set the Receive Mode setting to Auto so you can
receive faxes automatically.

» Check that the cable connecting your telephone wall jack to your product's LINE port is secure.

» Print a fax connection report using your product control panel or fax software to help diagnose the
problem.

» Verify that the telephone wall jack works by connecting a phone to it and testing it.

« Ifthere is no dial tone and you connected the product to a PBX (Private Branch Exchange) phone line
or Terminal Adapter, change the Line Type setting to PBX. If you still cannot send a fax, turn off the
turn off the product's dial tone detection setting. (Turning off the dial tone setting may cause the
product to drop the first digit of a fax number.)

+ If you connected your product to a DSL phone line, you must connect a DSL filter to the phone jack to
enable faxing over the line. Contact your DSL provider for the necessary filter.

« If your telephone line has static, turn off your product's error correction mode fax communication
setting and try faxing again.

» Try lowering your product's fax speed setting.

» Make sure the error correction mode (ECM) setting is turned on if you are trying to send or receive a
color fax.

« If your telephone line uses call waiting and you have trouble receiving faxes, turn off call waiting to
prevent disruption of incoming faxes.

* If you have subscribed to a call forwarding service, the product may not be able to receive faxes.
Contact your service provider for assistance.

» Check your inbox and delete faxes after reading or printing them. If the inbox is full, the product cannot

receive faxes.

Note: If your product is connected to a VolP (Voice over Internet Protocol) phone line, keep in mind that
fax machines are designed to work over analog phone lines. Epson cannot guarantee that fax
transmission will work when using VolP.

If your phone line includes voice mail answering services, calls or faxes may be inadvertently received
by your voice mail service.

Parent topic: Solving Faxing Problems
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Related tasks

Connecting a Telephone or Answering Machine
Using the Fax Setup Wizard

Selecting the Line Type

Selecting Advanced Fax Settings

Printing Fax Reports

Receiving Faxes Automatically

Related topics
Loading Paper

Cannot Receive Faxes with a Telephone Connected to Your Product
If you cannot receive faxes when a telephone is connected to your product, try these solutions:
* Make sure your telephone is connected to your product's EXT port.
* Make sure the Receive Mode is set to Manual.

Note: When answering a call that is a fax, wait until the product's LCD screen displays a message that a
connection has been made before you hang up.

Parent topic: Solving Faxing Problems

Related tasks
Connecting a Telephone or Answering Machine
Using the Fax Setup Wizard

Uninstall Your Product Software

If you have a problem that requires you to uninstall and re-install your software, follow the instructions for
your operating system.

Uninstalling Product Software - Windows
Uninstalling Product Software - OS X

Parent topic: Solving Problems

Uninstalling Product Software - Windows
You can uninstall and then re-install your product software to solve certain problems.
1. Turn off the product.
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Disconnect any interface cables.
Do one of the following:

* Windows 10: Right click IEI and select Control Panel > Programs > Programs and Features.
Select the uninstall option for your Epson product, then select Uninstall/Change.

Note: If you see a User Account Control window, click Yes or Continue.

Select your product again, if necessary, then select OK, and click Yes to confirm the
uninstallation.

* Windows 8.x: Navigate to the Apps screen and select Control Panel > Programs > Programs
and Features. Select the uninstall option for your Epson product, then select Uninstall/Change.

Note: If you see a User Account Control window, click Yes or Continue.

Select your product again, if necessary, then select OK, and click Yes to confirm the
uninstallation.

* Windows (other versions): Click E" or Start, and select All Programs or Programs. Select
EPSON, select your product, then click EPSON Printer Software Uninstall.

Note: If you see a User Account Control window, click Yes or Continue.

In the next window, select your product and click OK. Then follow any on-screen instructions.
Do one of the following to uninstall Epson Event Manager, then follow any on-screen instructions:
* Windows 10: Select Epson Event Manager and click Uninstall.

* Windows 8.x: Select Epson Event Manager and click Uninstall.

* Windows 7/Windows Vista: Open the Windows Control Panel utility. Select Programs and
Features. (In Classic view, select Programs and click Uninstall a program.) Select Epson
Event Manager and click Uninstall/Change.

* Windows XP: Open the Windows Control Panel utility. Double-click Add or Remove Programs.
Select Epson Event Manager and click Change/Remove.

Do one of the following to uninstall Epson Scan, then follow any on-screen instructions:
* Windows 10: Select EPSON Scan and click Uninstall.
* Windows 8.x/Windows 7/Windows Vista: Select EPSON Scan and click Uninstall/Change.
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6.

* Windows XP: Select EPSON Scan and click Change/Remove.
Restart your computer, then see the Start Here sheet to re-install your software.

Note: If you find that re-installing your product software does not solve a problem, contact Epson.

Parent topic: Uninstall Your Product Software

Uninstalling Product Software - OS X

In most cases, you do not need to uninstall your product software before re-installing it. However, you
can download the Uninstaller utility from the Epson support website to uninstall your product software as
described here.

Note: If you find that re-installing your product software does not solve a problem, contact Epson.

1.

©® N o ok 0D

To download the Uninstaller utility, visit the Epson download site (U.S. downloads or Canadian
downloads).

Follow the instructions on the screen to install the Uninstaller utility.
Quit all applications currently running on your Mac.

Double-click the Uninstaller icon.

Select the checkbox for each software program you want to uninstall.
Click Uninstall.

Follow the on-screen instructions to uninstall the software.

Reinstall your product software.

Note: If you uninstall the printer driver and your product name remains in the Print & Fax, Print & Scan,
or Printers & Scanners window, select your product name and click the — (remove) icon to remove it.

Parent topic: Uninstall Your Product Software

Where to Get Help

If you need to contact Epson for technical support services, use the following support options.
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Internet Support

Visit Epson's support website at epson.com/support (U.S.) or epson.ca/support (Canada) for solutions to
common problems. You can download drivers and documentation, get FAQs and troubleshooting
advice, or e-mail Epson with your questions.

Speak to a Support Representative

Before you call Epson for support, please have the following information ready:

* Product name

* Product serial number (located on a label on the product)

» Proof of purchase (such as a store receipt) and date of purchase

» Computer configuration

» Description of the problem

Then call:

+ U.S.: (562) 276-4382, 6 AM to 8 PM, Pacific Time, Monday through Friday, and 7 AM to 4 PM, Pacific
Time, Saturday

» Canada: (905) 709-3839, 6 AM to 8 PM, Pacific Time, Monday through Friday, and 7 AM to 4 PM,
Pacific Time, Saturday

Days and hours of support are subject to change without notice. Toll or long distance charges may
apply.
Purchase Supplies and Accessories

You can purchase genuine Epson ink and paper at epson.com/ink3 (U.S. sales) or epson.ca (Canadian
sales). You can also purchase supplies from an Epson authorized reseller. To find the nearest one, call
800-GO-EPSON (800-463-7766).

Parent topic: Solving Problems
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Technical Specifications

These sections list the technical specifications for your product.

Note: Epson offers a recycling program for end of life Epson products. Please go to this site for
information on how to return your Epson products for proper disposal.

Windows System Requirements
OS X System Requirements
Printing Specifications

Scanning Specifications

Automatic Document Feeder (ADF) Specifications
Fax Specifications

Paper Specifications

Printable Area Specifications

Ink Cartridge Specifications
Dimension Specifications

Electrical Specifications
Environmental Specifications
Interface Specifications

Network Interface Specifications
Safety and Approvals Specifications
PS3 Mode Fonts

PCL5 Mode Fonts (Bitstream)
PCL6 Mode Fonts (Bitstream)

PCL Mode Fonts (URW)

Symbol Sets

Windows System Requirements

To use your product and its software, your computer should use one of these Microsoft operating
systems:

* Windows 10
¢ Windows 8.x
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* Windows 7

* Windows Vista

* Windows XP Professional x64 Edition
* Windows XP SP3

* Windows Server 2012R2

* Windows Server 2012

* Windows Server 2008R2

* Windows Server 2008

* Windows Server 2003R2

* Windows Server 2003

Note: Visit Epson's support website at epson.com/support (U.S.) or epson.ca/support (Canada) for the
latest in compatibility and drivers for your product.

Parent topic: Technical Specifications

OS X System Requirements
To use your product and its software, your Mac should use one of these operating systems:
+ OSX10.11.x
+ OS X 10.10.x
+ OS X 10.9.x
+ OSX10.8.x
+ OS X 10.7.x
+ 0SX10.6.8

Note: Visit Epson's support website at epson.com/support (U.S.) or epson.ca/support (Canada) for the
latest in compatibility and drivers for your product.

Parent topic: Technical Specifications
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Printing Specifications

Paper path

Capacity

Rear paper feed slot, top entry

Paper cassette, front entry

Rear paper feed slot: 0.04 inch (0.9 mm) stack thickness
Paper cassette: 1.08 inches (27.5 mm) stack thickness

Parent topic: Technical Specifications

Scanning Specifications

Scanner type
Photoelectric device
Effective pixels

Document size

Scanning resolution

Output resolution

Image data

Light source

Flatbed, color
CIS

10200 x 14040 pixels at 1200 dpi; scanning area may be restricted if
resolution setting is large

Maximum: A4 (8.3 x 11.7 inches [210 x 297 mm]) or Letter (8.5 x 11
inches [216 x 279 mm])

1200 dpi (main scan)

2400 dpi (sub scan)

50 to 4800, 7200, and 9600 dpi

(50 to 4800 dpi in 1 dpi increments)

16 bits per pixel per color internal

8 bits per pixel per color external (maximum)
LED

Parent topic: Technical Specifications

Automatic Document Feeder (ADF) Specifications

Paper input
Paper output

Faceup loading
Facedown ejection
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Paper size

Paper type

Paper weight

Sheet feeding capacity

US letter, legal, A4, A5, or B5 size
Plain paper

17 Ib (64 g/m?) to 24 Ib (95 g/m?)
Total thickness: 0.14 inch (3.5 mm)

Approximately 35 sheets at 20 Ib (75 g/m?); up to 10 sheets of paper
in this size: Legal (8.5 x 14 inches [216 x 356 mm])

Note: You cannot scan on both sides of the paper in this size: Legal (8.5 x 14 inches [216 x 356 mm]).

Parent topic: Technical Specifications

Fax Specifications

Fax type

Supported lines

Speed
Resolution

Speed dial numbers
Page memory

Walk-up black-and-white and color fax capability (ITU-T Super
Group 3)

Standard analog telephone lines

PBX (Private Branch Exchange) telephone systems
Up to 33.6 kbps

Monochrome:

Standard: 203 x 98 dpi

Fine: 203 x 196 dpi

Photo: 203 x 196 dpi

Super Fine: 203 x 392 dpi

Ultra Fine: 406 x 392 dpi

Color:

Fine: 200 x 200 dpi

Photo: 200 x 200 dpi

Up to 200

Up to 550 pages (based on ITU-T No. 1 chart)
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Redial 2 times (with 1 minute interval); specifications may differ by region or
country

Interface RJ-11 Phone Line
RJ-11 Telephone set connection

Parent topic: Technical Specifications
Paper Specifications

Note: Since the quality of any particular brand or type of paper may be changed by the manufacturer at
any time, Epson cannot guarantee the quality of any non-Epson brand or type of paper. Always test a
sample of paper stock before purchasing large quantities or printing large jobs.

Single-sheets

Size A4 (8.3 x 11.7 inches [210 x 297 mm])

A6 (4.1 x 5.8 inches [105 x 148 mm])

Letter (8.5 x 11 inches [216 x 279 mm])

Legal (8.5 x 14 inches [216 x 356 mm])

4 x 6 inches (102 x 152 mm)

5 x 7 inches (127 x 178 mm)

8 x 10 inches (203 x 254 mm)

3.5 x 5inches (89 x 127 mm)

16:9 wide (4 x 7.1 inches [102 x 181 mm])

Half Letter (5.5 x 8.5 inches [140 x 216 mm])
Paper types Plain paper and paper distributed by Epson
Weight Plain paper: 17 Ib (64 g/m?) to 24 Ib (90 g/m?)

Thick paper: 25 Ib (91 g/m?) to 68 Ib (256 g/m?)

Envelopes

Size No. 10 (4.1 x 9.5 inches [105 x 241 mm])
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Paper types Plain bond paper
Weight 20 1b (75 g/m?) to 24 Ib (90 g/m?)

Parent topic: Technical Specifications
Printable Area Specifications
Note: When printing borderless, quality may decline in the expanded printable area.

Single sheets

- Nrezzzzz) |\ —

. —

1 Top/bottom/sides: 0.12 inch (3.0 mm) minimum
2 Reduced print quality area/top: 1.77 inches (45.0 mm) minimum
3  Reduced print quality area/bottom: 1.97 inches (50.0 mm) minimum
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Envelopes
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Sides: 0.12 inch (3.0 mm) minimum
Top/bottom: 0.20 inch (5.0 mm) minimum
Reduced print quality area/right: 0.71 inch (18.0 mm) minimum

A WO DN -

Reduced print quality area/left: 1.77 inches (45.0 mm) minimum
Parent topic: Technical Specifications
Ink Cartridge Specifications

Note: This product uses only genuine Epson-brand cartridges. Other brands of ink cartridges and ink
supplies are not compatible and, even if described as compatible, may not function properly.

The cartridge included with the printer is designed for printer setup and not for resale. After some ink is
used for charging, the rest is available for printing. Yields vary considerably based on images printed,
print settings, paper type, frequency of use, and temperature. For print quality, a variable amount of ink
remains in the cartridge after the "replace cartridge" indicator comes on.

Color Black
Cartridge life Opened package: 6 months

Unopened package: do not use if the date on the package has
expired
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Temperature Storage: —4 °F (=20 °C) to 104 °F (40 °C)
1 month at 104 °F (40 °C)
Ink freezes at 14 °F (—10 °C)
Ink thaws and is usable after 3 hours at 77 °F (25 °C)

Note: For best printing results, use up a cartridge within 6 months of opening the package.

Parent topic: Technical Specifications

Dimension Specifications

Height Stored: 13.5 inches (342 mm)
Printing: 15.1 inches (383 mm)
Width Stored: 18.1 inches (461 mm)
Printing: 18.1 inches (461 mm)
Depth Stored: 16.6 inches (422 mm)
Printing: 25.8 inches (655 mm); with the output tray extension
extended
Weight 31.11b (14.1 kg)
(without ink cartridges or power
cord)

Parent topic: Technical Specifications

Electrical Specifications

Power supply rating 100t0 240V
Rated frequency range 50/60 Hz
Rated current 0.8t0 04 A
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Power consumption Printing: 22 W (ISO/IEC24712)
Ready mode: 8.9 W
Sleep mode: 2.6 W
Power off mode: 0.4 W

Parent topic: Technical Specifications

Environmental Specifications

Temperature Operating: 50 to 95 °F (10 to 35 °C)
Storage: —4 to 104 °F (—20 to 40 °C)
1 month at 104 °F (40 °C)

Humidity Operating: 20 to 80% RH

(without condensation) Storage: 5 to 85% RH

Parent topic: Technical Specifications

Interface Specifications

Interface type Hi-Speed USB (Device Class for computers)

Hi-Speed USB (for Mass storage class for external storage)
External USB devices MO drive: 1.3 GB maximum capacity

Hard disk drive: 2 TB maximum capacity

USB flash drive: 2 TB maximum capacity, formatted in FAT, FAT32,
or exFAT

Note: Epson cannot guarantee the operation of externally connected devices. External storage devices
that are powered via USB are not recommended. Use only external storage devices with independent
AC power sources.

Parent topic: Technical Specifications

364



Network Interface Specifications

Wi-Fi

Standard

Security

Frequency band
Communication mode

Ethernet

Standard
Communication mode

IEEE 802.11 b/g/n; complies with either IEEE 802.11 b/g or IEEE
802.11 b/g/n, depending on purchase location

WEP (64/128 bit)

WPA-PSK (TKIP/AES); complies with WPA2 with support for
WPA/WPA2 Personal

WPAZ2-Enterprise
2.4 GHz
Infrastructure mode
Ad hoc mode

Wi-Fi Direct

Note: Wi-Fi Direct Simple AP mode available even if you connect
the product to an Ethernet network.

IEEE802.3i/u/ab, IEEE802.3az
Ethernet 100BASE-TX/10BASE-T

Ethernet 1000BASE-T; use a category-5e or higher cable, preferably
an STP (Shielded Twisted Pair) cable, to prevent risk of radio
frequency interference

Note: The connected device should be IEEE802.3az compliant.

Security Protocl
IEEE802.1X
IPsec/IP Filtering

SSL/TLS: HTTPS Server/Client or IPPS

SNMPv3
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Parent topic: Technical Specifications

Safety and Approvals Specifications

United States Safety: UL60950-1
EMC: FCC part 15 Subpart B class B
Canada Safety: CAN/CSA C22.2 No. 60950-1

EMC: CAN/CSA-CEI/IEC CISPR 22 Class B

This equipment contains the following wireless module:
» Manufacturer: Askey Computer Corporation.
* Type: WLU6117-D69 (RoHS)

This product conforms to Part 15 of FCC Rules and RSS-210 of the IC Rules. Epson cannot accept
responsibility for any failure to satisfy the protection requirements resulting from a non-recommended
modification of the product. Operation is subject to the following two conditions: (1) this device may not
cause harmful interference, and (2) this device must accept any interference received, including
interference that may cause undesired operation of the device.

To prevent radio interference to the licensed service, this device is intended to be operated indoors and
away from windows to provide maximum shielding. Equipment (or its transmit antenna) that is installed
outdoors is subject to licensing.

This equipment complies with FCC/IC radiation exposure limits set forth for an uncontrolled environment
and meets the FCC radio frequency (RF) Exposure Guidelines in Supplement C to OET65 and RSS-102
of the IC radio frequency (RF) Exposure rules. This equipment should be installed and operated so that
the radiator is kept at least 7.9 inches (20 cm) or more away from a person's body (excluding extremities:
hands, wrists, feet and ankles).

Parent topic: Technical Specifications

PS3 Mode Fonts

Albertus, Albertus lItalic, Albertus Light

AntiqueOlive Roman, AntiqueOQlive Italic, AntiqueOlive Bold, AntiqueOlive Compact

Apple Chancery

ITC AvantGarde Gothic Book, ITC AvantGarde Gothic Book Oblique, ITC AvantGarde Gothic Demi,
ITC AvantGarde Gothic Demi Oblique
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Bodoni, Bodoni Italic, Bodoni Bold, Bodoni Bold Italic, Bodoni Poster, Bodoni Poster Compressed

ITC Bookman Light, ITC Bookman Light Italic, ITC Bookman Demi, ITC Bookman Demi Italic

Carta

Chicago

Clarendon, Clarendon Light, Clarendon Bold

CooperBlack, CooperBlack Italic

Copperplate Gothic 32BC, Copperplate Gothic 33BC

Coronet

Courier, Courier Oblique, Courier Bold, Courier Bold Oblique

GillSans, GillSans ltalic, GillSans Bold, GillSans Bold Italic, GillSansCondensed, GillSans Condensed
Bold, GillSans Light, GillSans Light Italic, GillSans Extra Bold

Eurostile, Eurostile Bold, Eurostile Extended Two, Eurostile Bold Extended Two

Geneva

Goudy Oldstyle, Goudy Oldstyle Italic, Goudy Bold, Goudy Boldltalic, Goudy ExtraBold

Helvetica, Helvetica Oblique, Helvetica Bold, Helvetica Bold Oblique, Helvetica Condensed, Helvetica
Condensed Oblique, Helvetica Condensed Bold, Helvetica Condensed Bold Oblique, Helvetica
Narrow, Helvetica Narrow Oblique, Helvetica Narrow Bold, Helvetica Narrow Bold Oblique

Hoefler Text, Hoefler Text Italic, Hoefler Text Black, Hoefler Text Black Italic, Hoefler Text Ornaments

Joanna, Joanna ltalic, Joanna Bold, Joanna Bold Italic

LetterGothic, LetterGothic Slanted, LetterGothic Bold, LetterGothic Bold Slanted

ITC Lubalin Graph Book, ITC Lubalin Graph Book Oblique, ITC Lubalin Graph Demi, ITC Lubalin Graph
Demi Oblique

Marigold

Monaco

ITC Mona Lisa Recut

New Century Schoolbook Roman, New Century Schoolbook Italic, New Century Schoolbook Bold, New
Century Schoolbook Bold Italic

New York

Optima, Optima ltalic, Optima Bold, Optima Bold Italic
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Oxford

Palatino Roman, Palatino Italic, Palatino Bold, Palatino Bold Italic

Stempel Garamond Roman, Stempel Garamond Italic, Stempel Garamond Bold, Stempel Garamond
Bold Italic

Symbol

Tekton

Times Roman, Times ltalic, Times Bold, Times Bold Italic

Univers, Univers Oblique, Univers Bold, Univers Bold Oblique, Univers Light, Univers Light Oblique

UniversCondensed, UniversCondensed Oblique, UniversCondensed Bold, UniversCondensed Bold
Oblique

UniversExtended , UniversExtended Oblique, UniversExtended Bold, UniversExtended Bold Oblique

Wingdings

ITC ZapfChancery Medium ltalic

ITC ZapfDingbats

Arial, Arial Italic, Arial Bold, Arial Bold ltalic

Times New Roman, Times New Roman ltalic, Times New Roman Bold, Times New Roman Bold ltalic

Parent topic: Technical Specifications

PCL5 Mode Fonts (Bitstream)

Scalable Fonts

Font name Family HP equivalent Symbol set
FixedPitch 810 Medium, Bold, ltalic, Bold |Courier 1
Italic
FixedPitch 850 Regular, Bold, Italic, Letter Gothic
FixedPitch 810 Dark Medium, Bold, ltalic, Bold |Courier PS 3
Italic
Dutch 801 Medium, Bold, ltalic, Bold |CG Times 2
Italic
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Font name Family HP equivalent Symbol set

Zapf Humanist 601 Medium, Bold, Italic, Bold [CG Omega 3
Italic

Ribbon 131 — Coronet

Clarendon 701 — Clarendon Condensed

Swiss 742 Medium, Bold, ltalic, Bold | Univers
Italic

Swiss 742 Condensed | Medium, Bold, Italic, Bold |Univers Condensed 3
Italic

Incised 901 Medium, Bold, ltalic Antique Olive 3

Aldine 430 Medium, Bold, ltalic, Bold | Garamond 3
Italic

Calligraphic 401 — Marigold

Flareserif 821 Medium, Extra Bold Albertus

Swiss 721 SWM Medium, Bold, Italic, Bold | Arial
Italic

Dutch 801 SWM Medium, Bold, ltalic, Bold | Times New 3
Italic

Swiss 721 SWA Medium, Bold, Oblique, Helvetica 3
Bold Oblique

Swiss 721 Narrow Medium, Bold, Oblique, Helvetica Narrow 3

SWA Bold Oblique

Zapf Calligraphic 801 Medium, Bold, ltalic, Bold |Palatino 3

SWA Italic

Geometric 711 SWA Medium, Bold, Oblique, ITC Avant Garde Gothic 3
Bold Italic

Revival 711 SWA Light, Demi Bold, Light ITC Bookman 3
Italic, Demi Bold Italic

Century 702 SWA Medium, Bold, Italic, Bold |[New Century Schoolbook 3

Italic
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Font name Family HP equivalent Symbol set

Dutch 801 SWA Medium, Bold, ltalic, Bold |Times 3
Italic

Chancery 801 Medium |— ITC Zapf Chancery Medium |3

SWA ltalic Italic

Symbol SWM — Symbol 4

More WingBats SWM | — Wingdings 5

Ding Dings SWA — ITC Zapf Dingbats 6

Symbol SWA — SymbolPS 4

David BT Medium, Bold David 7

Narkis Tam BT Medium, Bold Narkis 7

Miryam BT Medium, Bold, Italic Miryam 7

Koufi BT Medium, Bold Koufi 8

Naskh BT Medium, Bold Naskh 8

Ryadh BT Medium, Bold Ryadh 8

Bitmap Font

Line Printer, Symbol set 9

OCR/Barcode Bitmap Font

Font name Family Symbol set

OCRA — 10

OCRB — 11

Code 39 9.37cpi, 4.68cpi 12

EAN/UPC Medium, Bold 13

Note: Depending on the print density, or quality and color of the paper, the OCR/Barcode Bitmap fonts

may not be readable. Print a sample and check for readability before printing large quantities.

Parent topic: Technical Specifications
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Scalable Fonts

PCL6 Mode Fonts (Bitstream)

Bold Oblique

Font name Family HP equivalent Symbol set

FixedPitch 810 Medium, Bold, ltalic, Bold |Courier 1
Italic

FixedPitch 850 Regular, Bold, Italic, Letter Gothic 1

FixedPitch 810 Dark Medium, Bold, ltalic, Bold | Courier PS 3
Italic

Dutch 801 Medium, Bold, ltalic, Bold |[CG Times 2
Italic

Zapf Humanist 601 Medium, Bold, Italic, Bold [CG Omega 3
Italic

Ribbon 131 — Coronet

Clarendon 701 — Clarendon Condensed

Swiss 742 Medium, Bold, ltalic, Bold | Univers
Italic

Swiss 742 Condensed | Medium, Bold, Italic, Bold |Univers Condensed 3
Italic

Incised 901 Medium, Bold, ltalic Antique Olive

Aldine 430 Medium, Bold, ltalic, Bold | Garamond
Italic

Calligraphic 401 — Marigold

Flareserif 821 Medium, Extra Bold Albertus

Swiss 721 SWM Medium, Bold, ltalic, Bold | Arial
Italic

Dutch 801 SWM Medium, Bold, ltalic, Bold | Times New 3
Italic

Swiss 721 SWA Medium, Bold, Oblique, Helvetica 3
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Font name Family HP equivalent Symbol set

Swiss 721 Narrow Medium, Bold, Oblique, Helvetica Narrow 3

SWA Bold Oblique

Zapf Calligraphic 801 Medium, Bold, ltalic, Bold |Palatino 3

SWA Italic

Geometric 711 SWA Medium, Bold, Oblique, ITC Avant Garde Gothic 3
Bold Italic

Revival 711 SWA Light, Demi Bold, Light ITC Bookman 3
Italic, Demi Bold Italic

Century 702 SWA :\t/I(T_dium, Bold, Italic, Bold [New Century Schoolbook 3

alic

Dutch 801 SWA Medium, Bold, ltalic, Bold |Times 3
Italic

Chancery 801 Medium |— ITC Zapf Chancery Medium |3

SWA ltalic Italic

Symbol SWM — Symbol 4

More WingBats SWM | — Wingdings 5

Ding Dings SWA — ITC Zapf Dingbats 6

Symbol SWA — SymbolPS 4

David BT Medium, Bold David 7

Narkis Tam BT Medium, Bold Narkis 7

Miryam BT Medium, Bold, Italic Miryam 7

Koufi BT Medium, Bold Koufi 8

Naskh BT Medium, Bold Naskh 8

Ryadh BT Medium, Bold Ryadh 8

Bitmap Font

Line Printer, Symbol set 9

Parent topic: Technical Specifications
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PCL Mode Fonts (URW)

Scalable Fonts

Bold Oblique

Font name Family HP equivalent Symbol set

Nimbus Mono Medium, Bold, ltalic, Bold |Courier 1
Italic

Letter Gothic Medium, Bold, ltalic, Letter Gothic 1

Nimbus Mono PS Regular, Bold, Oblique, Courier PS 3
Bold Oblique

Nimbus Roman No4 Medium, Bold, ltalic, Bold |[CG Times 2
Italic

URW Classico Medium, Bold, Italic, Bold [CG Omega 3
Italic

URW Coronet — Coronet

URW Clarendon — Clarendon Condensed

Condensed

URW Classic Sans Medium, Bold, ltalic, Bold | Univers 2
Italic

URW Classic Sans Medium, Bold, Italic, Bold |Univers Condensed 3

Condensed Italic

Antique Olive Medium, Bold, ltalic Antique Olive

Garamond Antiqua, Halbfett, Kursiv, |Garamond
Kursiv Halbfett

Mauritius — Marigold 3

Algiers Medium, Extra Bold Albertus 3

NimbusSansNo2 Medium, Bold, ltalic, Bold | Arial 3
Italic

Nimbus Roman No9 Medium, Bold, ltalic, Bold | Times New 3
Italic

Nimbus Sans Medium, Bold, Oblique, Helvetica 3
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Font name Family HP equivalent Symbol set

Nimbus Sans Narrow | Medium, Bold, Oblique, Helvetica Narrow 3
Bold Oblique

Palladio Roman, Bold, ltalic, Bold |Palatino 3
Italic

URW Gothic Book, Demi, Book ITC Avant Garde Gothic 3
Oblique, Demi Oblique

URW Bookman Light, Demi, Light Italic, ITC Bookman 3
Demi ltalic

URW Century Roman, Bold, Italic, Bold |[New Century Schoolbook 3

Schoolbook Italic

Nimbus Roman Medium, Bold, ltalic, Bold |Times 3
Italic

URW Chancery — ITC Zapf Chancery Medium |3

Medium Italic Italic

Symbol — Symbol 4

URW Dingbats — Wingdings 5

Dingbats — ITC Zapf Dingbats 6

Standard Symbol — SymbolPS 4

URW David Medium, Bold HP David 7

URW Narkis Medium, Bold HP Narkis Tam 7

URW Miryam Medium, Bold, Italic HP Miryam 7

URW Koufi Medium, Bold Koufi 8

URW Naskh Medium, Bold Naskh 8

URW Ryadh Medium, Bold Ryadh 8

Bitmap Font

Line Printer, Symbol set 9
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OCR/Barcode Bitmap Font for PCL5

Font name Family Symbol set
OCRA — 10
OCRB — 11
Code 39 9.37cpi, 4.68cpi 12
EAN/UPC Medium, Bold 13

Note: Depending on the print density, or quality and color of the paper, the OCR/Barcode Bitmap fonts
may not be readable. Print a sample and check for readability before printing large quantities.

Parent topic: Technical Specifications

Symbol Sets

Your product can access a variety of symbol sets. Many of these symbol sets differ only in the
international characters specific to each language.

Note: Since most software handles fonts and symbols automatically, you may never need to adjust your
product settings. However, if you write your own product control programs, or if you use older software
that cannot control fonts, refer to these tables for details on the typefaces and symbol sets.

When you consider which font to use, also consider which symbol set to combine with the font. Available
symbol sets vary depending on the mode and font you choose.

PCL5 Mode Typefaces and Symbol Sets

In the PCL5 mode symbol sets table, you can use any of these typefaces in the left column:
» Zapf Humanist 601

* Ribbon 131

+ Clarendon 701

* Swiss 742 Condensed

* Incised 901

* Aldine 430

+ Calligraphic 401
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* Flareserif 821

* Swiss 721 SWM

* Dutch 801 SWM

* Swiss 721 SWA

* Swiss 721 Narrow SWA

» Zapf Calligraphic 801 SWA
* Geometric 711 SWA

* Revival 711 SWA

» Century 702 SWA

* Dutch 801 SWA

» Chancery 801 Medium SWA ltalic

 FixedPitch 810 Dark
PCL5 Mode Symbol Sets

Typeface details

Symbol set names

FixedPitch 810
Dutch 801
Swiss 742
FixedPitch 850
Line Printer

IBM-US (10U)

Roman-8 (8U)

ECM94-1 (ON)

Roman-8 (8U)

8859-9 ISO (5N)

8859-101SO (6N)

IBM-DN (11U)

PcMultilingual (12U)

Legal (1U)

8859-151SO (9N)
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Typeface details

Symbol set names

FixedPitch 810 PcBIt775 (26U) Pc1004 (9J)

Dutch 801 WIBALT (19L) DeskTop (7J)

Swiss 742 PsText (10J) Windows (9U)

FixedPitch 850 McText (12J) MsPublishi (6J)
PiFont (15U) VeMath (6M)
Velnternational (13J) VeUS (14J)
PcE.Europe (17U) PcTk437 (97)
WiAnsi (19U) WIE.Europe (9E)
WiTurkish (5T) UK (1E)
Swedis2 (0S) Italian (OI)
Spanish (2S) German (1G)
Norweg1 (0D) French2 (1F)
Roman-9 (4U) PcEur858 (13U)
ISO 8859/4 Latin 4 (4N) Unicode 3.0 (18N)

FixedPitch 810 PsMath (5M)

Dutch 801 Math-8 (8M)

Swiss 742 ANSI ASCII (0U)

FixedPitch 850

David BT

Miryam BT

Narkis Tam BT

Naskh BT

Koufi BT

Ryadh BT
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Typeface details

Symbol set names

FixedPitch 810 Pc866Cyr (3R) Pc866Ukr (14R)
Dutch 801 WinCyr (9R) Pc8Grk (12G)
Swiss 742 Pc851Grk (10G) WinGrk (9G)
FixedPitch 850 ISOGrk (12N) Greek8 (8G)
FixedPitch 810 ISOCyr (10N)
Dutch 801
Swiss 742
FixedPitch 850
Line Printer
Line Printer Roman Extension (OE)
FixedPitch 810 Hebrew?7 (OH)
FixedPitch 850 ISO 8859/8 Hebrew (7H)
David BT Hebrew8 (8H)
Narkis Tam BT PC-862, Hebrew (15H)
Miryam BT
Koufi BT Arabic8 (8V)
Naskh BT PC-864, Arabic (10V)
Ryadh BT HPWARA (9V)
Symbol SWA Symbol (19M)
Symbol SWM
More WingBats SWM Wingdings (579L)
Ding Dings SWA ZapfDingbats (14L)
OCRA OCRA (00)
OCRB OCRB (10)
OCR B Extension (3Q)
Code3-9 Code3-9 (0Y)
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Typeface details

Symbol set names

EAN/UPC

EAN/UPC (8Y)

PCL6 Mode Symbol Sets

Symbol set Attribute |Font classification

name *1 *2 *3 *4 *5 *6 *7 *8 *9
ISO Norwegian | 4 v v v — — — — — —
ISO ltalian 9 v v v — — — — _ _
ISO 8859-1 14 v v v — — — — — v
Latin 1

ISO Swedish |19 v v v — — — — — _
ASCII 21 v v v — — — v v —
ISO United 37 v v v — — — - _ _
Kingdom

ISO French 38 v v v — — — — _ _
ISO German |39 v v v — — — — _ _
Legal 53 v v/ v/ — — — — — v
ISO 8859-2 78 v v v — — — — — v
Latin 2

ISO Spanish |83 v v v — — — — — _
Roman-9 149 v v v — — — — _ _
PS Math 173 v v v — — — v v

ISO 8859-9 174 v v v — — — — — v
Latin 5

Windows 3.1 |180 v v v — — — — _ _
Latin 5

Microsoft 202 v v v — — — — _ _
Publishing
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Symbol set Attribute |Font classification

name (2 [*3 *4  [*5 % |*7 8 |*o
ISO 8859/10 |206 v v v — — — — — v
Latin 6

DeskTop 234 v v v — — — - _ _
Math-8 269 v v v — — — v v
Roman-8 277 v Vv Vv — — — — — v
Windows 3.1  [293 v v v — — — — — _
Latin 2

Pc1004 298 v v v — — — — — —
ISO 8859-15 | 302 v v v — — — — — —
Latin 9

PC-Turkish 308 v v v — — — — _ _
Windows 3.0 |309 v v v — — — — _ _
PS Text 330 v v v — — — — _ _
PC-8 341 v v v — — — — — v
PC-8 D/N 373 v v v — — — — — v
MC Text 394 v v v — — — — —

PC-850 405 v v v — — — — — v
PcEur858 437 v v v — — — - _ _
Pi Font 501 v v v — — — — — _
PC852 565 v v v — — — — — _
Unicode 3.0 590 v v v — — — — — _
WBALT 620 v v v — — — — — —
Windows 3.1 |629 v v v — — — — — _
Latin 1

PC-755 853 v v v — — — — — —
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Symbol set |Attribute |Font classification

name *1 *2 *3 *4 *5 *6 *7 *8 *9
Wingdings 18540 — — — — v — — — —
Symbol 621 — — — v — — — — —
ZapfDigbats  [460 — — — — — v — — —
PC-866, 114 v v — — — — — — —
Cyrillic

Greek8 263 v v — — — — — — _
Windows 295 v v — — — — — — _
Greek

Windows 306 v v — — — — — — _
Cyrillic

PC-851, Greek | 327 v v — — — — — _ _
ISO 8859/5 334 v v — — — — — — —
Cyrillic

PC-8, Greek |391 v v — — — — — — —
ISO 8859/7 398 v v — — — — — — —
Greek

PC-866 UKR |466 v v — — — — — — —
Hebrew?7 8 v — — — — — — _ _
ISO 8859/8 232 v — — — — — v — —
Hebrew

Hebrew8 264 v — — — — — v _ _
PC-862, 488 — — — — — — v — —
Hebrew

Arabic8 278 — — — — — — — v —
HPWARA 310 — — — — — — — v —
PC-864, Arabic| 342 — — — — — — — v —
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Parent topic: Technical Specifications
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Notices

Check these sections for important notices about your product.

Note: Epson offers a recycling program for end of life Epson products. Please go to this site for
information on how to return your Epson products for proper disposal.

Important Safety Instructions
FCC Compliance Statement
Trademarks

Copyright Notice

Important Safety Instructions
Before using your Epson product, read and follow these safety instructions.

General Product Safety Instructions

Ink Cartridge Safety Instructions

LCD Screen Safety Instructions

Wireless Connection Safety Instructions
Telephone Equipment Safety Instructions

Parent topic: Notices

General Product Safety Instructions
» Be sure to follow all warnings and instructions marked on the product.
» Use only the type of power source indicated on the product's label.

» Use only the power cord that comes with the product. Use of another cord may cause fires or shock.
Do not use the cord with any other equipment.

» Place the product near a wall outlet where the plug can be easily unplugged.

* Avoid plugging the product into an outlet on the same circuit as a photo copier or air control system
that regularly switches on and off, or on an outlet controlled by a wall switch or timer.

» Do not let the power cord become damaged or frayed. Place it to avoid abrasions, cuts, fraying,
crimping, and kinking. Do not place objects on top of it and do not allow it to be stepped on or run over.
Be careful to keep the cord straight at each end.
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http://global.epson.com/SR/environment/recycle/?rdct=recycle

If you use an extension cord with the product, make sure the total ampere rating of the devices
plugged into the extension cord does not exceed the cord's ampere rating. Also, make sure the total
ampere rating of all devices plugged into the wall outlet does not exceed the wall outlet's ampere
rating.

Always turn off the product using the power button, and wait until the power light stops flashing before
unplugging the product or cutting off power to the electrical outlet.

If you will not be using the product for a long period, unplug the power cord from the electrical outlet.

Place the product on a flat, stable surface that extends beyond its base in all directions. It will not
operate properly if it is tilted or at an angle.

Allow space behind the product for the cables, and space above the product so that you can fully raise
the document cover.

Leave enough space in front of the product for the paper to be fully ejected.

Avoid locations that are subject to rapid changes in heat or humidity, shocks or vibrations, or dust.
Do not place or store the product outdoors.

Do not place the product near excessive heat sources or in direct sunlight.

Leave enough room around the product for sufficient ventilation. Do not block or cover openings in the
case or insert objects through the slots.

Keep the product away from potential sources of electromagnetic interference, such as loudspeakers
or the base units of cordless telephones.

When connecting the product to a computer or other device with a cable, ensure the correct
orientation of the connectors. Each connector has only one correct orientation. Inserting a connector
in the wrong orientation may damage both devices connected by the cable.

Do not touch the flat white cable inside the product.
Do not move the print head by hand; this may damage the product.
Do not spill liquid on the product or use the product with wet hands.

Do not use aerosol products that contain flammable gases inside or around the product. Doing so may
cause fire.

Do not press too hard on the document table when placing originals.

Do not open the scanner section while the product is copying, printing, scanning, or performing any
other functions.

Be careful not to trap your fingers when closing the document cover or scanner.
Except as specifically explained in your documentation, do not attempt to service the product yourself.
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Unplug the product and refer servicing to qualified service personnel under the following conditions: if
the power cord or plug is damaged; if liquid has entered the product; if the product has been dropped
or the case damaged,; if the product does not operate normally or exhibits a distinct change in
performance. Adjust only those controls that are covered by the operating instructions.

Leave the ink cartridge installed. Removing the cartridge can dehydrate the print head and may
prevent the product from printing.

When storing or transporting the product, do not tilt it, stand it on its side, or turn it upside down;
otherwise ink may leak.

Parent topic: Important Safety Instructions

Ink Cartridge Safety Instructions

Keep ink cartridges out of the reach of children and do not drink the ink.

Be careful when you handle used ink cartridges; there may be ink remaining around the ink supply
port. If ink gets on your skin, wash it off with soap and water. If it gets in your eyes, flush them
immediately with water.

Do not put your hand inside the product or touch any cartridges during printing.

Install a new ink cartridge immediately after removing an expended one. Leaving cartridges
uninstalled can dry out the print head and may prevent the product from printing.

Do not remove or tear the label on the cartridge; this can cause leakage.

Do not remove the transparent seal from the bottom of the cartridge. This may cause the cartridge to
become unusable.

Do not break the hooks on the side of the cartridge when removing it from the packaging.
Do not touch the green IC chip on the side of the cartridge. This may prevent normal operation.
Do not shake cartridges after opening their packages; this can cause them to leak.

If you remove an ink cartridge for later use, protect the ink supply area from dirt and dust and store itin
the same environment as the product. Note that there is a valve in the ink supply port, making covers
or plugs unnecessary, but care is needed to prevent the ink from staining items that the cartridge
touches. Do not touch the ink cartridge ink supply port or surrounding area.

Use an ink cartridge before the date printed on its package.
Do not dismantle an ink cartridge. This could damage the print head.
Store ink cartridges in a cool, dark place.

After bringing an ink cartridge inside from a cold storage site, allow it to warm up at room temperature
for at least three hours before using it.
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» Store ink cartridges with their labels facing upward. Do not store cartridges upside down.
Parent topic: Important Safety Instructions

LCD Screen Safety Instructions
» Use only a dry, soft cloth to clean the LCD screen. Do not use liquid or chemical cleansers.

» Ifthe LCD screen is damaged, contact Epson. If the liquid crystal solution gets on your hands, wash
them thoroughly with soap and water. If the liquid crystal solution gets into your eyes, flush them
immediately with water. If discomfort or vision problems remain after a thorough flushing, see a doctor
immediately.

» Do not press too hard on the LCD screen.
» Do not use a pointy or sharp object, such as a pen or your fingernail, to operate the LCD screen.
Parent topic: Important Safety Instructions

Wireless Connection Safety Instructions

Radio waves from this product may adversely affect the operation of medical equipment or automatically
controlled devices, such as pacemakers, automatic doors or fire alarms. When using this product near
such devices or inside a medical facility, follow the directions from authorized staff members at the
facility, and follow all posted warnings and directions on the device to avoid causing an accident.

Parent topic: Important Safety Instructions

Telephone Equipment Safety Instructions

When using telephone equipment, you should always follow basic safety precautions to reduce the risk
of fire, electric shock, and personal injury, including the following:

* Do not use the Epson product near water.

» Avoid using a telephone during an electrical storm. There may be a remote risk of electric shock from
lightning.

» Do not use a telephone to report a gas leak in the vicinity of the leak.

Caution: To reduce the risk of fire, use only a No. 26 AWG or larger telecommunication line cord.

Parent topic: Important Safety Instructions
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FCC Compliance Statement

For United States Users

This equipment complies with Part 68 of the FCC rules and the requirements adopted by the
Administrative Council for Terminal Attachments ("ACTA") . On the surface of this equipment is a label
that contains, among other information, a product identifier in the format US:AAAEQ##TXXXX. If
requested, this number must be provided to the telephone company.

Applicable certification jack Universal Service Order Codes ("USOC") for the equipment: RJ11C.

A plug and jack used to connect this equipment to the premises wiring and telephone network must
comply with the applicable FCC Part 68 rules and requirements adopted by the ACTA. A compliant
telephone cord and modular plug is provided with this product. It is designed to be connected to a
compatible modular jack that is also compliant. See installation instructions for details.

The REN is used to determine the number of devices that may be connected to a telephone line.
Excessive RENs on a telephone line may result in the devices not ringing in response to an incoming
call. In most but not all areas, the sum of RENs should not exceed five (5.0). To be certain of the number
of devices that may be connected to a line, as determined by the total RENs, contact the local telephone
company. For products approved after July 23, 2001 , the REN for this product is part of the product
identifier that has the format US:AAAEQ##TXXXX. The digits represented by ## are the REN without a
decimal point (e.g., 03 is a REN of 0.3). For earlier products, the REN is separately shown on the label.

If this equipment causes harm to the telephone network, the telephone company will notify you in
advance that temporary discontinuance of service may be required. But if advance notice isn't practical,
the telephone company will notify the customer as soon as possible. Also, you will be advised of your
right to file a complaint with the FCC if you believe it is necessary.

The telephone company may make changes in its facilities, equipment, operations or procedures that
could affect the operation of the equipment. If this happens the telephone company will provide advance
notice in order for you to make necessary modifications to maintain uninterrupted service.

If you have problems with this product and require technical or customer support, please visit
www.epson.com for more information.

This product is not intended to be repaired by the customer. If you experience trouble connecting this
equipment to a telephone line, please contact:

Name: Epson America, Inc.
Address: 3840 Kilroy Airport Way, Long Beach, CA 90806 U.S.A.
Telephone: (562) 981-3840

If the equipment is causing harm to the telephone network, the telephone company may request that you
disconnect the equipment until the problem is resolved.
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This equipment may not be used on coin service provided by the telephone company. Connection to
party line service is subject to state tariffs. Contact the state public utility commission, public service
commission or corporation commission for information.

If your home has specially wired alarm equipment connected to the telephone line, ensure the
installation of this equipment does not disable your alarm equipment. If you have questions about what
will disable alarm equipment, consult your telephone company or a qualified installer.

The Telephone Consumer Protection Act of 1991 makes it unlawful for any person to use a computer or
other electronic device, including fax machines, to send any message unless such message clearly
contains in a margin at the top or bottom of each transmitted page or on the first page of the
transmission, the date and time it is sent and an identification of the business or other entity, or other
individual sending the message and the telephone number of the sending machine or such business,
other entity, or individual. (The telephone number provided may not be a 900 number or any other
number for which charges exceed local or long-distance transmission charges.)

In order to program this information into your fax machine, click the link below for instructions on entering
fax header information.

According to the FCC's electrical safety advisory, we recommend that you may install an AC surge
arrester in the AC outlet to which this equipment is connected. Telephone companies report that
electrical surges, typically lightning transients, are very destructive to customer terminal equipment
connected to AC power sources and that this is a major nationwide problem.

This equipment has been tested and found to comply with the limits for a Class B digital device, pursuant
to Part 15 of the FCC Rules. These limits are designed to provide reasonable protection against harmful
interference in a residential installation. This equipment generates, uses, and can radiate radio
frequency energy and, if not installed and used in accordance with the instructions, may cause harmful
interference to radio or television reception. However, there is no guarantee that interference will not
occur in a particular installation. If this equipment does cause interference to radio and television
reception, which can be determined by turning the equipment off and on, the user is encouraged to try to
correct the interference by one or more of the following measures:

* Reorient or relocate the receiving antenna.

* Increase the separation between the equipment and receiver.

» Connect the equipment into an outlet on a circuit different from that to which the receiver is connected.
» Consult the dealer or an experienced radio/TV technician for help.

WARNING

The connection of a non-shielded equipment interface cable to this equipment will invalidate the FCC
Certification or Declaration of this device and may cause interference levels which exceed the limits
established by the FCC for this equipment. It is the responsibility of the user to obtain and use a shielded
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equipment interface cable with this device. If this equipment has more than one interface connector, do
not leave cables connected to unused interfaces. Changes or modifications not expressly approved by
the manufacturer could void the user’s authority to operate the equipment.

For Canadian Users

1. This product meets the applicable Industry Canada technical specifications.

2. The Ringer Equivalence Number is an indication of the maximum number of devices allowed to be
connected to a telephone interface. The termination on an interface may consist of any combination of
devices subject only to the requirement that the sum of the RENSs of all the devices does not exceed five.

CAN ICES-3(B)/NMB-3(B)
Le présent matériel est conforme aux spécifications techniques applicables d’Industrie Canada.

L’indice d’équivalence de la sonnerie (IES) sert a indiquer le nombre maximal de terminaux qui peuvent
étre raccordés a une interface téléphonique. La terminaison d’une interface peut consister en une
combinaison quelconque de dispositifs, a la seule condition que la somme d’indices d’équivalence de la
sonnerie de tous les dispositifs n’excéde pas 5.

CAN ICES-3(B)/NMB-3(B)
Parent topic: Notices

Related tasks
Using the Fax Setup Wizard

Trademarks

EPSON® is a registered trademark, EPSON Exceed Your Vision is a registered logomark, and Epson
Connect™, Epson iPrint™, and Remote Print™ are trademarks of Seiko Epson Corporation.

Epson Store®™ is a service mark of Epson America, Inc.

Apple, App Store, AirPrint, AirPrint logo, iPad, iPhone, iPod touch, Mac, and OS X are trademarks of
Apple Inc., registered in the U.S. and other countries.

Google® is a registered trademark and Android™, Chromebook™, Google Cloud Print™, Google Drive™,
and Google Play™ are trademarks of Google Inc.

Wi-Fi Direct® is a registered trademark of Wi-Fi Alliance®.
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General Notice: Other product names used herein are for identification purposes only and may be
trademarks of their respective owners. Epson disclaims any and all rights in those marks.

EPSON

EXCEED YOUR VISION

Parent topic: Notices

Copyright Notice

All rights reserved. No part of this publication may be reproduced, stored in a retrieval system, or
transmitted in any form or by any means, electronic, mechanical, photocopying, recording, or otherwise,
without the prior written permission of Seiko Epson Corporation. The information contained herein is
designed only for use with this Epson product. Epson is not responsible for any use of this information as
applied to other products.

Neither Seiko Epson Corporation nor its affiliates shall be liable to the purchaser of this product or third
parties for damages, losses, costs, or expenses incurred by purchaser or third parties as a result of:
accident, misuse, or abuse of this product or unauthorized modifications, repairs, or alterations to this
product, or (excluding the U.S.) failure to strictly comply with Seiko Epson Corporation's operating and
maintenance instructions.

Seiko Epson Corporation shall not be liable for any damages or problems arising from the use of any
options or any consumable products other than those designated as Original Epson Products or Epson
Approved Products by Seiko Epson Corporation.

Seiko Epson Corporation shall not be held liable for any damage resulting from electromagnetic
interference that occurs from the use of any interface cables other than those designated as Epson
approved Products by Seiko Epson Corporation.

This information is subject to change without notice.

libTIFF Software Acknowledgment

A Note Concerning Responsible Use of Copyrighted Materials
Default Delay Times for Power Management for Epson Products
Copyright Attribution

Parent topic: Notices

libTIFF Software Acknowledgment
Copyright © 1988-1997 Sam Leffler
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Copyright © 1991-1997 Silicon Graphics, Inc.

Permission to use, copy, modify, distribute, and sell this software and its documentation for any purpose
is hereby granted without fee, provided that (1) the above copyright notices and this permission notice
appear in all copies of the software and related documentation, and (ii) the names of Sam Leffler and
Silicon Graphics may not be used in any advertising or publicity relating to the software without the
specific, prior written permission of Sam Leffler and Silicon Graphics.

THE SOFTWARE IS PROVIDED "AS-IS" AND WITHOUT WARRANTY OF ANY KIND, EXPRESS,
IMPLIED OR OTHERWISE, INCLUDING WITHOUT LIMITATION, ANY WARRANTY OF
MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE.

IN NO EVENT SHALL SAM LEFFLER OR SILICON GRAPHICS BE LIABLE FOR ANY SPECIAL,
INCIDENTAL, INDIRECT OR CONSEQUENTIAL DAMAGES OF ANY KIND, OR ANY DAMAGES
WHATSOEVER RESULTING FROM LOSS OF USE, DATA OR PROFITS, WHETHER OR NOT
ADVISED OF THE POSSIBILITY OF DAMAGE, AND ON ANY THEORY OF LIABILITY, ARISING OUT
OF OR IN CONNECTION WITH THE USE OR PERFORMANCE OF THIS SOFTWARE.

Parent topic: Copyright Notice

A Note Concerning Responsible Use of Copyrighted Materials

Epson encourages each user to be responsible and respectful of the copyright laws when using any
Epson product. While some countries' laws permit limited copying or reuse of copyrighted material in
certain circumstances, those circumstances may not be as broad as some people assume. Contact your
legal advisor for any questions regarding copyright law.

Parent topic: Copyright Notice

Default Delay Times for Power Management for Epson Products

This product will enter sleep mode after a period of nonuse. This is to ensure that the product meets
Energy Star standards of energy efficiency. More energy savings can be achieved by setting the time to
sleep to a shorter interval.

Parent topic: Copyright Notice

Copyright Attribution
© 2016 Epson America, Inc.
3/16
CPD-50901
Parent topic: Copyright Notice
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